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Software License
To use the software you must agree to the license terms set out below.

LOGTAG RECORDERS END-USER LICENSE AGREEMENT

YOU SHOULD CAREFULLY READ THE FOLLOWING TERMS AND CONDITIONS BEFORE USING THIS PRODUCT. IT
CONTAINS SOFTWARE, THE USE OF WHICH IS LICENSED BY LOGTAG RECORDERS, TO ITS CUSTOMERS FOR THEIR USE
ONLY AS SET FORTH BELOW. IF YOU DO NOT AGREE TO THE TERMS AND CONDITIONS OF THIS AGREEMENT, DO NOT
USE THE SOFTWARE. USING ANY PART OF THE SOFTWARE INDICATES THAT YOU ACCEPT THESE TERMS.

LICENSE: LogTag Recorders grants you a personal, limited, non-exclusive license to use the accompanying software program(s)
(the "Software") subject to the terms and restrictions set forth in this License Agreement. You are not permitted to lease or rent
(except under separate mutually agreeable terms set forth in writing), distribute or sublicense the Software or to use the
Software in a time-sharing arrangement or in any other unauthorized manner. Further, no license is granted to you in the human
readable code of the Software (source code). Except as provided below, this License Agreement does not grant you any rights to
patents, copyrights, trade secrets, trademarks, or any other rights in respect to the Software.

The Software is licensed to be used on any computing device. You may reproduce and provide one (1) copy of such Software for
each computing device on which such Software is used as permitted hereunder. Otherwise, the Software and supporting
documentation may be copied only as essential for backup or archive purposes in support of your use of the Software as
permitted hereunder. You must reproduce and include all copyright notices and any other proprietary rights notices appearing
on the Software on any copies that you make.

NO ASSIGNMENT; NO REVERSE ENGINEERING: You may transfer the Software and this License Agreement to another party if
the other party agrees in writing to accept the terms and conditions of this License Agreement. If you transfer the Software, you
must at the same time either transfer all copies of the Software as well as the supporting documentation to the same party or
destroy any such materials not transferred. Except as set forth above, you may not transfer or assign the Software or your rights
under this License Agreement.

Modification, reverse engineering, reverse compiling, or disassembly of the Software is expressly prohibited. Analyzing the
input to and output from the Software is expressly prohibited except when this is done solely to evaluate the subjective quality
of the Software's visual and data analysis processes. You may not otherwise modify, alter, adapt, port, or merge the Software
except as specified in this License Agreement.

EXPORT RESTRICTIONS: You agree that you will not export or re-export the Software or accompanying documentation (or
any copies thereof) or any products utilizing the Software or such documentation in violation of any applicable laws or
regulations of the United States or the country in which you obtained them.

TRADE SECRETS; TITLE: You acknowledge and agree that the structure, sequence and organization of the Software are the
valuable trade secrets of LogTag Recorders and its suppliers. You agree to hold such trade secrets in confidence. You further
acknowledge and agree that ownership of, and title to, the Software and all subsequent copies thereof regardless of the form or
media are held by LogTag Recorders and its suppliers.

TRADEMARKS AND COPYRIGHTS: "LogTag®" is a registered trademark (R) of LogTag Recorders. You may not remove, alter,
deface, overprint, or otherwise obscure any LogTag Recorders trademark, service mark, or copyright notices included with this
Software.

INTELLECTUAL PROPERTY: All intellectual property rights in and to this Software are and shall remain in LogTag Recorders.

TERM AND TERMINATION: This License Agreement is effective until terminated. You may terminate it at any time by
destroying the Software and documentation together with all copies and merged portions in any form. It will also terminate
immediately if you fail to comply with any term or condition of this License Agreement. Upon such termination you agree to
destroy the Software and documentation, together with all copies and merged portions in any form.

GOVERNING LAW: This License Agreement shall be governed by the laws of the State of California and by the laws of the
United States, excluding their conflicts of law principles. The United Nations Convention on Contracts for the International Sale
of Goods (1980) is hereby excluded in its entirety from application to this License Agreement.

LIMITED WARRANTY; LIMITATION OF LIABILITY: EXCEPT AS EXPRESSLY PROVIDED OTHERWISE IN A WRITTEN
AGREEMENT BETWEEN LOGTAG RECORDERS AND YOU, THE SOFTWARE IS NOW PROVIDED "AS IS" WITHOUT
WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, OR THE WARRANTY OF NON-
INFRINGEMENT. WITHOUT LIMITING THE FOREGOING, LOGTAG RECORDERS MAKES NO WARRANTY THAT (I) THE
SOFTWARE WILL MEET YOUR REQUIREMENTS, (II) THE USE OF THE SOFTWARE WILL BE UNINTERRUPTED, TIMELY,
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SECURE, OR ERROR-FREE, (III) THE RESULTS THAT MAY BE OBTAINED FROM THE USE OF THE SOFTWARE WILL BE
ACCURATE OR RELIABLE, (IV) THE QUALITY OF THE SOFTWARE WILL MEET YOUR EXPECTATIONS, (V) ANY ERRORS IN
THE SOFTWARE WILL BE CORRECTED, AND/OR (VI) YOU MAY USE, PRACTICE, EXECUTE, OR ACCESS THE SOFTWARE
WITHOUT VIOLATING THE INTELLECTUAL PROPERTY RIGHTS OF OTHERS. SOME STATES OR JURISDICTIONS DO NOT
ALLOW THE EXCLUSION OF IMPLIED WARRANTIES OR LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY MAY
LAST, SO THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU. IF TEXAS LAW IS NOT HELD TO APPLY TO THIS
AGREEMENT FOR ANY REASON, THEN IN JURISDICTIONS WHERE WARRANTIES, GUARANTEES, REPRESENTATIONS,
AND/OR CONDITIONS OF ANY TYPE MAY NOT BE DISCLAIMED, ANY SUCH WARRANTY, GUARANTEE,
REPRESENTATION AND/OR WARRANTY IS: (1) HEREBY LIMITED TO THE PERIOD OF EITHER (A) THIRTY (30) DAYS
FROM THE DATE OF OPENING THE PACKAGE CONTAINING THE SOFTWARE OR (B) THE SHORTEST PERIOD ALLOWED
BY LAW IN THE APPLICABLE JURISDICTION IF A THIRTY (30) DAY LIMITATION WOULD BE UNENFORCEABLE; AND (2)
THE SOLE LIABILITY OF LOGTAG RECORDERS. FOR ANY BREACH OF ANY SUCH WARRANTY, GUARANTEE,
REPRESENTATION, AND/OR CONDITION SHALL BE TO PROVIDE YOU WITH A NEW COPY OF THE SOFTWARE.

IN NO EVENT SHALL LOGTAG RECORDERS OR ITS SUPPLIERS BE LIABLE TO YOU OR ANY THIRD PARTY FOR ANY
SPECIAL, INCIDENTAL, INDIRECT OR CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER,
INCLUDING, WITHOUT LIMITATION, THOSE RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER OR NOT
LOGTAG RECORDERS HAD BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, AND ON ANY THEORY OF
LIABILITY, ARISING OUT OF OR IN CONNECTION WITH THE USE OF THE SOFTWARE. SOME JURISDICTIONS PROHIBIT
THE EXCLUSION OR LIMITATION OF LIABILITY FOR CONSEQUENTIAL OR INCIDENTAL DAMAGES, SO THE ABOVE
LIMITATIONS MAY NOT APPLY TO YOU. THESE LIMITATIONS SHALL APPLY NOTWITHSTANDING ANY FAILURE OF
ESSENTIAL PURPOSE OF ANY LIMITED REMEDY.

SEVERABILITY: In the event any provision of this License Agreement is found to be invalid, illegal or unenforceable, the
validity, legality and enforceability of any of the remaining provisions shall not in any way be affected or impaired and a valid,
legal and enforceable provision of similar intent and economic impact shall be substituted therefore.

ENTIRE AGREEMENT: This License Agreement sets forth the entire understanding and agreement between you and LOGTAG
RECORDERS, supersedes all prior agreements, whether written or oral, with respect to the Software, and may be amended only
in a writing signed by both parties.

The software menus and texts as well as this agreement have been created in English and any other language versions have been
translated from the English version. In the event of a dispute, reference should be made to the English language version, which
is conclusive.

For further information about licensing please email licensing@logtagrecorders.com.

Privacy Policy
LogTag® Recorders stores a small number of your personal data to enhance your user experience.
What data we store and the way we store and use the data is described in our Privacy Policy, which
you can access from the LogTag® Recorders website at https://logtagrecorders.com/privacy-policy/.
Installing and using this software constitutes your agreement to this policy.

https://logtagrecorders.com/privacy-policy/


Chapter 1
Introduction

LogTag® Recorders offer a range of logger and indicator products for temperature and
humidity, which are complemented by software and interface products. Some of these
products can be used on their own, most often, however, you will use a combination of
products to get the best results. LogTag® Recorders offer a variety of different models.
The product range is constantly being updated and new models added, so visit the
LogTag® Website at https://logtagrecorders.com frequently to get the latest
information and news about upcoming product releases.

Typically LogTag® products are configured, put with goods that require monitoring and
are downloaded once the goods receive their intended destination.

Figure 1: Typical distribution process with loggers and indicators

Other applications may involve stationary loggers placed in warehouses or fridges,
such as the Vaxtag®, which can be seen in this video:

Figure 2: Example of a stationary logger application

https://logtagrecorders.com/
https://youtu.be/M2PgEuFkFDs
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Loggers
LogTag® temperature and humidity logger products are small, battery powered, credit card size
devices with built-in sensors and data logging memory. They record between 4,000 and 16,000
samples from anywhere between -80°C and +100°C, depending on the model. For detailed
information about individual data logger models please visit the LogTag® Recorders website at
https://logtagrecorders.com/products.

Figure 3: Some of the LogTag® logger products

Indicators
LogTag® temperature indicators are even smaller devices, also battery powered, containing a
statistics memory, which can hold minimum and maximum values from anywhere between 20
days and three years. They feature a display for a quick assessment if goods have been exposed to
temperatures outside pre-configured temperature limits. For detailed information about individual
indicator models please visit the LogTag® Recorders website at
https://logtagrecorders.com/products.

Figure 4: Some of the LogTag® indicator products

https://logtagrecorders.com/products
https://logtagrecorders.com/products


Software
Loggers and Indicators are downloaded using the LogTag® Analyzer software, which is also used to
configure loggers.

This guide will take you through the relevant steps to successfully use the LogTag® products.

You will learn how to:

l install the software,

l configure LogTag® products for recording,

l retrieve the recorded readings,

l display and analyse the data and

l configure the available options in the software so you can make best use of its features.

Experienced users of the software may choose to skip chapters 1 to 3, however if you are about to
use a newer version of a LogTag® or Interface Cradle we recommend you at least skim the
installation chapter for any relevant changes.

This guide covers version 2.9 of the LogTag® Analyzer software. If you are unsure which version
you are currently using, please read the section about Finding your software version (see page 196)
included later in this guide.

If you find a feature described in this guide that does not appear in your software, we recommend
you update it as explained in the section about Updating LogTag Analyzer (see page 19). You can
always get the most up to date version of LogTag® Analyzer from the LogTag® Recorders website at
https://logtagrecorders.com.

This guide includes all the relevant information to install and use the product range supplied by
LogTag® Recorders, however, the reader is expected to be familiar with using a computer and the
Windows® operating system.

Chapter 1: Introduction 15
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Chapter 2
Installing the software

To use your LogTag® products you need to install LogTag® Analyzer on your computer.
This will allow preparing your LogTag® for recording, retrieving the readings from
memory at the end of a trip and analysing the data.

This chapter will take you through the installation steps. Experienced users may
choose to skip this chapter. You should read it, however, if you are new to using a
computer or installing software.

In this chapter:

System requirements 17
Getting a copy of the software 17
The installation process 18
Updating LogTag Analyzer 19
Starting the software 21
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System requirements
To ensure that the software will work on your computer following minimum specifications are
required:

l PC capable of running Windows® 7 or later, or Windows® 2008 Server or later

l 60MB free disk space

l Internet Explorer 8.0 or later

l 1 available USB port (depending on purchased interface you may need an RS232 serial
port)

l 1024 x 768, or higher, screen resolution.

l 256 screen colours

The recommended specifications are:

l Processor equivalent to Pentium IV or later

l 512MB of available RAM

l Latest Internet Explorer

l 65535 (16bit), or more, screen colours.

If you are unsure of your computer's specifications, please refer to your operating system's
documentation or help function.

Getting a copy of the software
The software can be download from the from the LogTag® Recorders website; navigate to
http://logtagrecorders.com/software and click the link for LogTag® Analyzer version 2. Complete
and submit the download registration form. Click Download Now and confirm whether you wish to
open the downloaded file or to save it to a folder on your PC.

Figure 5: Downloading using Internet Explorer

Figure 6: Download Window - Mozilla Firefox

Depending on the type of browser and its version you may get different windows to start and
process the download. Modern browsers like Windows® Explorer, Google Chrome or Mozilla Firefox
typically have a special directory into which all downloads are copied.

http://logtagrecorders.com/software


Figure 7: Download progress using Internet Explorer

Figure 8: Download progress using Firefox

Figure 9: Download progress using Chrome

If you have an older browser, we recommend you select a folder on your PC that you can easily
access (such as the "My Documents" or "Download" folder), but you are free to choose any folder
for which you have write permissions. The downloaded file is a single executable installer file; no
other files are required for installation of LogTag Analyzer software on your computer.

Once the installation process has completed the installer file is no longer required and can safely
be deleted.

LogTag® Recorders does not charge for the download and use of this software, or for updates. You
are welcome to distribute copies of the LogTag® Analyzer software provided it is distributed
unaltered, in the packaged format as originally downloaded from the LogTag® Analyzer website.

The installation process
To install the LogTag® Analyzer software, locate the installation file downloaded in the previous
step and execute it (typically by double clicking or selecting the file in Windows® Explorer and
pressing Enter). Follow the on-screen instructions. Select the installer language and change the
program's storage location if desired. You can also choose if the default location for all downloaded
data files should be:

l only accessible by you, in your own Documents folder. You would use this, if you are the
only one requiring access to the downloaded data, or

l accessible by all users of the PC in the Public Documents folder. Use this, if all files from
multiple users on one PC should be stored in the same location.

Chapter 2: Installing the software 18
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Note: You can change the document storage location in LogTag® Analyzer 's option settings once
you have started the program, but you cannot change the program location. We recommend you
leave all options at their default setting, especially if you are unsure of what option to select or
what effects changing the option would have.

To proceed through each step of the installation process, click Next > . If you want to change a
previous step click < Back . When all required data have been entered, click Finish to complete the
installation process. If you want to stop installing the software, click the Cancel button.

The drivers required to operate your USB interface are installed as part of the main installation
process. From time to time updated drivers may be released by LogTag® Recorders. These drivers
will be available through the Microsoft Windows® Update feature, as an optional hardware update,
or as part of an upgraded installer file (See "Updating LogTag Analyzer")

Effective version 2.7r8 you can no longer use the *.exe installer with Windows XP or Windows Vista
operating systems. Neither operating system is now officially supported or tested by LogTag®

Recorders. You can still use the *.msi installer and the legacy USB drivers, however we strongly
recommend you perform your own validation testing. Some functions may no longer work in these
operating systems.

Updating LogTag Analyzer
From time to time, LogTag® Recorders will publish updated versions of LogTag® Analyzer to
introduce new or enhanced features, or to support new LogTag® models. LogTag® Recorders
recommend that you always use the latest version of the software.

You can get these updates…

… automatically, if you have enabled "Automatic Updates" see Software Updates on
page 172

… by selecting Check Internet for update... from the Help menu (1)

… by downloading an upgraded installer file from the LogTag® Recorders website.

This requires you check yourself if the version currently offered for download is more
recent that the one installed on your PC. You can find the version number of the
software in the title bar and via the Help menu (see Finding your software version on
page 196).

(1)Neither of these two options will transmit any information about you or your system to LogTag® Recorders, so you can rest
assured your privacy is maintained.



The Update Process

LogTag® Analyzer will check if a newer version
is available, independent of whether this
process started automatically or via the menu.

It will offer to download a new version if
available.

Any important update information will be
published on a special page on the LogTag
Recorders website, which you can view by
clicking the link.

Click Download to download the new installer
file to a temporary folder on your PC.

While the new installer file is downloading you
can see the progress indication.

Once the download is complete, click Install to
start the installation process. Follow the
instructions given on-screen. LogTag®

Analyzer will be closed before the update
starts, and will restart once the installation has
finished. The old version of the software will
be replaced with the new version.

Installing a newer version will update all the relevant program files. It will not affect any of your
LogTag data files or your custom settings of the software.

Chapter 2: Installing the software 20
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Starting the software
At the conclusion of the installation process click Finish to close the installer window.

At any time you can start the software ...

l ... by double clicking the "Shortcut" on the desktop

l ... by navigating to the "Shortcut" in the "Start" menu system.

Click on the "All Programs" item to locate the "LogTag® Analyzer" shortcut, similar to the
following picture:

Figure 10: Windows® Start Menu



l ... by selecting the LogTag® Analyzer tile from the Start screen

Please refer to your operating system documentation for further assistance about program
locations and how to execute programs.

Chapter 2: Installing the software 22



Chapter 3
First Steps

This chapter will cover how you prepare your LogTag® loggers for use, how to start
them and how to retrieve and analyse the recorded information. Subsequent chapters
will explain this in more detail, and also show you how you can customise LogTag®

Analyzer's settings to make your work easier.

In this chapter:

Connecting the Interface 24
Using the LogTag® with the Interface 25
The Workspace 27
Initial Set-up 28
Configuring a LogTag® for recording 28
Starting and using the LogTag® 37
LogTag® light patterns 37
Retrieve information from LogTag® 39
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Connecting the Interface
The interface cradles available from LogTag® Recorders connect to either a serial (RS232) port or a
USB (Universal Serial Bus) port, depending on the model you purchased.

The ports for serial (RS232) communication devices are typically located at the rear of the
computer as shown here:

Figure 11: Rear of PC with one serial port (RS232)

Insert the plug into the port with the correct orientation. We recommend you tighten the securing
screws when the connector is plugged in so that it does not accidentally pull out during use.

The ports for USB devices are typically also located at the rear of the computer, but you may find
other ports at the front or sides of your computer. If you are using a USB hub we recommend it has
its own power supply.

Figure 12: Rear of PC with 4 USB ports

Connectors for USB devices will often display a USB logo so you can identify them easier:

LogTag® Analyzer can communicate with multiple interface cradles at the same time; you may
connect as many serial and USB interface cradles as the computer supports, although we find that
connecting more than 4 interfaces becomes impractical.

If you install LogTag® Analyzer on a computer with no internet connection you must ensure USB
interface cradles are not connected until the installation is completed, since the required drivers
are installed as part of LogTag® Analyzer.

If the software cannot identify a connected USB interface cradle there may have been a problem
during the installation of the driver software. Please refer to the FAQ on the LogTag® Recorders
website for further information.



The LogTag® range of USB loggers do not require an interface to communicate with LogTag®

Analyzer.

Using the LogTag® with the Interface

Depending on the product you want to download you will need one of two different interface cradle
types.

Figure 13: Standard interface cradle with LogTag® Figure 14: TICT/TIC20 interface cradle

Most products use the standard interface cradle, where the LogTag® is inserted into the slot from
the top as shown to enable communication. You will be able to see the contact pins inside the slot
that meet with the matching contact pads on the LogTag®. When inserting a LogTag® into the slot
you feel a slight resistance as the contacts engage. Removing the LogTag® will cause a slight
clicking noise as the contacts snap back into their unloaded position.

The indicator products TIC20 and TICT use a special cradle in which the contact pins are exposed
at the top. To enable communication locate the indicator's lug on the interface's boss and firmly
press it down, so the contact pins pierce through the rear label. When using the TICT, please
remove the adapter from the bottom of the interface and place it as shown; this helps correctly
locating the contact pins .

Figure 15: TICT in interface with adapter

You can connect both interface types to your computer at the same time, provided you use
different ports.
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LogTag® Analyzer will automatically download and display
any readings or statistics stored inside the LogTag®.

USB logger products do not require a dedicated interface;
they communicate directly with LogTag® Analyzer when
plugged into a USB port.

The download process will only take a few seconds, but you
can stop it if needed by clicking Cancel or pressing the ESC key.



The Workspace
Once you have started LogTag® Analyzer, the main window will open. From here you have access
to menu commands, option settings and many other controls.

Figure 16: LogTag® Analyzer Workspace, showing areas of interest

You can find more information about the different areas here:

l Information for Menu commands on page 181

l Information for Toolbar commands on page 189

l Information for Upload Status Window on page 191

Use your mouse as usual to click menus, toolbar buttons and dialogues as they appear. You can
also use your keyboard to navigate most screens via shortcut keys, indicated by an underlined
character. Pressing the character on the keyboard will activate the corresponding control.

Depending on your version of Windows these shortcut keys may not be revealed until you press the
ALT key. You can permanently activate these keys via the Windows control panel by navigating
to its Ease of Access Center and selecting Make the keyboard easier to use. Here, select
Underline keyboard shortcuts.
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Initial Set-up
Before you start configuring and downloading loggers we recommend you customize some of the
settings which are available though the Edit-Options menu.

l Define the display language and temperature units used (see General Settings on
page 137)

l Choose how time and date are displayed (see Date and Time Format on page 166)

l Select how LogTag® Analyzer names downloaded files and where these are stored (see
File and Folder Settings on page 157)

l Decide which communication ports LogTag® Analyzer uses (see Communication Ports on
page 169)

Sometimes your network administrator will ask you to import settings from a configuration file.
You can read how to do this in the section about Importing and Exporting Option Settings.

Configuring a LogTag® for recording

Some of the LogTag® products are delivered to you ready to start. Others will need to be configured
before they can record data. During the configuration process of a logger you define settings such
as:

l how and when to start recording, how many readings to record and at which interval (see
Entering Configuration Parameters on page 41)

l whether to stop recording after a defined number of readings or to record continuously
(see Continuous operation on page 73)

l what alerts to process and at which temperature limits (see Alarm Processing on page 48)

l if password protection is required for setting up or downloading a logger (see Restricting
Access on page 71).

You can use a Wizard to assist in the configuration process (see Using the LogTag® Access Wizard
on the facing page) or select Configure from the LogTag menu (see Using the LogTag® Menu on
the facing page).



Using the LogTag® Access Wizard

You can use the LogTag Access Wizard by either clicking on the toolbar icon ( ) or by selecting
Wizard from the LogTag® menu.

Figure 17: LogTag Access Wizard from toolbar

Figure 18: LogTag Access Wizard from menu

The LogTag® Access Wizard performs following tasks:

1. The Welcome screen is displayed, giving you information about the process that follows. If
you enable the "Do not show me this information again" check box, the screen will not be
shown again next time you run the wizard.

2. All connected interface cradles are checked for inserted LogTag® products. If any of them
contain previously recorded data these are downloaded and saved.

3. A configuration window is displayed where you can enter details about the next recording
trip, such as interval and duration.

4. The configuration data entered are uploaded to connected LogTag® loggers.

Using the LogTag® Menu

You do not need to use the LogTag® Access Wizard to prepare loggers. You can perform the
configuration by clicking on Configure from the LogTag menu or by pressing the F3 key.

Figure 19: Configure LogTag® from menu

In this case downloading and saving data from a previous trip is skipped.

As soon as a logger is configured, previous data can no longer be downloaded. Please ensure you
have downloaded the readings before configuring to avoid data loss.

1. LogTag® Analyzer finds all communication ports (USB or Serial) with interface cradles
attached.

2. It checks all connected interface cradles for inserted LogTag® products.

Chapter 3: First Steps 29



30 LogTag® Analyzer Version 2.9 User Guide

3. It displays a configuration window where you can enter details about the next recording trip,
such as interval and duration.

4. It uploads the configuration data entered into any connected LogTag® loggers.

You can also use pre-configured profiles, or quickly re-configure a LogTag® with the same settings
as used for the previous recording. For more details on these options please see Configuration
Profiles on page 76 and Quickly re-configuring a LogTag®



Welcome Screen
First the Wizard has a welcome screen (this is "1" on the Action List). This asks you to make sure
you the LogTag® is placed firmly in the Interface Cradle.

Figure 20: Wizard "Welcome" Screen

The Wizard is responsible for certain "Action Steps" and these are clearly listed at the left in the
wizard window.

To get to the next screen, click Next > and the next wizard screen will appear. The green arrow
will indicate you have moved to Step 2.

Chapter 3: First Steps 31



32 LogTag® Analyzer Version 2.9 User Guide

Locate LogTag®(s), download and save relevant data

Figure 21: Locate LogTag®(s) screen

In this screen you will see one of the following pictures next to each of the items in the list:

l (no picture) indicates the software is still trying to access this communications port.

l Data were successfully retrieved from the LogTag® and stored/saved to disk.

l Data were successfully retrieved from the LogTag® but there was no need to save the
information to disk.

l The software was unable to detect an Interface Cradle connected to the
communications port or was unable to detect a LogTag® in the Interface Cradle.

l The LogTag® is a single use logger and cannot be prepared for use again. It should be
returned to the supplying distributor or agent or disposed of in accordance with local
regulations. You will still be able to continue to retrieve information stored within the
LogTag®.

The LogTag® should be almost instantly recognized by serial number and the number of readings.
It is possible to have and use more than one communication port at a time and if so, the wizard
will find all the LogTag®s.

The communication ports that are not in use (the ones that initially are reported with the
mark) can be removed from view by selecting an option. You don't have to do that now, but you
can do it later to clean up the "wizard window" appearance.



To get to the next screen, click on Next > and the third wizard step screen will appear. The
software will automatically proceed to the next wizard step, as if the user clicked on Next > , if
each of the Interface Cradles detected have a LogTag® detected in them and any data recorded was
successfully downloaded.

USB Loggers
There is a short delay after a USB logger is plugged in, before it can be accessed by LogTag®

Analyzer. This has two causes:

1. As soon as the USB logger is plugged in, it generates any files it has been configured for.
This process is skipped for units that are factory-new, as there are no files to generate,
however with subsequent configuration this process can take some time, especially if the
unit has a full memory buffer and has been configured to create PDF, CSV and LTD files.
While the files are being generated, the green LED is permanently lit. During this time, no
communication to the software is possible.

2. After file generation is complete, the logger starts a registration process with the operating
system called USB Device Enumeration. It will take a few seconds while the operating
system loads the required drivers. During this time, no communication to the software is
possible. When this process is complete, the green LED blinks.

LogTag® Analyzer can only detect and communicate with the USB logger once all files are
generated and it has completed USB enumeration (see note below).

As a result, if LogTag® Analyzer detects a USB logger, it keeps displaying the Locate and
Download window, rather than automatically advancing. This allows you time to insert the desired
number of USB loggers and to wait until they have completed USB enumeration. As soon as all
loggers are enumerated, press Again to update the list of devices, then Next > to continue the
configuration process.

To remind you of this, an additional message is displayed above the list of loggers and interfaces, if
a USB logger is found:

Note: Newer USB loggers suppress file generation while LogTag® Analyzer is running (see
Prioritising Communication over File Generation on page 68). This speeds up communication
between software and logger and is particularly useful for multi-trip loggers, as they can be re-
configured quickly without having to wait for all files to be generated. If you wish to access the
files on the device itself please close LogTag® Analyzer and wait for the device to be
enumerated.
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Configure LogTag®(s) for next use

Figure 22: Configuration Screen

The options are available so you have appropriate control over the way the LogTag®s will behave
and store data for the upcoming period of recording. These options are explained in more detail in
the chapter about Preparing a LogTag® for recording. Click Next > to record the configuration data
and you will see the final confirmation screen.



Preparing LogTag®(s) for use

The last Wizard screen involves sending the new configuration data to each LogTag® to prepare
them for their next use. While the software is sending the new configuration data to each LogTag®

the top of the window will look similar to the following picture. The process of sending the new
configuration data to each LogTag® should take less than 20 seconds in total to complete.

Once the software has finished uploading the updated configuration information into each
LogTag®, the window displaying the progress will look similar to the following picture.

Figure 23: Successful configuration of loggers

In this screen you will see one of the following pictures next to each of the items in the list:

l (no picture) indicates the LogTag® is still in the process of being prepared for its next
use.

l The LogTag® was successfully prepared for its next use.
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l This logger was not configured as its allowed maximum number of trips has been
exceeded. You will see this on SRIC-4, SRIL-8, USRIC-4 and USRIC-8 loggers when you
attempt to configure them for a second trip.

l The LogTag® failed to be prepared for next use. Press Again to try again.

l This logger was configured, however not all parameters selected in the configuration
window are supported by this model. Only supported parameters were uploaded.

l An upgrade is available for this logger. Please see Information for Upgrading USB
Loggers on page 70.

l The LogTag
®

s battery is low and is unlikely to have enough capacity to complete
another trip. In this situation the LogTag® should no longer be used.

When all LogTag®s have finished receiving their new configuration data, click Close to close the
wizard. Your LogTag®(s) are now ready to be started and used.

If you see the following message, one or more of the connected loggers was not configured
correctly:

The following message appears if all loggers were configured, but some of them don't support all
features set during the configuration.

Please note that the automatic download feature is disabled in this screen. If you use the Again
button to configure a different LogTag®, you may update the configuration of a LogTag® with
unsaved data.



Starting and using the LogTag®

Once a LogTag® has been successfully configured, it must be started to take readings.

A logger can start automatically at a date and time set during configuration, or manually by
pressing the START button on the logger.

The different start methods are explained in more detail in the chapter about Preparing a LogTag®
for recording.

For exact procedures how to start a logger or indicator product please refer to the individual
Product User Guides and Quickstart Guides, available for download from the product web pages at
https://logtagrecorders.com/products.

LogTag® light patterns

LogTag® products without a display signal different events and convey information with their
LED's. The table below contains a summary of the light patterns you may come across during use.
LogTag®

Signal Sequence Occurrence

LogTag® wake-
up signal

Sequence of four
alternate flashes of
green-red LED's

l displayed after configuration has been
successfully applied to the LogTag®.

l when a LogTag® is woken up from
hibernation.

Not to be mixed up with...

LogTag® start-
up signal

Sequence of sixteen
alternate flashes of
green-red LED's

l displayed when the LogTag® starts its
recording cycle.

Mark signal Sequence of five
simultaneous flashes
of green and red LED's

l displayed when pressing start/mark button
while recording to indicate an inspection
mark in the software.

l displayed directly after the start-up signal
following a push button start where a
recording delay has been configured. In this
instance the start-up signal is repeated
when the actual recording begins.

Logging active,
no alert present

Single flash of green
LED every 4 seconds
(approx.)

l indicates LogTag® is recording.

This is not displayed when pre-start is
active and the main logging cycle has not
yet started. It is also not displayed when
the green LED has been turned off in the
configuration screen.

Table 1: LogTag® light patterns
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Signal Sequence Occurrence

Logging
finished, no
alert present

Single flash of green
LED every 8 seconds
(approx.)

l indicates LogTag® has finished recording.

This is not displayed when the green LED
has been turned off in the configuration
screen.

Will also be displayed when unit has been
woken up from hibernation.

Logging active,
alert condition
present,

Single flash of red LED
every 4 seconds

l displayed when the LogTag® has detected
an alert condition and the Alert LED has
been activated.

Logging
finished, alert
condition
present

Single flash of red LED
every 8 seconds

l displayed when the LogTag® has detected
an alert condition and the Alert LED has
been activated.

For non-USB products the Alert LED will
still flash every 4 seconds.

Battery test Green and Red LED's
both turn on for
approx. 1 second

n displayed only for some TRIL-8 and SRIL-8
models. This puts a small load on the
battery during configuration, which allows
the battery voltage measurement to be
more accurate.

Communication The green LED will
flash occasionally

l during communication with the interface
the green LED will flash occasionally; no
information is conveyed in this.

Start button
press

red LED glows faintly l This is by design but conveys no
information.

USB loggers signal additional events, particularly when connected to a USB port:

Signal Sequence Occurrence

Ready for USB
One (MSD disabled) or
two (MSD enabled)
quick flashes of the
green LED every
second

l A USB logger is connected to a USB port and
waiting for USB communication.

Ready for
upgrade

The red LED is on
permanently

l A permanently lit red LED light indicates
the USB logger is ready to receive new
firmware. Special software is required to
upload new firmware to USB loggers.

Table 2: Additional USB Logger light patterns



Signal Sequence Occurrence

Generating PDF The green LED is on
permanently

l A permanently lit green LED light indicates
the USB logger is generating a PDF. No USB
activity will be observed on the computer
screen during this time.

Software priority
active

Long green flash l A USB logger is connected to a USB port and
is prioritising USB communication over file
generation.

It is also possible you see no LED lights at all. This could represent one of a number of conditions:

l The LogTag® is ready to start, but has not been started yet.

l The LogTag® has been configured so the LED flashing is turned off.

l The LogTag® is in "Hibernation". Refer to Hibernation - Prolonging battery life for further
information.

l The battery is empty and the LogTag® has reached the end of its life.

Retrieve information from LogTag®

When you are ready to view the recording just place the LogTag® into the Interface Cradle as
before (if the LogTag® is still recording it will continue to do so without interruption, and you will
be able to download the data again later).

The software will automatically retrieve any readings; during the download process an animation is
displayed, similar to the following:

Figure 24: Downloading a LogTag® logger

Once the readings have been successfully retrieved, the software will display the information. The
chapter Results from LogTag® Loggers explains in more detail what information is displayed and
how you can influence its appearance.

Your LogTag® may now also be reconfigured for another trip with the same settings as before, if
you have this option activated (see Re-configure with same settings after automatic download.)

Chapter 3: First Steps 39



Chapter 4
Preparing a LogTag® for

recording

Before you can use a LogTag® to record temperature or humidity data you need to
configure it. The process of configuration allows you to define a number of
parameters, including:

l how long it should record data for,

l how frequent it should record the data and

l at what temperature or humidity limits an alert should be displayed.

This chapter explains these steps in detail.
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Getting a LogTag® ready for recording

There are two ways to prepare a LogTag® for recording, both of which will achieve the same result.
Once a LogTag® has been through the configuration process to get it ready for next use, any
readings previously recorded will no longer be available for retrieval.

l Click the LogTag® icon ( ) on the toolbar or the "Wizard..." menu item located in the
LogTag® menu.

This is the safest option, as it will retrieve any readings that are stored within the
LogTag® and save them to disk before getting the LogTag® ready for next use. This option
is useful when you are unsure whether or not the readings stored within the LogTag®

have been previously retrieved and saved to disk.

l Click the "Configure..." menu item located in the LogTag® menu.

This is the quickest option, as it does not involve the step that retrieves any readings
that are stored within the LogTag®. This option is useful when you know you have
previously retrieved the readings or you no longer need a record of the readings that are
currently stored within the LogTag®.

The wizard will appear once you have selected the option of your choice to guide you through the
necessary steps to prepare a LogTag® for next use. While the wizard is visible the "Automatic
download" feature will be disabled.

Entering Configuration Parameters
The "Configure LogTag®(s) for next use" allows you to enter all the different options that affect
how the LogTag® records data during its next trip. This screen is automatically presented when you
use the wizard, however, you can also configure LogTag®s by selecting Configure from the
LogTag® menu.



Figure 25: Configuring a LogTag® using the menu

The values initially presented to you reflect the configuration parameters that were used when
this logger was last configured.

When you have entered the details and adjusted the settings as desired, click Next > to send the
configuration information to the LogTag®(s).

Figure 26: Configuration screen for a HAXO-8

The following table describes each configurable option; please note, however, that not every option
may be present for each of the LogTag® models.
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Function Purpose

User ID

(optional)

This can be used for identification of the load in transit to be monitored, or
simply an identifier that describes the purpose of the monitoring. Bill of
Loading information, Shipper, commodity, contact name and other relevant
information can be placed here.

The User ID can be up to 38 characters long (36 for recorders with a display)
and can contain a mix of letters, numbers and special characters. The selected
input language of the computer's operating system determines which special
characters can be selected.

If a user decides to make use of special characters, extra information about
the language used is stored inside the recorder. Users will then need LogTag®

Analyzer 2.3 Release 7 or later so the User ID is correctly displayed.

If you use the special character sets for languages such as Greek or Chinese
the maximum number of characters that can be used will be reduced due to
the increased memory required to store the characters.

Please see Appendix on page 197 for a more detailed explanation.

To view the PDF file generated by a USB logger, the fonts used must be
present on the receiver's computer. PDF Reader software typically only
installs a small number of fonts, none of which support an extended
character set. Therefore, you can only use ASCII characters in the User ID
field when configuring a USB logger.

Table 3: Logging configuration parameters and start options



Function Purpose

Start method

(mandatory)

This is used to determine how/when the LogTag® will start recording its next
set of readings.

l Date/Time start

When the 'Date/Time start' option is selected, the LogTag® will
automatically start recording at the date/time defined in the
subsequent field. Pressing the START/Mark button prior to the start
date/time will have no effect.

Note: When using the Date/Time start option, the start time must
be at least two minutes into the future. This delay allows you to
complete the remaining configuration options and gives the
software enough time to upload the configuration to the LogTag®

before it starts.

l Push button start

When the 'Push button start' option is selected, the LogTag® will
start recording when the START/Mark button has been pressed and
held until both the OK and Alert lights alternately flash on and off.

l Push button start from hibernation

When the 'Push button start from hibernation' option is selected, the
LogTag® will start as if programmed for 'Push button start'. The
difference is that once the configuration is successfully uploaded to
the LogTag® it will be placed into hibernation. When the
START/Mark button is pressed and held, the LogTag® will wake
from hibernation and start recording with the parameters as
configured.

Note: The real time clock inside the logger is not active with this
start option. It is therefore necessary that the computer on which
the unit is downloaded is set to the correct time, so the time on
the downloaded data is correct..

Please see Prolonging battery life for more information on
Hibernation.

Not every LogTag® model can support every start mechanism. If a start option
is not listed when configuring a particular LogTag®, this option is not available
for this model.
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Function Purpose

Enable pre-start
logging

(optional)

When you enable Pre-start logging, the logger starts taking readings as soon
as the configuration data have been uploaded. If you forget to press the
START/Mark button, the data for the trip will still be available. This insures
no critical data are lost. This option is further explained in the section Pre-
start data collection.

Pre-start readings will not be recorded if the start method is 'Date/time' or
'Push button start from hibernation'.

Record readings
continuously,
overwrite oldest
when memory
full

(optional)

When this option is selected, the logger initially fills the complete memory
with readings, and overwrites the oldest data when the memory is full.

If this option is selected, the user cannot select either of the two following
options. For a more detailed explanation see Continuous operation

Record readings
so that:

(optional)

If this is selected, the logger stops taking readings after a pre-determined
number of recordings. The following two fields determine the time these
recordings will cover.

Some LogTag® logger models cannot be stopped manually.

Readings
recorded will
span at least X
days

(optional)

If you know how many days of data you want to record, enter this number
here. The shortest possible recording interval that covers this period will be
automatically calculated, based on how frequently the logger takes a reading.

Number of
readings to
record X
(maximum is Y)

(optional)

This data box will display the calculated number of readings if you select a
time period and an interval. Alternatively, you can select the number of
readings desired, and the time period will be calculated based on the interval.
"Y" represents the maximum number of readings the LogTag® can store,
however with a selected interval and a selected time span, you may not need
to use all of the available data space.

Record a reading
every X
(mandatory)

This determines how frequently the LogTag® records and stores humidity
and/or temperature values.

Begin recording
after a delay of
X

(optional)

Enter the time that passes after a user has pressed the START/Mark button
on the LogTag® until the start of the recording. This feature is useful for
example, when the LogTag® could falsely trigger an alert because the
environmental conditions to be monitored are quite different to the
environment in which it is started.

If pre-start logging is enabled, the LogTag® will still continue to record pre-
start readings during this delay period.



Function Purpose

Enable the OK
(Green)
indicator

This determines whether or not the green LED should blink while the LogTag®

is recording.

Humidity /
Temperature

These tab controls will allow the humidity and temperature alert conditions to
be configured independently. They will only appear when configuring a
HAXO-8.

Configure
requires a
password

This feature allows the user to define a password that must be provided when
the LogTag® is next configured. If this option is enabled and the password
changes, the user will be required to verify the new password when the wizard
progresses to the next step. Passwords are case sensitive and therefore the
passwords "Bob" and "bob", for example, are different.

When configuring multiple loggers that already have different
passwords set, the password used for configuration will be allocated
from one of those passwords. We recommend you type a new
password to avoid any uncertainty about which password was used.

If you use special character sets for languages such as Greek or Chinese, the
maximum number of characters that can be used will be reduced due to the
increased memory required to store the characters.

Please see Appendix on page 197 for a more detailed explanation.

Due to the restrictions in the User ID you can only use ASCII characters in
the password field when configuring a USB logger.

Download
requires a
password

If this option is enabled, the LogTag®'s recorded data can only be downloaded
after entering the correct password.

Only one password can be provided for each LogTag®. The same password
applies to the Configure and Download actions.
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Function Purpose

Upgrade logger
to enable this
feature

TRIX-8, TREX-8, TREL-8 and HAXO-8 loggers which do not yet have the
"Download requires a password" feature can be upgraded. These units will
then require LogTag® Analyzer revision 1.8r9 or later (2.4r4 or later for HAXO-
8) to be configured or downloaded, and an error message will be displayed in
older versions.

If LogTag® Analyzer configures such a logger, an additional check box is
displayed:

The "Download requires a password" is grayed out if the update has not
previously been applied to the logger being configured. Once you tick the
"Update logger to enable this feature" box, the "Download requires a password"
check box becomes available for activation. You can then select the password
functions for either configuration or download. The logger will be permanently
upgraded as soon as the configuration is downloaded.

l The update cannot be reversed.

l If the "Update logger to enable this feature" is ticked, the upgrade
will perform, regardless whether any of the "...requires a password"
tick boxes are enabled or not.

l If multiple units are configured at the same time using more than
one interface, all units will be upgraded if the Upgrade option is
selected.

l When the "Again" button is used with a different unit, that unit will
also be upgraded.

If a unit has been upgraded in a previous session, and is now configured
using the "Download requires a password" function, units configured with
the "Again" button in the same session will not automatically be upgraded;
only those units that have already been upgraded separately in a previous
session will have the "Password on download" function enabled.

If the battery in the LogTag® reports 'low' the logger is should no longer be used. The software will
display a warning to you in the top right corner, like the following example.

Figure 27: Low battery during configuration

Some LogTag® models display the remaining percentage in this screen once it falls below half
capacity. Some models cannot be configured any longer once their battery capacity falls below a
pre-determined threshold.



Alarm Processing
The LogTag® can display a visual alert if one or more pre-configured alarm trigger conditions have
been met. Each alarm trigger condition consists of a threshold value, an activation type (which can
be instant, consecutive or accumulative (1)) and a delay value, if it is not an instant alarm.

If an alarm trigger condition requires readings to exceed an upper threshold temperature it is
called an upper alarm. If an alarm trigger condition requires readings to go below lower thresholds
it is called a lower alarm. Readings above the upper or below the lower threshold are called an
alarm reading.

Alarm trigger conditions can be used to show visual alerts on the logger itself, and in LogTag®

Analyzer once the readings are downloaded and displayed.

Gather as much information about the effects of exposure to different durations of out-of-
range humidity or temperature as you can, so you can match these alarms to known
conditions of interest in your monitoring program.

As with the other logging parameters these are adjusted in the "Configure LogTag®s for use"
screen.

Figure 28: Alarm parameter entry

Some loggers have advanced alarm settings or allow more than two alarms to be configured.
Typically these settings can be accessed by clicking on a separate button called Advanced Alarms or
similar.

l You can read about advanced alarms for TRIX-8, TRIX-16 and TREX-8 models in
Advanced Alarm Settings on page 52.

l Multi-alarm settings can be found in Alarm processing for USB Loggers on page 56.

l TRID30, TRED30 and TRED30-16R alarm settings are described in Display Logger Alarms
on page 55.

(1) Instant = one temperature reading is above (below) the threshold
Consecutive = temperature readings are above (below) the threshold for the time (multiples of the logging interval) defined
in the activation delay without interruption
Accumulative = temperature readings are above (below) the threshold for the total time (multiples of the logging interval)
defined in the activation delay time, but may not necessarily be sequential.
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The following table describes each configurable option for the basic alarm configuration found in
most loggers. Advanced settings for individual models are described in the relevant sections listed
above.

Function Purpose

Enable the Alert (Red)
indicator when

This defines whether or not the red alert indicator light should activate
when an alarm has triggered. When enabled, an active alarm is
indicated by this indicator flashing at a regular interval.

Readings below X or
above Y (inclusive)

You can set the upper and lower threshold limits by entering values
directly into the entry fields, or by increasing or decreasing the existing
values using the up/down arrows.

As long as readings stay inside the range specified by X and Y the alert
indicator will not activate.

Charts will highlight the readings above and below the
temperatures entered here, regardless of whether the alert
indicator is enabled or not.

The values entered in these boxes are included in the alert
range. In the above example 7 consecutive readings of 45°C will
trigger an alert, whereas 7 consecutive readings of 44.9°C will
not trigger an alert. Please set your alert values with this in
mind.

After X consecutive
alert readings (W
minutes)

Enable this activation type and enter the number of readings into the
adjacent field if you want an alarm to be triggered once X number of
consecutive alarm readings are recorded. The time shown will be
calculated from the number you enter and the recording interval. The
maximum value you can enter here is 256, the minimum is 2.

After X alert readings
have occurred (W
minutes)

Enable this activation type and enter the number of readings into the
adjacent field if you want an alarm to be triggered once a total number
of alarm readings are recorded. The time shown will be calculated from
the number you enter and the recording interval. The maximum value
you can enter here is 256, the minimum is 2.

You can enter a number directly into the field or increase or decrease
the values with the arrows. Please note that certain combinations of
accumulative and consecutive readings are not allowed.

Table 4: Alarm configuration parameters



Function Purpose

Leave alert indicator
enabled even if
readings return within
alert range

If this option is enabled the alert indicator will remain active, even if
the current reading no longer meets the alarm trigger conditions
specified.

If this option is disabled, the alert indicator will remain active only if
the current reading meets the alarm trigger conditions.

Please note, however, that this setting is only applicable if an
immediate alert is configured; if consecutive or accumulative alarm
settings are configured this box has no effect, and the alert indicator
will always remain visible once an alarm has occurred.

Clear and reset alert
when START/Mark

button pressed

If this feature is enabled, any user can turn off an active alert by
pressing the LogTag®'s START/Mark button. It will also reset the
internal alert counters as if no alert condition had occurred at all while
the LogTag® was recording.

Should the LogTag® subsequently detect a further alert condition, the
alert will activate again.

Once theLogTag® has finished recording, pressing the START/Mark
button will not clear and reset any active alert.

If the LogTag® being configured does not support this feature, it will be
disabled and its setting cannot be changed.

Example:

You wish to configure a LogTag® so an alert is indicated for 5 continuous alarm readings, or 7 total
alarm readings. The alarm parameters should therefore be set as follows:

This table shows how different conditions would result in the Alert Indicator flashing or not:

What the LogTag®

recorded
What the LogTag® indicated

2 readings out-of-range,
return to normal, 2 readings
out-of-range, return to
normal, 2 readings out-of-
range, return to normal

Neither alarm condition is met.
The maximum number of consecutive alarm readings is only 2 (5
required.)
The total number of alarm readings is 2 + 2 + 2 = 6. The alarm
trigger condition is 7 total, so the alert indicator remains off.

No Flashing Red Alert Indicator

Table 5: Alert examples
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What the LogTag®

recorded
What the LogTag® indicated

4 readings out-of-range,
return to normal, 4 readings
out-of-range

The first alarm condition is not met, as the the maximum number
of consecutive alarm readings is only 4 (5 required.)
The second alarm condition, however, is met since the total
number of alarm readings equals 4 + 4 = 8. The alarm trigger
condition is 7 total, hence the alert indicator flashes.

Flashing Red Alert Indicator

4 readings out-of-range,
return to normal, 2 readings
out-of-range

Neither alarm trigger condition is met.
The maximum number of consecutive alarm readings is only 4 (5
required.)
The total number of alarm readings equals 4 + 2 = 6. The alarm
trigger condition is 7 total, so the alert indicator remains off.

No Flashing Red Alert Indicator

6 readings out-of-range,
return to normal

The second alarm trigger condition is not met, as the total
number of alarm readings equals 6 (7 required.)
The maximum number of consecutive alarm readings, however, is
6, and since the alarm trigger condition requires 5 consecutive
readings, the alert indicator flashes.

Flashing Red Alert Indicator

Please note following special conditions:

1. If you wish an alert to be indicated on the first reading that is recorded out-of-spec, enable
the Enable the Alert (Red) indicator when and clear the tick from both After X
consecutive alert readings and After X alert readings have occurred.

2. You cannot enter a number into After X consecutive alert readings that is larger than the
number in After X alert readings have occurred, since the latter alarm condition would
always be met first.

3. Similarly, you can not enter a number in After X alert readings have occurred that is
smaller than the number in After X consecutive alert readings. The software will adjust
field values as appropriate.



Advanced Alarm Settings
TRIX-8, TRIX-16 and TREX-8 loggers support more detailed alarm settings than described before.
When you configure one of these models, an additional Advanced >>> button is visible in the
bottom left of the configuration screen.

When you click this button, the alarm configuration screen changes and you can adjust the options
in more detail:

Figure 29: Advanced Alarm Settings

The red alert indicator can now be configured independently for upper and lower alert values.

Function Purpose

Readings above X
Readings below Y

(inclusive)

In addition to entering the threshold levels you can now enable the
alarm conditions for only the upper or only the lower threshold settings,
or for both. If both are enabled, the behaviour is the same as for the
standard alarm settings.

After Z consecutive
alert readings (W
minutes)
Readings above
Readings below

You can enable consecutive alarm conditions separately for "Readings
above" and "Readings below". This will determine if only readings above
and including the upper threshold or only readings below and including
the lower threshold should count towards the consecutive conditions. If
both are enabled, the behaviour is the same as for the standard alarm
settings. If the Alert Indicator for either upper or lower alarms is
disabled, the respective box for the consecutive alarm cannot be
selected.

After Z alert readings
have occurred (W
minutes)
Readings above
Readings below

You can enable accumulative alarm conditions separately for "Readings
above" and "Readings below". This will determine if only readings above
and including the upper threshold or only readings below and including
the lower threshold should count towards the accumulative conditions.
If both are enabled, the behaviour is the same as for the standard alarm
settings. If the Alert Indicator for either upper or lower alarms is
disabled, the respective box for the accumulative alarm cannot be
selected.

Table 6: Advanced alarm settings

The advanced settings are displayed automatically without the need to press Advanced >>> if an
advanced configuration is already found in the logger to be configured. If you do not wish to use
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the advanced settings, press <<Simple , and the standard Alarm Processing configuration screen is
displayed.

Example:

You wish to configure a LogTag® so an alert is displayed if 5 continuous readings are out-of-range
or 7 total readings are out-of-range, but only if the temperature goes to 20°C and above. You wish
to see in LogTag® Analyzer if the product has gone to 0°C and below, but you do not wish to trigger
an alert for this condition. Alert parameters should be set as follows:

Figure 30: Advanced Alarm Settings - Sample settings

The following table shows how different conditions would result in the Alert Indicator flashing or
not:

What the LogTag®

recorded
What the LogTag® indicated

2 readings of 20°C or
above, return to normal,
8 readings at 0°C or
below, return to normal,
4 readings of 20°C or
above, return to normal

Neither alarm trigger condition is met.
The maximum number of consecutive out-of-spec readings is only 2
(5 required, the 8 readings below 0°C do not count towards alarm
readings).
The total out-of-range events equals 2 + 4 = 6. The alarm condition is
7 total, so there is no visual alert, as, again, the 8 readings below 0°C
do not count towards alarm readings.

No Flashing Red Alert Indicator

4 readings of 20°C or
above, return to normal,
4 readings of 20°C or
above

The first alarm trigger condition is not met, as the maximum number
of consecutive out-of-spec readings is only 4 (5 required.)
The second alarm trigger condition, however, is met since the total
out-of-range events equals 4 + 4 = 8. The alarm condition is 7 total,
so there is a visual alert.

Flashing Red Alert Indicator

Table 7: Advanced alert examples

Separate alarm trigger conditions for upper and lower thresholds are useful if you expect the
monitored product to encounter temperatures lower than the lowest possible alarm temperature.
In this case a flashing alert indicator may not necessarily indicate an unfavourable condition was
encountered. In programs where such conditions are monitored the lower alert should be turned
off.



Please note that USB loggers and loggers with a display also show an Advanced Settings
button, however, for those models the resulting screen is different. Please see the
following pages for further details.
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Display Logger Alarms
TRID30 and TRED30 loggers have a different settings screen.

Figure 31: Advanced alarm parameter entry for TRID30 and TRED30

The settings are similar to the Advanced Alert Settings, hence they are not explained again here.
There is, however, one notable exception; for each range (above or below) you can only select
either accumulative or consecutive readings, but not a combination of both. This does however give
you the option to select a different number of cumulative readings for above and below ranges.

The TRED30-16R has an additional option to enable an audible alarm:

Figure 32: Display logger with audible alarm setting

If enabled, a buzzer inside the unit will sound when an alarm event has been registered, until the
alarm is cleared.

Please note, that continual activation of the audible alarm will reduce the working life of
the battery. When an alarm event is triggered, the alarm should be cleared as soon as
possible. Please refer to the TRED30-16R Product User Guide for more information.



Alarm processing for USB Loggers
Different USB logger models offer different alarm trigger conditions.

USRIC-4
The USRIC-4 offers one upper and one lower alarm. Setting conditions for the two alarms is
identical to setting up a TRID30, except that the minimum and maximum threshold temperatures
are model specific and therefore different.

Figure 33: Alarm configuration for USRIC-4

USRIC-8 and UTRIX-16
These models can be configured for up to 6 different alarm trigger conditions.

If you wish, you can retain the traditional single upper and lower alarm settings. This will be
sufficient for most clients and is presented in the same way as for the USRIC-4:

Figure 34: Alarm configuration for USRIC-8, and UTRIX-16

This screen is presented if the logger's current alarm parameters contain a maximum of one upper
and one lower alarm (i.e. both, either, or none at all).

You can, however, add four freely configurable alarm trigger conditions to the primary upper and
lower alarms as shown in the next diagram:
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Primary upper alarm range

Upper threshold Alarm 4

Upper threshold Alarm 5

Upper threshold Alarm 6

Primary lower threshold

Primary upper threshold

Lower threshold Alarm 3

Primary lower alarm range

Alarm range 4

Alarm range 3

Alarm range 5

Non-alarm range

Temperature

Alarm range 6

Figure 35: Multiple alarm ranges for USRIC-8

To enter more than two alarm thresholds click Advanced alarm settings , which will expand the
dialogue to show you up to six lines, each with the option for instant, accumulative or consecutive
settings.

Figure 36: Sample Configuration Screen for UTRIX-16



Figure 37: Representation of 6 alarm trigger conditions in LogTag® Analyzer

Initially, start with the primary upper and lower alarms trigger conditions and activate additional
conditions separately. For each threshold value you enable, you can set the usual values such as
threshold temperature, activation type and alarm delay value.

Figure 38: Entry line for alarm trigger conditions

You need to observe some basic rules when entering alarm trigger conditions into the Advanced
Alarm Configuration Screen in LogTag® Analyzer:

l A primary upper alarm must be entered before more upper alarms can be entered.

l A primary lower alarm must be entered before more lower alarms can be entered.

l Any additional upper alarms must have the same or a higher threshold value than any
previously entered alarm.

l Any additional lower alarms must have the same or a lower threshold value than any
previously entered alarm.

l Threshold values for adjacent alarms can be equal when combined with different
activation types. For example, you can enter a primary upper alarm with an 8°C
threshold and 10 accumulative readings, plus an alarm with an 8°C threshold and 5
consecutive readings. In this instance the alam will be triggered, if either 10 readings in
total are above 8°C, or 5 consecutive readings above 8°C have occurred. If a combination
is not valid, an error message will be displayed.

l You can enter a different number of upper and lower conditions, or only upper, or only
lower conditions, or none at all. You can, however, not make all 6 alarms upper alarms,
and you cannot make all 6 alarms lower alarms either.

l A temperature value may contribute to multiple alarm triggers. In the above example, a
value of 18°C would be recorded against the 'above 8°C' alarm as well as against the
'above 15°C' alarm.

Any alarm condition that is enabled will be used to indicate an alert on the logger and will also be
shown on the PDF and in the software.

If you only wish to configure one upper and one lower alarm you can do this by only enabling the
primary lower and upper alarms. You can also hide any additional alarms by clicking
Simple alarm settings .
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You can switch between advanced alarms and simple alarms at any time during the
configuration process.

l When you switch from simple to advanced alarms, any alarms you have already
enabled will remain enabled and become the primary upper or lower alarms in
the advanced alarm screen.

l When you switch from advanced to simple alarms, the primary upper and lower
alarms will be retained, and all remaining entries will be discarded. If you decide
to switch back to advanced alarms again, you will have to re-enter these alarms.

USRIC-8M and UTRIX-16M models
For a short period in 2017, USRIC-8 and UTRIX-16 models with multiple alarm threshold values
were sold with the suffix M after the model name, i.e. USRIC-8M and UTRIX-16M. Effective
November 2017 this suffix has been dropped from the model designation, and USRIC-8 (from serial
number 5035127752) and UTRIX-16 (from serial number 5040022407) now support multiple alarm
threshold values. Models without the M suffix delivered with lower serial numbers only allow
simple alarm settings with one upper and one lower alarm. They can also not be upgraded.

If you are configuring earlier USRIC-8 and UTRIX-16 models that do not support multiple
alarm thresholds you will not be able to select the Advanced Alarm Settings .

If you are configuring older and newer units together you will see a yellow warning
triangle ( ⁠ ⁠) next to the button, reminding you that not all connected units can be
configured with advanced (i.e. multiple) alarm settings. In that case, loggers that support
the advanced alarm settings will be configured using the values as entered in the
advanced alarm screen. For any loggers that do not support the advanced alarm settings,
only primary upper and lower alarms will be set. The remaining alarms will be
disregarded.

UTRID-16
For the UTRID-16 a slightly different screen is shown. Click Alarm Settings in the configuration
screen to open a separate window.

Here, the alarm symbols that appear on the LCD are depicted next to the entries in the software.
The rules above are the same, and you still enter the usual values such as threshold temperature,
activation type and alarm delay value for each threshold you enable. You can, however, only enter
a maximum of three upper and three lower alarm conditions.



Primary upper alarm range
Primary upper threshold

Secondary upper threshold

Tertiary upper threshold

Primary lower threshold

Secondary lower threshold

Tertiary lower threshold

Primary lower alarm range

Secondary upper alarm range

Secondary lower alarm range

Tertiary upper alarm range

Tertiary lower alarm range

Non-alarm range

Temperature

Figure 39: Example Alarm ranges for UTRID-16

Figure 40: Representation for UTRID-16

Advanced Display Logger Options
When you click Advanced Options in the configuration screen, following window is displayed,
allowing you to enter parameters specific to TRID30, TRED30 and TRED30-16R loggers.

Figure 41: Advanced alarm options for display loggers
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Function Purpose

Clear and reset
alarm when
STOP/CLEAR

button pressed

If this option is enabled, any user can turn off an active alarm directly on the
LogTag® by pressing the STOP/CLEAR button. This will turn off the alarm
symbol and reset the internal counters as if no alarm had occurred while the
LogTag® was recording. When the LogTag® subsequently registers a further
alarm condition, the alarm will activate again. Once the LogTag® has finished
recording, pressing the STOP/CLEAR button will not clear and reset any active
alarm.

An alarm will always be registered in the day summary and cannot be
cleared, regardless of whether the alarm symbol was cleared or not.

Alarm remains
on even if
readings return
to non-
violation range

If this option is enabled then the alarm symbol will stay on, even if the current
reading does not meet the alarm conditions specified by the previous controls.

If this option is disabled then the alarm symbol will stay on only if the current
reading meets the alarm conditions specified by the previous controls.

Please note: Unlike for units without a display these settings also apply if
consecutive or accumulative alert settings are configured. If the Alarm
conditions are no longer met, all counters are re-set and an alarm is triggered
when the alarm condition is met again. In any case, an alarm will be
registered in the day summary, regardless whether conditions re-set or not.

Pause
alarm/statistics
processing for
X readings

If this option is enabled, pressing either button on the LogTag® while recording
excludes the next reading from the alarm and statistics calculations; PAUSED
will now be shown on the display. This allows the user to review the statistics
or clear an alarm without causing an invalid reading, alarm or statistic.

Switch off
display after 30
seconds

If this option is enabled, the display will turn off after 30 seconds to save
battery power.

Allow logging
stop with
STOP button

If this option is enabled, the LogTag® can be stopped by pressing the STOP
button. The recorder will no longer take any readings, however you can still
review the day statistics and download the logged results to a PC with LogTag®

Analyzer.

Table 8: Display logger alarms



Function Purpose

Allow reset of
logger with
START button

If this option is enabled, TRID30 and TRED30 loggers can be reset, and activated
again for a new trip by pressing the START button.

When resetting the recorder, all previously recorded readings and
statistics will be erased!

When this option is enabled, a warning box will be displayed to remind
you this is enabled and can result in loss of data.

Details about the reset procedure can be found in the Product User Guides,
available from the LogTag® Recorders website at
https://logtagrecorders.com/products.

Show total
summary days
collected

If this option is enabled, the LogTag® shows the number of days for which
statistics have already been collected on the display.

Enable Quick
start/stop if
available
(TRED30-16R
only)

If enabled, starting and stopping a TRED30-16R is faster than that of TRID30
and TRED30. Instead of holding the start button for 6 seconds (TRID30 and
TRED30), you will only need to press the button for approx. 1 second until the
unit starts or stops. For more detailed information please refer to the TRED30-
16R User Guide, available on the LogTag® Recorders website at
https://logtagrecorders.com.

If disabled, the standard start/stop method (6-second button press) is used.

Show user
resettable
Min/Max

(TRED30-16R
only)

If enabled, two additional screens are shown when reviewing the statistics on
the device display. These screens contain the minimum and maximum
temperature values recorded since the device was started. These values can be
cleared on the device, and new Min/Max temperatures will be recorded from the
time the values were cleared.

For more detailed information how the values are displayed and how you can
clear them please refer to the TRED30-16R User Guide, available from the
LogTag® Recorders website at https://logtagrecorders.com/products.

Please refer to the LogTag® Product User Manuals for TRID30, TRED30 and TRED30-16R loggers
on the LogTag® Recorders website at https://logtagrecorders.com/products for a detailed description
of the functionality of these products.

Note: When referring to TRID30 and TRED30 products, versions with both the fixed (F-suffix)
and replaceable (R-suffix) battery are included. The TRED30-16R model is only available with
replaceable batteries.
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Advanced USB Logger Display Options
When you click Advanced Options in the configuration screen, following window is displayed,
allowing you to enter parameters specific to the UTRID-16 model.

Figure 42: Advanced options for UTRID-16 display loggers

Function Purpose

Pause
alarm/statistics
processing for
X readings

If this option is enabled, pressing either button on the LogTag® while recording
excludes the next reading from the alarm and statistics calculations; PAUSED
will now be shown on the display. This allows the user to review the statistics
or clear an alarm without causing an invalid reading, alarm or statistic.

Switch off
display after 30
seconds

If this option is enabled, the display will turn off after 30 seconds to save
battery power.

Allow reset of
logger with
START button

If this option is enabled, a UTRID-16 logger can be re-activated and used again
for a new trip by pressing the START button.

When re-activating the recorder, all previously recorded readings and
statistics will be erased!

When this option is enabled, a warning box will be displayed to remind
you this is enabled and can result in loss of data.

Table 9: Display logger alarms



Function Purpose

Enable Quick
start

If enabled, starting a UTRID-16 is comparable to that of loggers without a
display. You will only need to press the button for approx. half a second until
the unit starts. For more detailed information please refer to the UTRID-16
Product User Guide.

If disabled, the standard start method is used (6-second button press).

Ex-factory this feature is enabled by default.

Show alarm
screens during
review

If enabled, the alarm threshold settings are shown when reviewing the
statistics data for the trip. For more detailed information please refer to the
UTRID-16 Product User Guide.

If disabled, only the min and max screens are shown.

Please refer to the LogTag® UTRID-16 Product User Guide on the LogTag® Recorders website at
https://logtagrecorders.com/products for a detailed description of the functionality of this product.

Additional USB Logger Options
LogTag® Analyzer allows you to set additional options for USB loggers, which decide...

… which type of files are generated at the end of the trip

… settings for time, temperature units, MKT parameters and if the logger can be stopped
and re-started

… how the individual elements of the generated PDF file will be displayed.

… How many and which alarms are activated

… What the display shows during recording and review

The next pages detail these functions.

USB Logger File Settings
LogTag® Analyzer allows you to set several options that decide which files will be generated when
a USB logger is plugged into a USB port, and how these files will look. (1)

(1)The USRIC-4 does not generate any files, therefore this dialogue window will not be displayed for this model.
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Figure 43: Advanced Option Dialogue for USB loggers

Following options are available:

Function Purpose

Generate PDF

Generate ltd

Generate csv

Select the file types the USB logger automatically creates each time it is
plugged into a USB port. The files are then accessible on a read-only drive or
mounted device via your file system.

The files created by the USB logger are not automatically copied to a
permanent storage volume on your computer. If you wish to retain
the files you need to manually copy them to a location such as your
Documents folder.

Clearing all file selection check boxes means no files will be generated and
you will need to access the data with LogTag® Analyzer.

Temperature
units

Select the temperature units to be used on the PDF report and in the CSV file.

Use local PC
Time Zone

When selected, the PDF file will display times and dates in your local PC's
time zone.

Table 10: Advanced Option Settings - General



Function Purpose

Time Zone You can clear the Use local PC Time Zone check box and choose a different
time zone. This is useful if you ship to receivers in a different time zone and
you wish them to see the times in their local time.

If you choose your own time zone settings you will need to adjust the time
zone for daylight saving yourself. For example, if you want the PDF data to
show the correct time for a user in New York, set the time zone to UTC - 5
during Standard Time and to UTC - 4 during Daylight Saving.

The time zone displayed in the PDF cannot be adjusted by the receiver! To
view the logger's data in other time zones the receiver will need to download it
with LogTag® Analyzer and adjust the displayed time zone. See Date and Time
Format for further details.

Time format Select 24 hour or 12 hour (am/pm) format.

Date format Select DD/MM/YY or MM/DD/YY format.

Calculate Mean
Kinetic
Temperature
(MKT)

Selecting this check box calculates and displays the MKT value on the PDF
report. If selected, you can choose the value of the Activation Energy to be
used for the MKT calculation:

l Use default ΔH value; if you select this option, the MKT value will
be calculated with the default value of 83.144 KJ/mol.

l Use the following value; you can select this option and enter a
custom ΔH value in the box. This value is then used for the MKT
calculations. Typical values range from 60.000 to 100.000 KJ/mol.

When you use LogTag® Analyzer to download a USB logger, the custom value
can also be used for the MKT calculations in the software. This is controlled by
a setting in the customisation for the Mean Kinetic Temperature (see page
125)

Allow stopping
with STOP
buttonWhen
enabled,

When enabled, the user can stop the USB logger by following the stop
procedure.

Prioritise
Download over
File Generation

When enabled, the logger attempts communication with LogTag® Analyzer
before generating on-board files. Please see Prioritising Communication over
File Generation for a more detailed explanation of this feature.

Following options influence the appearance of the PDF file.

The appearance of the PDF file can only be defined during configuration of the logger. It is
not possible to alter the appearance once the USB logger has completed its trip.
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Function Purpose

Generate Data
List

Select this to show pages in the report containing each recorded temperature
reading, along with the date, time and any special events that were recorded
against this reading.

The PDF file always contains a one page overview report. Please refer
to the individual USB Product guides for information about the
contents of the report.

When you clear this check box only the overview report will be created.

PDF Language Select the language of the PDF generated by the logger. Available languages
are:

l English

l French

l German

l Russian

l Spanish

Please note that this feature is only available on some newer models. If you
are unable to select a language other than English during configuration, the
feature is not available for your logger. The unit's display always shows
English characters regardless of the chosen language.

Y-axis scaling Select one of the following options to scale the chart displaying the recorded
readings:

l Range of readings; this scales the chart so the maximum and
minimum temperature displayed is just above/below the
highest/lowest recorded temperature reading. If you choose this
option the maximum screen area is used to display all recorded
readings.

l Range of sensor; this scales the chart to show the full temperature
measurement range of the logger.

l Custom range; when you select this option, the entry fields for the
two temperature values become active. Enter the values you wish to
use as maximum and minimum values for the chart's y-axis.

If readings outside your selected custom range are recorded
during the trip, the scaling is adjusted so the chart always
displays all recorded readings.

Show Y-axis grid
lines

Show X-axis grid
lines

Select which grid line will be displayed on the PDF. Clear the check boxes if
you don't wish to see the grid lines.

The position of the grid lines is automatically determined; it depends on the
Y-axis settings and the time span covered by the readings.

Table 11: Advanced Option Settings - PDF



Function Purpose

Show upper
alarm line

Show lower
alarm line

Select which alarm line will be displayed on the PDF. Clear the check boxes if
you don't wish to see the alarm lines.

The chart will not automatically zoom to include the alarm lines, if
they lie outside the selected Y-axis scale. If you wish to always see
the alarm lines, set a custom range Y-axis zoom which includes the
alarm values.

It is possible not all products you wish to configure support all features presented by LogTag®

Analyzer. If this is case, any feature that is turned on, but not supported by every product, will be
marked with a yellow warning triangle . You can still configure all units, the features marked
may, however, not be uploaded to all attached loggers.

Figure 44: Advanced Options with Warnings

Prioritising Communication over File Generation
When this feature is enabled, a USB logger will try to establish communication with LogTag®

Analyzer before starting to generate the on-board files, such as *.pdf, *.ltd and *.csv. This is
particularly beneficial for re-usable USB loggers such as the UTRIX-16, where you do not need to
see the PDF file again when re-configuring the unit. The time between inserting the logger and

Chapter 4: Preparing a LogTag® for recording 68



69 LogTag® Analyzer Version 2.9 User Guide

being able to communicate with LogTag® Analyzer no longer needs to account for the extra step of
generating any files on the unit itself and providing them via a new drive letter.

Recorder

plugged in

Recorder

plugged in

Recorder

plugged in

Driver Installation

Device Enumeration

Prioritise download

over file generation enabled

LogTag Analyzer not running

Prioritise download

over file generation enabled
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Driver Installation

Device Enumeration

Driver Installation
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Analyzer
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User can access data
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User can access PDF
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once Analyzer is closed

File generation active

File generation background activity

Communication with LogTag Analyzer

User can access data

in LogTag Analyzer

User can start LogTag 

Analzyer and access data

Figure 45: Timing comparison when inserting USB loggers

Some existing models already support this feature. If it is disabled, you can enable it, but please
keep in mind that the recorder will then become incompatible with LogTag® Analyzer 2.6 and
earlier. Subsequent disabling of the feature will NOT make the logger compatible with earlier
version again.

New models may already have this feature enabled ex factory.



Upgrading USB Loggers
LogTag® Recorders will from time to time add new functionality to USB loggers or enhance existing
features, allowing you to upgrade exiting units.

Note: You cannot start a logger upgrade unless .NET 4.0 is installed on the PC.

If an upgrade is available for your model, a red information circle ( ) will be shown in the location
column of the Locate screen. Once you click Next > , an extra selection is available in the
configuration screen, below the alarm settings:

This option is selected by default; you can, however, clear the box if you do not wish the logger to
be upgraded at this point.

LogTag® Recorders strongly recommend updating the logger if an upgrade is suggested.

This option is also available when creating and saving a configuration profile , you may need to
edit your profile after upgrading from an earlier version of LogTag® Analyzer. If you select to
upgrade, the configuration process will take about 2 minutes to complete.

The success screen will tell you if upgrade and configuration succeeded, or if errors occurred. If the
red Alert indicator remains lit, you can

l repeat the configuration process. LogTag® Analyzer will detect if the red Alert LED on a
USB logger is still active and try the upgrade process again.

l use the stand-alone upgrader. Close LogTag® Analyzer, click Start - Programs - LogTag
Recorders and click on the upgrader for you model. You will also need to use this
upgrader, if after an upgrade attempt the Configure Screen shows this message:
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Restricting Access
Users can enable a password protection feature. Once enabled, a user will need to provide the
correct password when next setting up the LogTag® for recording in the Restricted Access
dialogue.

Figure 46: Password entry

Only once the correct password has been entered can you view the configuration screen, change
parameters and configure the unit for a further trip.

Tip: Sometimes, users tick the password required boxes, but don't enter a password. Such
a "blank" password is valid, hence the password request dialogue will appear when re-
configuring such a unit. In this case simply selecting OK will advance to the next screen.
A warning message will inform you when you are using a blank password.

There is one exception to this rule. If a TRID30, TRED30 or TRED30-16R is re-configured using the
option Reconfigure with same settings after automatic download while at the same time the
option Skip configuration password prompt is enabled (as described in Quickly re-configuring a
LogTag® on page 81), a password does not have to be provided, as long as the data download has
been successful.

Please note that using this option deletes the data unrecoverably from the logger. To
safeguard your data you need to make sure the file that was saved during the procedure is
secure and cannot be deleted by unauthorised users.

Protecting Recorded Data
You can configure most models so they require a password before you can access recorded data.
This function can be enabled in the main configuration screen by selecting the check box next to
"Download requires password". The same password is used to protect configuration and download.

Some models do not have this feature enabled, but can be upgraded. In this case a further check
box appears on the configuration screen:



You cannot select "Download requires a password" if this update has not previously been applied to
the logger being configured. Once you select "Update logger to enable this feature", the "Download
requires a password" box becomes available for activation. You can then select the password
functions for either configuration or download. The logger will be permanently upgraded as soon as
the configuration is applied.

Following should be noted:

l The update cannot be reversed.

l If the "Update logger to enable this feature" is ticked, the upgrade will perform,
regardless whether any of the "...requires a password" tick boxes are enabled or not.

l If multiple units are configured at the same time using more than one interface, all units
will be upgraded if the option to upgrade is enabled.

l If this upgrade is applied, LogTag® Analyzer 1.8r9 or later will be required to access the
loggers. Older versions will display an error message if communication is attempted.

l When the "Again" button is used with a different unit, that unit will also be upgraded.

l Data files cannot be protected by passwords.

l If a logger has been upgraded in a previous session, and is now configured using the
"Download requires a password" function, units configured with the "Again" button in the
same session will not automatically be upgraded; only those units that have already been
upgraded separately in a previous session will have the "Password on download" function
enabled.

Password Rules
The password can be up to 6 characters long (16 characters for USB loggers and can contain a mix
of letters, numbers and special characters. The selected input language of the computer's
operating system determines which special characters can be selected.

If a user decides to make use of special characters, extra information about the language used is
stored inside the recorder. Users will then need LogTag® Analyzer 2.3 Release 7 or later so the
password is correctly interpreted.

This feature is not available in USB loggers.

If you use special characters for languages such as Japanese or Chinese the maximum number of
characters that can be used will be reduced due to the increased memory required to store the
characters.

Please see see Code Pages on page 199 for a more detailed explanation.

Verify Access Password
If the Configure requires a password option was enabled or the password was changed during the
configuration process the user is required to verify the password before it will be stored in the
LogTag®. A window similar to this will appear:
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Figure 47: Password confirmation

Once a password has been stored in the LogTag®, further access to it can only be achieved by
providing the correct password. Therefore, if a password is forgotten further access to the LogTag®

will not be possible. Passwords are case sensitive and therefore the passwords "Bob" and "bob", for
example, are different.

Pre-start data collection
LogTag® products support a feature called pre-start logging, which can be selected during
configuration.

When pre-start logging is enabled, the LogTag® will automatically start logging as soon as
configuration is completed. It will record at the sampling interval defined in the configuration and
will continue to record until the user starts the LogTag® by pressing the START/MARK button.
While the LogTag® is recording pre-start readings the Alert LED will not activate, even if an alert
condition is present.

Pre-start logging is useful as a fail-safe recording setting so if the LogTag® is not started at the
appropriate time, the readings will still be available to view later.

Once the LogTag® has been started, it will record as per the configuration settings. When the
readings are retrieved from the LogTag®, any pre-start readings will be separately displayed, so the
user can quickly identify the readings recorded before and after the LogTag® was started.

While the LogTag® is recording pre-start readings the LogTag® will operate continuously as
explained further in the section aboutContinuous operation. Once the LogTag® memory is full, the
oldest pre-start reading will be overwritten with the latest pre-start reading, or the latest reading if
the logger has been started.

If a LogTag® has been configured to start recording at a certain date/time, or for push button start
from hibernation, no pre-start readings will be recorded.

Continuous operation
All LogTag® products have a limited amount of memory to store the readings they record. When
selecting the option to Record readings continuously, the LogTag® will not stop once the memory
is full; instead it will replace the oldest reading stored with the newest reading so that only the
most recent readings are retained in memory.

Not every model supports continuous operation. If the LogTag® being configured does not support
this feature, you will not be offered to select this setting.



Working with more then one LogTag®

At some stage you may need to perform a similar task on multiple LogTag®s, whether it is
retrieving readings or preparing them for a new trip. The LogTag® Analyzer software has been
designed to make working with multiple LogTag®s easy.

To retrieve a copy of the recorded readings from multiple LogTag®s, simply insert each LogTag®

into the Interface cradle. The software will automatically retrieve the recorded data from the
LogTag®, save it to disk and then display the information for you (see Automation on page 144).
You can repeat this for each LogTag® without needing to interact with the software.

To prepare multiple LogTag®s for logging you can use the "Wizard..." or the "Configure..." from the
"LogTag®" menu, depending on whether or not you want to retrieve and save a copy of the
previous readings. Simply prepare the first LogTag®(s) as per usual and at the conclusion of the
last step replace it with the next LogTag® and click Again . Therefore, you will be able to prepare
multiple LogTag®s for use with minimal interaction with the software and/or computer. You can
also use a pre-configured Profile (see Configuration Profiles on page 76) or the Quick Reconfigure
feature (see Quickly re-configuring a LogTag® on page 81).
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Getting the best from your LogTag®

Many users of humidity and/or temperature loggers are used to attaching the logger to a hook or
tie-wrapping them to a monitored object. A wide variety of attachment methods can be used with
the hole on upper right hand corner of the LogTag®, such as bolting the LogTag® in position,
attaching it to a packaging strap, using a car-seal for security or other means.

The hole is quite strong, so most means of attachment will not compromise the structural integrity
of the LogTag®. We do, however, recommend that the dead weight stress on the hole itself not
exceed 5 pounds (2 Kg).

The sensor for the LogTag® is also very responsive, so we recommend you position the LogTag® in
a location, where it will not be susceptible to changes in temperature due to operational activities.
For example, it is not recommended you place a LogTag® beside a door way, as every time
someone passes through the door, the LogTag® will register the change of environmental
temperature due to the breeze that will be generated by the person, which does not necessarily
reflect the overall temperature of the environment being monitored.

Figure 48: LogTag® features



Configuration Profiles
To simplify the task of configuring multiple loggers with the same parameters, you can store the
settings you would enter during configuration (such as alert limits, logging interval, number of
readings etc...) in a Configuration Profile, and then apply them to loggers as required.

Configuring a logger with a pre-defined profile requires only three steps:

1. Select Profiles from the LogTag® menu

The window now displayed gives you an overview of the profiles already installed. You can
also add new profiles or edit and delete existing ones.

2. Select the profile you wish to use in the Configuration Profiles main window

Figure 49: Configuration Profiles Main Window

A Profile grid

B Profile control buttons

C Profile storage file path and name

D Profile file controls

E Dialogue controls

Chapter 4: Preparing a LogTag® for recording 76



77 LogTag® Analyzer Version 2.9 User Guide

3. Click Configure loggers to configure all loggers currently in connected interfaces using the
parameters stored in the configuration profile highlighted in the grid. You can also double-
click the profile name.

The next few pages detail the steps required to add and manage configuration profiles.

Profiles Grid
When you first select this feature the profiles grid will be empty (just like above). You will fill the
grid by adding profiles or importing profiles.

Figure 50: Profiles in the profile grid

Profiles from the grid can then be used to configure loggers. A single click on the column title will
sort the profile using this column. Double-clicking on a profile will configure all loggers currently
in connected interfaces using the parameters stored in the configuration profile. You can select
multiple profiles for export or deletion when you hold down the CTRL key while clicking, but you
cannot edit or apply more than one profile at the same time.



Profile Control Buttons
Use the control buttons to add new profiles, and to edit or delete existing profiles.

Clicking the New... button will bring up the "Edit Profile" window.

Figure 51: New profile window

A Profile name

B Recorder model
C Configuration parameters

This window contains all the controls you can find in the configuration window, plus one entry
field at the top where you need to enter the new name of the profile, and a drop down box where
you need to select the model type of the logger.

The same window will be displayed when you press the Edit button. Every entry field is now
populated with the saved value for this profile. Any entry field can be edited, with the exception of
the model type.

You can click OK to save the profile or Cancel to discard any changes.

Profile Storage File Name and Path
The collection of profiles displayed in the profiles grid is saved in a single file on your PC, which is
called the profile file. This file is typically stored in a folder called "LogTag Configuration Profiles"
inside the "My LogTag Documents" folder. Every time you open LogTag® Analyzer this profile file
is activated.

You can select alternative collections by opening different files. This can be useful if for example
you want to keep different profiles for different customers, or you prefer to separate and organise
your profile collections.

Chapter 4: Preparing a LogTag® for recording 78



79 LogTag® Analyzer Version 2.9 User Guide

You can click on the button and select a different profile file. If you have unsaved changes you
will be asked to confirm if you want to first save these changes. An explorer window will then
open, where you can select a new profile file.

Note: To create a new profile file, export one or more profiles to a new profile file. You can then
open the new profile file and add, edit or delete profiles as usual. Alternatively, you can download
an empty profile file template from
https://logtagrecorders.com/download/software/analyzer/Blank_Profile.ltp.

Profile File Controls
If you have stored your profiles in different profile files, you can transfer data between different
files with the import and export buttons.

When you click Import... , an explorer style window will open. Select the profile file from which
profiles will be imported and confirm your selection by clicking Open . All profiles from the
selected profile file will be imported into the currently active profile. If a profile is imported that
has the same name as an already active profile, you need to confirm whether you wish to skip the
import of this profile or overwrite the active profile with the imported profile.

You can export selected profiles to a new file by highlighting a profile and clicking Export selected... .
An explorer style window will open, where you can enter a new profile file name (the file will be
created when you click Save ), or overwrite an existing profile. If a profile is exported, and a profile
file already exists, you need to confirm whether you wish to cancel the export of this profile or
overwrite the profile file. You can export more than one file at the same time by selecting the
desired files while holding down the CTRL key.

You cannot amend a profile file by exporting a profile to it. Exporting a profile will always
overwrite the target profile file.

Profile Dialogue Controls
Clicking Save changes and exit will store the profile in the location entered above. Clicking Cancel
will discard any changes and return you to the main window.

Please note there are some restrictions when you work with configuration profiles:

l Configuration profiles cannot use the date/time start mechanism. If a defined start time
were to be applied to a profile, this time would most likely have passed by the time the
profile is applied. If you need to configure a number of loggers and you want them all to
start at the same time you should use the standard configuration screen and the Again
button.

l You cannot configure one type of logger model with a profile written for another model.

l You cannot have multiple profiles with the same name.

l If you have exported a profile to a profile file, canceling the main edit window will not
undo the changes.

l If you try to apply a profile to a logger with a password protected configuration, this
same password must be provided in the profile. There is no separate password
confirmation dialogue.

l Loggers that can be upgraded to use a download password will automatically be upgraded

https://logtagrecorders.com/download/software/analyzer/Blank_Profile.ltp


when a profile is applied using this feature.

l Values marked with a warning triangle will be stored in the profile, however they will
only be applied during configuration if the product supports this feature.

Also, some profiles can be applied to models with different memory sizes (such as TRIX-8 and
TRIX-16). Profiles for these models include an extra option to record the maximum number of
readings. This ensures that the logger will always use the maximum number of readings
permissible for the size of memory fitted and means that you can apply such a profile to both the
8K memory model as well as the 16k memory model with the maximum readings adjusted to suit.

If the logger is configured to record readings continuously it will always use the maximum
available memory.

Sometimes a logger cannot be configured using a particular profile. In this case one of the
following errors will be displayed:

Message Description

"Logger does not
support advanced alert
settings"

You have selected a profile which has separate upper and lower alert
settings, but the logger you wish to configure does not support this. You
will need to use a different profile, or use a different logger if this
feature is important for this trip.

"Logger cannot record
more than X readings"

You have selected a profile that requires the logger to take more
readings than fit into its memory. You will need to use a different
profile, or use a different loggerif this feature is important for this trip.

"Password in profile
does not match logger
password"

You have selected a profile with a password, and the password currently
stored in the logger is different. You will need to use the normal
configuration process to remove the password; after that you can use
the profile function to configure the logger with the new password. If
the logger does not allow the password to be changed, you will need to
use a different profile.

"A password cannot be
applied to this logger"

You have selected a profile with a password, but the logger is factory
configured so the user cannot change or enter a password. You will need
to use a different profile that doesn't have a password protection, or use
a different logger if this feature is important for this trip.

"Logger only supports
latched master alarm"

Loggers typically can have a setting applied that allows an alarm to
reset if conditions go back to within specification. Some older TRID30
loggers do not support this feature, and if you attempt to configure such
a logger with a profile using this setting you will see this error. You will
need to use a different profile or use a later model TRID30 if this
feature is important for this trip.

Table 12: Profile error messages
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Message Description

"Profile logger type
does not match"

You are trying to configure a unit with a profile that was created for
another model. A profile is specific to a logger model, so you will need
to use a different profile.

"Lease expired. The
max. number of starts
has been reached."

You are trying to configure a unit which has no more trips left. You will
need to use a different logger.

Quickly re-configuring a LogTag®

You can configure a LogTag® logger without first displaying the configuration screen. To do this,
you can use the "Quick Re-Configure" function from the LogTag® menu, and you will see the
"Upload configuration" screen where a recorder will simply be re-configured with the settings used
for the previous trip.

You can also use the F6 function key.

There are certain rules when using this function:

l You can use multiple interfaces. Each LogTag® detected in an interface is re-configured
with the same data used for its previous trip. Loggers do not have to be of the same
model, and can each have different configuration settings.

l Re-configuration is only possible for loggers which used the "Push button" or the "Push
button from hibernation" start method for their previous trip. If the recorder's previous
trip was started by the date/time start method the quick re-configure option will result in
an error message being displayed.

l If a logger requires a password for configuration you will be requested to provide this
password. If you enter an incorrect password, the configuration process will be aborted.

l If the LogTag® is still logging when you reconfigure it, you will be asked to confirm
whether or not you wish to stop the current trip.

You can automate this further by setting an option in Edit - Options - Automation. When you
enable Reconfigure with same settings after automatic download, any logger that is downloaded
successfully will automatically be re-configured with the settings used for the last trip. This is
particularly useful for loggers in stationary applications, where regular download and subsequent
re-configuration is required.

The rules as listed above also apply to this feature. For TRID30, TRED30 and TRED30-16R loggers
you can, however, disable the requirement for providing a configuration password by enabling the



Skip configuration password prompt feature. In this case the re-configuration will proceed
without you needing to provide the password.

Please note that using this option deletes the data unrecoverably from the logger. To
safeguard your data you need to make sure the file that was saved during the procedure is
secure and cannot be deleted by unauthorised users.

Automatic Re-Configuration after Download
To process loggers even faster you can now set-up an option to re-configure a logger with the
same settings after it has been downloaded using the automatic download option.

This feature is set up in the Automation section of the general options by enabling the check box
"Re-configure with same settings after automatic download".

Once enabled, a LogTag® is automatically downloaded once inserted in the interface cradle, and
immediately re-configured with the same settings as the trip just completed. You will receive the
following feedback once the configuration is complete:

Please note this option only works when a LogTag® is automatically downloaded when inserted
into the interface, i.e. the "Enable automatic download of readings from LogTags" option must be
enabled, and the download triggered by inserting the recorder into the interface. This does not
apply when the LogTag® is downloaded through the menu of by pressing F4.

A word of caution: If the LogTag® you have downloaded does not have a configuration password
and has also finished logging, the only visual feedback on the PC will be after the recorder has
already been re-configured for a new trip. You will only be able to access the data from the trip
just downloaded on the PC, but not within the recorder. Therefore it is important you make sure
the file location for storing data is always accessible to avoid loss of data.

Hibernation - Prolonging battery life
If your LogTag® is not going to be used for extended periods of time you should set it to
"Hibernation". While in "Hibernation" the LogTag® will consume minimal power, which will extend
the battery life when compared with leaving an idle LogTag® operating.

While a LogTag® is in "Hibernation" it will:

l Not record and store any new readings.

l Not activate the Alert and OK lights.

l Not respond to the START MARK button being pressed.

The only exception is when the LogTag® has been configured for 'Push button start from
hibernation' in the configuration screen. In this case pressing the START MARK button will 'wake'
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the product and commence logging according to the configured settings. Not every model supports
this feature.

To 'wake' a LogTag® from "Hibernation" to normal operation go through the usual process of
Entering Configuration Parameters (see page 41).

To set a LogTag® to "Hibernation", select Hibernate... from the LogTag menu.

You can also use the F5 function key.

You will see this screen when hibernating a logger.

Figure 52: Hibernation successful

You will see one of the following pictures next to each of the items in the list:

l (no picture) indicates the LogTag® is still in the process of being hibernated.

l The LogTag® was successfully set to hibernation.

l The software was unable to set the LogTag® to hibernation.

Once a LogTag® has been successfully set to "Hibernation" it should be removed from the Interface
Cradle before pressing any other button. As soon as the software communicates with a LogTag® in
"Hibernation", (for example through automatic download it will be returned to normal operation.

The extent to which the Hibernation will prolong the battery life of a LogTag® may vary between
different models and versions of LogTag® products. Some LogTag® models may not support
Hibernation.



Chapter 5
Results from LogTag® Loggers

Once a LogTag® has finished recording, you can

l download the data to a PC, using the LogTag® Analyzer software and an
interface cradle,

l view and analyse the information and

l print the information or save it to other formats.

This chapter explains these steps in detail.

In this chapter:

Getting results from LogTag®s 85
Saving LogTag® Data 87
Analyzing the results 94
Combining charts onto a single chart 117
Automatically calculated statistics 123
Displaying statistics 126
Printing the results 127
Emailing a file directly from LogTag® Analyzer 129
Calling up previous results 130
Digital signatures 132
How secure is my data 133
Viewing file properties 134
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Getting results from LogTag®s

LogTag® products store all recorded data non-volatile memory. You can download the data as many
times as you want, as long as the logger is not re-configured or hibernated.

When you download the data, a file is automatically created in a pre-defined folder. Typically this
is the C:\Users\User\Documents\My LogTag Documents folder, but you can customise it to your
requirements see Folder Name on page 161

Downloading data stored in a LogTag® does not erase the data from memory, however if you have
enabled the "Automatically re-configure..." option you will no longer be able to access the data in
the logger once this process has started. In this case you need to open the data file to access the
information.

If the LogTag® is currently recording while you retrieve the information, it will continue to record
without interruption. If the logger is in the process of taking a log you may see a slightly longer
download time as communication pauses to allow the log to be taken.

There are three ways to retrieve the recorded results from a LogTag®:

l via automatic download

Slot the LogTag® into the interface cradle while the LogTag® Analyzer software is
running (this can be in the background, or even minimized). If the automatic download
feature is enabled, the software will automatically retrieve the recorded readings, save
the information to your disk drive and display the information to you. While the software
is automatically retrieving the readings you will see an animation, similar to the
following picture.

You can also enable the option to automatically re-configure the LogTag® with its current
settings (see see Automatic Re-Configuration after Download on page 82).

l via the menu system

Click Download... from the LogTag menu.



You can also press the F4 function key.

l Using the Wizard

Click the LogTag® icon ( ) on the toolbar or click on Wizard... from the LogTag menu.

The wizard will guide you through the necessary steps to retrieve the readings stored in
the LogTag® and then offer to prepare the LogTag® for its next use. If you do not need to
configure the LogTag® at this time you can cancel the process, however if you do not
intend to configure units directly after downloading you may find it quicker to use the
previous option.

Note: While the wizard is visible the "Automatic download" feature will be temporarily disabled.
You will not be able to access any of the Wizards while an "Automatic download" is in progress.
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Saving LogTag® Data

This section shows the different ways data can be saved and presented to you.

Saving LogTag® Data files

Every time you download a LogTag® Logger to your computer the data are automatically saved to a
file with a *.ltd file extension (LogTag® Data). This type of file is unique to LogTag® data loggers
and can only be read by LogTag® Analyzer software.

You can customise the conditions for which the file is generated in the Edit - Options window:

l You can determine the file's name by specifying the key details about the logger it was
downloaded from (see File Name on page 158)

l You can decide if existing files with older data should be overwritten or kept (see
Uniqueness on page 163)

l You can automatically have files sent to email recipients and FTP sites (see Automation
on page 144)

l You can decide which additional other file formats are created (see Exports and Reports
on page 163)

You can also save all or part of the data in other files to make them accessible to other users (for
example as Selected LogTag® Data files (*.sltd) and PDF files).

Please refer to the respective sections in this user guide for more information.

Note: If the logger you are downloading has not taken any readings, a message similar to this is
displayed:

Saving a Multi Chart file
If the main LogTag® Analyzer window currently displays a Multi Chart as explained in Combining
charts onto a single chart, you can save the current configuration by clicking on the toolbar icon
or selecting Save from the file menu. Select a file name and location for your Multi Chart file. The
file extension for Multi Chart files is "*.multi".

A Multi Chart file does not contain any recorded data. Instead, it contains a collection of
information that describes which data files need to be opened, and in which relation to each other
the data inside these files should be displayed, such as chart colors and time offset when Shifting
chart start times.

Therefore, if any of the data files referenced in a Multi Chart file are renamed, deleted, or moved
to a different folder, this Multi Chart file will display error messages.



A Multi Chart file must be saved in the same folder as the individual data files. It is not sensible to
store relative path information inside the file, as it would make it difficult to email a Multi Chart
file if the recipient would have to re-create the exact folder structure as the sender for the file to
be displayed. From version 2.4 onwards you can select any folder for storing your Multi Chart file.
If this file references *.ltd files not stored in this folder, a dialogue box will appear requesting you
to confirm that all files will be copied to the chosen folder.

Figure 53: Confirm Multi Chart file copy

Any annotations added to the Multi Chart display are saved in a separate annotation file with the
file extension ".anno". This file must be located in the same folder as the Multi Chart file to be
included in the Multi Chart display.

To open a previously saved Multi Chart configuration file, click on the toolbar icon or select
Open... from the File menu , then select the "*.multi" file to be opened.

To save a Multi Chart file under a different name, select the Save As... command from the File
menu and enter a new file name.

Note: You can save a Multi Chart file as a PDF, but not as any of the other export file types.

LogTag® indicator products such as the TICT or TIC20 do not have date/time related readings and
therefore do not appear on the multichart.

Selected LogTag® Data files (*.sltd)

Users can save data to a "Selected LogTag® Data" file, which -when opened again- will display a
smaller time window of the recorded data. This window is defined through the zoom settings of the
currently active tab, or can be entered in the dialog box displayed when when clicking Save as...
from the File menu with 'Selected LogTag® Data (*.sltd)' as the file type.
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Figure 54: Saving a file as a *.sltd file

Select a file name and location for your file.

The chart of this file, which contains pre-start readings, has been zoomed to show only a small
proportion of the readings:

Figure 55: Zoomed chart display

The window slider shows there are still readings earlier and later than the displayed data.

When saved as a *.sltd file, it will be automatically re-opened and now only displays the previously
zoomed readings. You will note that the pre-start readings are no longer displayed and you cannot
zoom out or display any readings before and after the selected time frame.



Note: Those readings which are no longer displayed are still present in the file. Any *.sltd file can
be saved as a *.ltd file, and when re-opened, all readings taken by the recorder during this trip will
become available for viewing.

This can also be achieved by simply re-naming the file from *.sltd to *.ltd.

Files with a *.sltd extension cannot be read by versions of LogTag® Analyzer earlier than 2.0,
they can however be read once renamed to *.ltd.

*.sltd files can also be opened directly from email attachments or by double clicking the file in
Windows Explorer, as the installer forLogTag® Analyzer registers this file extension and
associates it with LogTag® Analyzer.

For TRID30, TRED30 and TRED30-16R the *.sltd files no longer show the summary tab.

Saving a file for use in spreadsheets
Occasionally you may wish to export a LogTag® data file so you can analyse it in more detail using
a spreadsheet program such as Microsoft™ Excel. You can choose between a few different options
to achieve this:

l You can use the File - Save as command from the menu, and select the *.csv option.
You can include pre-start data by ticking the box.
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CSV files can be read by most spreadsheet programs.

Please note that files created by LogTag® Analyzer may not always be true CSV files ( 
C omma S eparated V alues), as they use the list separator from the Windows
operating system. It does however mean the file can be opened with MS Excel without
going through the data import facility. To create a true CSV file select "Use custom list
separator" and enter a comma in the adjacent field. You can also use the custom list
separator to generate files for applications which require other list separator
characters.

l Select the Data tab and press CTRL-C or choose Edit - Copy from the menu. Open an
empty worksheet in your spreadsheet program and select CTRL-V or choose Edit - Paste
from the menu. The data will be pasted in the cells and you can save the file in the

format of your spreadsheet program.

l Automatically export the data into a CSV file when a logger is downloaded. Please see
Exports and Reports on page 163 for further details.

LogTag® Recorders also offer a conversion program, which you can use to bulk convert *.ltd files to
*.csv files. You can download this utility called LogTag® Convert from the software download page
at https://logtagrecorders.com/software.

PDF files
LogTag® Analyzer can save the currently active LogTag® data window to a PDF file. One single file
will be generated which contains chart images, summaries and a data list.

https://logtagrecorders.com/software


PDF files can be generated automatically, or by selecting Save as from the File menu and selecting
a file name and location for your PDF. Automatic generation of PDF files is enabled in the section
about Exports and Reports. Here you can also define the composition of the PDF file.

Click Customize *.pdf ; the following dialogue is displayed, allowing you to select, which content of
the PDF file will be created.

Figure 56: Customisation options for PDF files

Note: Only one single Data listing will be created. Depending on which sections are enabled, pre-
start only, chart only or all readings will be included.

Note: The report page is always included in the PDF. For display loggers, the day summary will
also be always included.

Each section can be identified by its heading. If a chart is zoomed, the PDF file will also contain a
zoomed setting.
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Analyzing the results
Data are displayed and analysed in file windows, which appear inside the main LogTag® Analyzer
window. Each file window displays the data of a single logger and has a series of tabs along the
bottom. Clicking on a tab changes the way the information is displayed; different file windows may
display different tabs.

You can activate Multi Chart display, and all open file windows are combined into a single window.
You can find more information about this feature in Combining charts onto a single chart.

These are the different ways to display the information in the file windows.

Tab selected Information displayed

Report Tab A summary display of the downloaded data, including a summary of the
important trip information and an overview graph.

Chart (or Log
Chart)

A display of the data in a humidity and/or temperature versus time chart.

Data A listing (spreadsheet style) of the time versus humidity and/or temperature
data.

Summary A summary of the data, including averages, ranges, alert results, LogTag®

identification data, and other information.

Day Summary A summary of the day statistics for display loggers.

Day Summary
Chart

A display of the minimum/maximum data in a temperature versus time chart;
for the iS0°Tag indicator only.

Pre-Start Chart Same as the "Chart", but limited to only show pre-start readings.

Pre-Start Data Same as the "Data", but limited to only show pre-start readings.

Pre-Start
Summary

Same as the "Summary", but limited to only show pre-start readings.

All Chart Same as the "Chart", but showing both regular and pre-start readings.

All Data Same as the "Data", but showing both regular and pre-start readings.

All Summary Same as the "Summary", but showing both regular and pre-start readings.

Table 13: Tab summary

The most used tabs will typically be the report tab or the chart tab, as the information displayed in
either of them gives an instant overview of the data, whether just recorded and downloaded from a
LogTag®, or retrieved from previously stored data files.

In some cases not all of these tabs are displayed. You may for example see only Report, Chart,
Data and Summary, if the LogTag® has been configured not to record any pre-start data.

Note: Indicator products such as the TICT or TIC20 only display the Report and Day summary
tabs. The iS0°Tag indicator displays Report, Log Chart, Data, Day Summary and Day Summary
Chart tabs.
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The following sections describe each type of information display (Report, Chart, Data, Summary,
Day Summary and Day Summary Chart) in more detail.

Chart Display
Clicking on the Chart tab presents the information in the file window as a 2-D line chart with
markers. When you first start LogTag® Analyzer, this tab is activated by default, but you can
change this in the Options .

Note: for iS0°Tag indicators this tab is called Log Chart, so it can be distinguished from the Day
Summary Chart (see Indicator products on page 107).

A Chart title

B Above alert area

C No alert area

D Graph line

E Below alert area

F Time line

G Time zone

H Chart Statistics

I Tabs

J Chart legend

Figure 57: Chart display

You can see how humidity or temperature changed over time. If you want to see parts of the graph
in more detail, you can zoom in and display a smaller section of the data. Move the cursor to the
upper left corner of the area you wish to magnify, hold down the left mouse button and move the
cursor so it covers the area you wish to see:



Figure 58: Chart display while zooming with the mouse

When you release the left mouse button, the area highlighted now fills the window:
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A Chart sub-title

B Mouse cursor on data point

C Tooltip

D Marker

E Download mark

F Inspection mark

Figure 59: Zoomed area

Depending on the zoom level not every data point may have a marker displayed. LogTag® Analyzer
adjusts the display of markers so the graph line is still visible. These markers can also be turned
off, and their appearance can be altered. You can learn more about this in the Charts Section.

When the mouse pointer is moved over the chart, a tooltip is displayed near the mouse pointer (as
shown in the example). It displays the reading closest to the mouse pointer position. If the
readings are very close together, you may want to zoom in further and then inspect individual
readings with the help of tooltips.

The tooltip will always show date and time of the recording, even when elapsed time is chosen for
the x-axis display. This will allow you to get the date and time information quickly without having
to change the setting in the options for Charts.

You can also add annotations (Chart annotations) and a subtitle (Chart subtitle) to the chart.

The chart area displayed in the window can be copied to the clipboard by either pressing CTRL-C,
selecting Copy from the LogTag menu or clicking on the Copy icon ( ) in the toolbar. This
picture can then be pasted into any Microsoft Windows® application. For example, if you are
writing a letter and want to illustrate a point based on chart data from a LogTag®, you can paste
the picture of the chart directly into the letter.



Event Markers
A reading is tagged when a user interacted with the logger between this reading and the previous
reading. Tags are stored with the reading, which is then displayed differently on the chart (and also
in the data listing):

Event Mark Description

Inspection Each time a user presses the Start/Mark button (or
Review/Mark button on some models), the next recorded reading
will be tagged with an Inspection event.

For such a reading the inspection mark symbol is shown on the
chart instead of the regular temperature marker.

Download Each time a logger is downloaded to a PC, the next recorded
reading will be tagged with a Download event.

The download mark symbol is shown on the chart instead of the
regular temperature marker.

Clock Adjust

(Display Loggers
only)

Each time a user adjusts a logger's display clock using the buttons,
the next recorded reading will be tagged with a Clock Adjust
event.

On the chart, a vertical dashed line is shown, which intersects the
temperature marker of that reading.

Paused
(Display Loggers
only)

If a logger was configured to pause for a set number of readings,
each time a button is pressed such readings will be tagged with a
Paused event.

The paused mark symbol is shown on the chart instead of the
regular temperature marker.

Min/Max Reset

(TRED30-16R
Loggers only)

Each time a user resets the min/max readings during data review,
the next recorded reading will be tagged with a Min/Max Reset
event.

The min/max reset mark symbol is shown on the chart instead of
the regular temperature marker.

Table 14: Event Markers

A reading can be tagged with more than one event. Since the markers are drawn on top of
each other you may not see all markers (except for a Clock Adjust mark, which will always
be visible). The markers are displayed in the following order:

l Min/Max reset (this always includes an inspection mark)

l Inspection mark

l Download mark

l Paused mark

If a reading was marked with multiple events, please refer to the Events Info section of
the report tab, which list all events for each reading.
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The appearance of download marks and inspection marks can be customised. Please refer to Charts
on page 141. Min/Max Reset marks and Paused marks cannot be customised.

Chart Elements
If you wish to temporarily change the elements of a single chart in the file window you can right-
click in the graph area, which will show this shortcut menu:

A Element controls

B Shade controls

C Zoom controls

D Annotations

The Element controls influence general items on the chart, such as turning on and off marks and
grid lines; these can be useful for finding information on the chart easier. Clicking on an enabled
item will disable it and vice versa.

The shade controls can be used to highlight the alarm and non-alarm areas of the chart for easier
identification.

You can use the zoom controls to define which part of the data is displayed on screen (see Zoom
Control) and the Annotation menu to display text on the chart (see Chart annotations).

Zoom Control
Manual Scaling
You can zoom into any detail of the chart by using your mouse, until you only see a single reading.
If you want a more refined control over the temperature and humidity scale or the range of
readings displayed you can use direct data input from the context menu.

Right clicking anywhere on the chart area and select Manual Scaling . The following dialog will be
displayed:



You can select:

l Range of sensor
The chart is zoomed to the minimum and maximum values for each sensor. These values
are dependent on the logger model.

l Range of readings
The chart is zoomed to the minimum and maximum reading values.

l Manual Scaling
When selecting this option you have complete control over which part of the graph is
displayed.
You can specify

l the date and time range for which the readings will be shown. Please note that
you cannot enter dates and times outside the span of the logger's logged data.

l Alternatively you can specify an index range for the readings. You can see each
reading's index in the data tab. This is useful if you wish to display a certain
part of multiple files that do not cover the same date and time range.

l The temperature (and humidity ranges if applicable) for the y-axis.
Initially the dialog shows the current zoom settings.

If you select the check box Apply to all open charts, these settings will be applied to all currently
open charts as follows:

l The Y-axis scaling (temperature and humidity) will be applied to every open chart.
Range of sensor and Range of readings use the currently active chart's sensor range or
reading range for all charts. If you want each chart to display its own sensor or reading
range, please select the corresponding option in Default Zoom in the chart options.

l The X-axis scaling (time) will be applied to every chart with readings inside the selected
time frame, including pre-start readings.

- If a chart's readings fall completely inside the specified range, the X-axis will not be
scaled.

- If a chart's readings fall partially inside the specified range, the X-axis will be scaled
so only those readings inside the range will be displayed.
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- A chart will always display the readings at the time they were recorded. As a result
the first and last readings may not always align perfectly with the selected time
frame, particularly with long log intervals.

l No scaling will be applied to files where the active tab is the summary tab, day summary
tab or one of the data list tabs.

The zoom range is also not applied to TIC20 and TICT indicator products.

If you clear the check box Apply to all open charts, the chosen settings will only be applied to the
currently active chart.

Click OK to apply your selected settings.

To return to the previous zoom level, use the Zoom Out ( ) command in the Edit menu, on the
toolbar or by right clicking anywhere on the graph area and selecting Zoom out in the context
menu. You can do this individually for each chart.

If you are planning to zoom in on multiple charts, bring the chart covering the longest
date and time range to the front. This will allow you to enter the widest possible
parameters for a date and time zoom.

Inspection and download mark zoom
You can also zoom directly to certain parts of the chart by using the inspection mark zoom icons
on the toolbar and in the context menu.

Zoom out

Zooms out one level of the chart in the currently active window. If you are displaying a
chart and this function is not available, then all available data are already being
displayed and you cannot zoom out any further.

Zoom to inspection marks

This zooms the chart so readings are shown between the oldest reading recorded and
the first inspection mark that exists in the data. If this function is not available then
there are no inspection marks in the data currently being displayed.

The next two commands will not be available until this command is activated.

Previous inspection mark group

This zooms the chart so readings are shown which were recorded between the first
inspection mark currently being displayed and the previous inspection mark.

This function is disabled when either the oldest reading is already being displayed, or
the "Zoom to inspection marks" function has not been activated.

Next inspection mark group

This zooms the chart so readings are shown which were recorded between the last
inspection mark currently being displayed and the next inspection mark.

This function is disabled when either the newest reading is already being displayed, or
the "Zoom to inspection marks" function has not been activated.



In addition to zooming out and manually scaling, some additional functions are available when you
right-click the chart.

From first reading to first inspection/download mark

This zooms the chart so readings are shown between the oldest reading recorded and the first
inspection mark or download mark that exists in the data. This is different from the "Zoom to
inspection marks" feature as it also evaluates download marks. You can use this function to look at
the first set of data where a logger is downloaded more than once during a trip, for example in a
cold chain transport where goods are transferred from a cargo ship to a distribution truck and you
are only interested in the shipping portion of the trip.

From last inspection/download mark to last reading

This zooms the chart so readings are shown between the last inspection mark or download mark
and the newest reading in the data. This is different from the "Zoom to inspection marks" feature
as it also evaluates download marks. You can use this function to look at the last set of data where
a logger is downloaded more than once during a trip, for example on a distribution truck which has
multiple drop off points and you are only interested in the last portion of the trip.

If either of the two menu points cannot be selected you are either already looking at this part of
the data, or there are no inspection or download marks present.

In the General section of the Options you have the opportunity to define either of these two
settings as the default when files are opened or recorders are downloaded.

Chart annotations
To include additional information in your chart you can add chart annotations. These will be
displayed and printed with your chart. Click the right mouse button at the location where you want
to add the annotation. The context menu will open, allowing you to select Annotations .

Figure 60: Chart context menu

Select Add , enter the annotation text and click OK . The annotation will be displayed in the chart.
When you zoom the chart display, the annotation will stay on screen as long as the point to which
the annotation was attached is also displayed.
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To edit an annotation, click the right mouse button while the cursor is at the annotation's location
and select Edit from the annotations menu. Edit the text and click OK to display the edited
annotation.

To delete an annotation, click the right mouse button while the cursor is at the annotation's
location and select "Delete" from the annotations menu. The annotation will be deleted. To delete
all annotations, select Delete All .

Figure 61: Chart with annotations

Selecting the "Show" command from the Annotations popup context menu will show or hide all of
the annotations on the chart.

To save the annotations, click the toolbar button or select the Save command from the File
menu. The annotations will be saved in a file with the same name as the data file and the file
extension ".anno".

When saving annotations in Multi Chart mode, the software will ask you to specify a file name for
the Multi Chart configuration, if you are saving this configuration for the first time.

Note: The contents of the original file are not changed. If the ".anno" file is accidentally deleted,
the annotations will no longer be displayed, but the recorded data will still be intact.

Chart subtitle
The chart subtitle is displayed and printed underneath the chart title.

To edit the subtitle, right-click on the area above the chart and select Edit Chart Subtitle from the
popup context menu.



Figure 62: Chart title context menu

Enter or modify the text, then click  OK to display the edited subtitle. To remove the subtitle,
delete the text in the Edit Chart Subtitle dialog and click OK .

Figure 63: Chart with subtitle

To save the chart subtitle click on the toolbar icon or select the Save command from the File
menu.
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If the LogTag® Analyzer application is in Single Chart mode, the subtitle (and annotations) for the
currently active chart will be saved in a file with the chart file name and the file extension .anno.

In Multi Chart mode, the subtitle is saved in the Multi Chart configuration file (file extension
.multi). If you are saving the configuration for the first time, you will be asked to specify a file
name for the Multi Chart configuration.



Report Display
The Report display provides a convenient and quick way of seeing all important information for a
trip in one single screen.

Figure 64: Report Tab

A Download and time zone
information

B General information

C Alarm pass/fail

D Configuration information

E Trip information

F High Alarm information

G Low Alarm information

H Receiver notes

I Graph area

J Event information

The graph area shows a smaller version of what you see in the chart tab. The zoom controls are
linked to those in the chart tab; if you zoom in to a particular area on the report's chart area, the
same area will be displayed in the chart tab and vice versa. You can use the same zoom controls as
in the chart, with some exceptions to the context menu controls.

Figure 65: Report context menu

A Grid control

B Zoom control

C Receiver notes

D Annotations

The grid and zoom controls as well as the annotation function work the same as they do in the
chart tab. Annotations added in the chart tab will be displayed in the report chart and vice versa.

When you select Receiver notes an entry dialogue box will open where you can add text, which is
displayed in the report's Receiver Notes section every time the file is opened.

Chapter 5: Results from LogTag® Loggers 106



107 LogTag® Analyzer Version 2.9 User Guide

These notes are stored in the "*.anno" file together with the chart annotations. This file must be
present in the same directory as the "*.ltd" file.

The Events Info section lists all events that have taken place during the trip. You will see if a
logger was previously downloaded, when an inspection mark was placed, when readings were
paused or when the clock was manually changed on a logger with a display. For each block of
paused readings in a USB logger only the first and last reading is shown.

If you enlarge the width of the window sufficiently, the report will be displayed in landscape
format.

Figure 66: Report tab in landscape format

Indicator products
The report will have a different look for TIC20 and TICT products, since they do not store
continuous temperature data:



Figure 67: Report tab for TIC20 and TICT products

A Download and time zone
information

B General information

C Alarm pass/fail

D Alarm Configuration information

E Trip information

F Alarm information

G Receiver notes

H Alarm trigger events

I Temperature bars

J Graph area with alert shading

The iS0°Tag indicators feature two charts instead of the temperature bars.
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Figure 68: Chart display in Report tab for iS0°Tag indicators

A Log Chart

B Day Summary Chart

For USB loggers the alarm section of the report shows one summary row for each activated alarm:

Figure 69: Multi-Alarm report section

The graph also shows the lines for each of the activated alarms.



Data Display
When you click on the data tab the readings are displayed in a list in chronological order from top
to bottom, also showing index, date & time and elapsed time. On the list you can also identify any
special marks attached to the reading, such as download marks (identified through purple
background) and inspection marks (identified through red background). The colour of the text
identifies if a reading has been above the upper alert value (red), below the lower alert value
(blue) or within specification (black). You can scroll through the readings with the arrow, page
up/down, home and end keys, or use the mouse to move the readings with the scroll bar. The zoom
controls from the chart tab are inactive in the data tab.
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Figure 70: Data tab

A List header row

B Reading with download mark

C Reading below lower alert value

D Reading with inspection mark

E In spec readings

F Reading with sensor unplugged (TRED30 models only)

G Reading with Min/Max reset mark

H Scroll bar

I Reading above upper alert value

The data tab will only display those readings shown on the corresponding chart. If the chart is
zoomed in, the data tab gives access to only the zoomed readings. You cannot use the scroll bar or
arrow keys to display readings before or after the currently zoomed readings.

The list grid can be copied to the Windows clipboard and pasted into other windows applications
such as spreadsheets, including the list header row. When the corresponding chart is zoomed in,
only those values will be copied.



Summary Display
The summary tab offers a brief statistics overview of some of the important trip data. You can
customise the statistical data you wish to include in this tab in the Options dialogue for the
Summary Statistics.

The first section shows the data for the complete trip, regardless of whether or not the chart is
zoomed in. The second section is only displayed if the chart is zoomed in, and displays the
statistics for only the zoomed readings.

Figure 71: Statistics tab

A Statistics summary for entire trip

B Statistics for zoomed readings

If there are readings beyond the limits of the sensor within the time interval displayed, the
statistics for this interval will show "**". If inspection marks are present in the data, statistics
summaries for each of the inspection mark groups in the data can be seen amended to the end.

No separate group exists for Min/Max reset marks, as these are always placed together
with an inspection mark.
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Figure 72: Statistics tab when inspection marks are included

A Statistics summary for first
inspection mark group

B Statistics summary for second
inspection mark group

C Statistics summary for third
inspection mark group

The list grid can be copied to the Windows clipboard and pasted into other windows applications
such as spreadsheets, including the list header row.
The zoom controls available for the chart tab are inactive in the summary tab.



Day Summary Display
The day summary tab is displayed for LogTag®s with an integrated statistics memory.

LogTag® logger products with statistics memory
For logger models with a statistics memory the day summary display shows the history of up to 30
days, arranged into 24 hour periods, with information about maximum and minimum values for
the day, and if alarms have been triggered on those days.

Figure 73: Day summary for loggers with display and statistics memory

A Day summary header row

B Summary grid

C Alarm marker

D Below Alarm level marker

E Sensor was unplugged for the
whole day (1)

The Day summary grid can be copied to the Windows clipboard and pasted into other windows
applications such as spreadsheets, including the header row.

LogTag® indicator products with display
These indicator products have multiple alarm levels. Time above or below each alarm level is
displayed, with information about maximum and minimum values for the day, if alarms have been
triggered on those days and how much time elapsed on that day until the alarm was triggered.

(1)Only for new loggers supporting the external sensor disconnect detection feature
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Figure 74: Day summary for indicators with statistics memory

A Day summary header row

B Alarm duration and trigger time

C Summary grid

D Total time monitored

The Day summary grid can be copied to the Windows clipboard and pasted into other windows
applications such as spreadsheets, including the header. row.



Day Summary Chart
iS0°Tag indicators show a tab not available for other types of indicators or loggers. It shows the
minimum and maximum recorded temperature values for each day the indicator was running in
form of a 2D line chart.

Figure 75: Day Summary Chart tab for iS0°Tag indicators

A Chart title and subtitle

B No alert area

C Maximum reading graph

D Inspection mark

E Minimum reading graph

F Below alert area

G Time line

H Time zone

I Tabs

J Chart legend

What you can do on this chart is almost identical to the Chart tab; tooltips show the data for each
you can zoom in and out, you can place annotation marks and manually scale the chart. There are,
however, some exceptions:

l There are no download marks. To download an iS0°Tag with LogTag® Analyzer it must
first be stopped, hence a download mark can never be recorded.

l Real time shows an approximation of the date in which minimum and maximum values
were recorded. The iS0°Tag's 24 hour day period starts at the time of the day the indicator
is activated, not at midnight. If you wish to make this chart reflect accurately at what
time the days rolled over you must switch to Elapsed time.

l The data points are linked by a line for visual appearance only.

l An inspection mark is recorded against a day, not a specific sample.
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l Average and multichart buttons have no effect on this tab.

l Since the data points don't represent readings, there is no chart statistics display

Combining charts onto a single chart

To overlay multiple charts in one view, select the Multi Chart ( ) command. All charts that are
currently open will be displayed together. Additional files opened while in Multi Chart mode
(including data downloaded from LogTag®s) will be added to the display.

Figure 76: Two charts combined into a multi chart

Each of the individual charts will be displayed with a letter symbol to allow you to tell them apart.
The legend contains an entry for each chart showing the chart name and the corresponding letter.

You can change the background color for the Multi Chart display through the Charts section in the
Options Window (see Charts on page 141).

To remove charts from the Multi Chart display, use the Single Chart ( ) command to switch to

Single Chart mode, then close the files you don't want to display. Select the Multi Chart ( )
command to switch back to Multi Chart mode.

You will notice that the Data and Summary tabs are not available in the Multi Chart display. If you
require additional information about the chart data, activate the display of the desired statistics on
in the Chart Statistics section in the Options Window (see Chart Statistics on page 140). The
chosen values will be displayed separately for each chart.



You can also view Min, Max and Average Charts, and select other options.

Changing Chart Colours
By default, all charts in the Multi Chart display are displayed in the colors specified in the Charts
section within the Options Window (see Charts on page 141).

To change the display color of individual charts/sensors, move the mouse pointer over a chart until
the tooltip is displayed. Right-click, then select Change Chart Color from the popup context
menu.

Select the desired colors for the chart readings and markers in the color selector boxes. To restore
the default color as specified in the Options window select the Restore Defaults command.
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Shifting chart start times
For easier data comparison, chart start times can be shifted in Multi Chart display. There are two
ways to shift a chart along the time axis:

1. Move the mouse pointer over the chart until the appropriate tooltip is displayed. Right-
click, then select the "Shift Chart" command from the popup context menu. This will cause
the following dialog to be displayed, where the new start time and date can be entered, or
the chart can be revert to its original date/time by selecting the "Original start time" button.
Click the OK button to display the change.

2. Press and hold the CTRL key, left-click on the chart you would like to move, and drag the
chart to new the position.

An additional time axis is displayed for each shifted chart indicating the corresponding time
in relation to the original start time.

Note: Shifting a chart will not change any of the original recorded data, only the location the
data is displayed in relation to other charts within the Multi Chart display will change.

Figure 77: Multi chart with different time axes

Aligning Charts
Select Align Charts from the popup context menu to automatically align all charts in the current
Multi Chart window.

The charts are aligned to the earliest start time:

- Chart tab: All start times are aligned.

- Pre-start Chart tab: All charts with Pre-start readings are aligned to the earliest Pre-start
reading.



- All Chart tab: Charts are aligned to the earliest reading (Pre-start reading if any Pre-start
readings have been recorded for the chart).

Every chart is assigned a different color and a time axis is displayed to illustrate the original start
time. You can display the elapsed time instead of the date/time by selecting the Elapsed Time
option in the Chart Options dialog (see Charts on page 141) or clicking on the elapsed time toolbar
icon ( ).

Aligning charts in one tab will also influence how these charts are represented in the other tabs. If
for example you select Align Charts in the Chart tab, and switch to the All Chart tab, you will
notice that the charts are now aligned at a new origin, with all pre-start readings to the left and all
readings to the right of this origin. The charts in the Pre-start tab are aligned with the last pre-
start reading to the right.

To revert to the original start times for all charts, select in the toolbar to switch to Single Chart

mode, then switch back to Multi Chart mode with .

Special Chart Tabs
When you select the average tab command in the toolbar, up to three additional chart tabs will

be shown, with the Chart Average tab highlighted:

These chart tabs display graphs calculated from the Chart, Pre-Start Chart, and All chart tabs and
show minimum, maximum and average value graphs. Changes in either of the three original data
displays, such as adding a new file and aligning or shifting charts, result in a re-display of the
corresponding Min/Max/Average tab, e.g. if one of the charts in the Pre-Start Chart is shifted, the
Pre-Start Min/Max/Average chart would redraw showing graphs based on the updated values.

You can annotate these special chart tabs in the same way as other chart tabs; such annotations
will be visible in the other chart tabs and are stored with the multi chart when saved.

Please note that following behaviour applies to these special chart tabs:

l Zoom settings will not be transferred to the Average tabs.

l Event markers will not be displayed in the Average tabs.

l Non-validated readings and re-calibrated readings will not be displayed with the special
attributes, even if set in the options. If you have chosen to show non-validated
readings, they are included in the minimum/maximum/average calculations, otherwise
not.

l The maximum allowed time the charts in a multi-chart can span is restricted. These
restrictions vary with logging interval, should you try to add a chart outside the allowed
range following dialogue box will appear:
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In this case the multi chart will disassemble, so you can close the window whose chart you no

longer want to display, and re-assemble the multi-chart by clicking on .

l If one or more of the charts have sections with readings outside the LogTag®'s sensor
range, LogTag® Analyzer is unable to calculate the minimum, maximum and average
values, and those sections of the graph will not be displayed. This will likely result in a
"broken" graph line, regardless of whether show readings beyond specifications in the
Charts section in the Options Window is enabled or not (see Charts on page 141).

l Due to the large number of calculations performed in this feature, specifically when
opening large numbers of charts spanning long periods, having the average tabs
displayed can occupy large amounts of memory and run slow. Therefore we recommend
only turning the feature on when required.

Clicking on the highlighted average tab command will turn the average tabs off. Selecting the

single charts command in the toolbar while the average charts are active will disassemble the

multi chart, and when switching back to multi chart the average tabs will be displayed again until
turned off.

Behind The Scenes
To create some meaningful results, LogTag® Analyzer uses a special trend line process to calculate
the minimum, maximum and average values across multiple charts, rather than a histogram. It is
important you understand this mechanism, so you can interpret the displayed readings correctly.

This is an example of two LogTag®s, one with a 5 minute log interval (A) and the other (B) logging
every 2 minutes.

Figure 78: Multichart data - as recorded

Before the data are displayed in an average tab, LogTag® Analyzer normalizes every chart's
readings so they fall in line with the logging interval of the LogTag® with the shortest log interval,
in this case unit (B). It does not shift any charts, but rather calculates a theoretical value for those
reading times by linear interpolation. Interpolation determines probable environmental conditions,
i.e. what the LogTag® would have recorded if taking a reading at that time.

Figure 79: Multichart data - normalised

Without this method, it would not be possible to compare LogTag®s with different log intervals, or
units that have the same log interval, but were started at different times.



Figure 80: Multichart data - normalised min/max/average curves

As a result of this process, absolute values for minimum and maximum may not always be shown
if they do not fall on normalized times, as seen in the example at 10:35 - despite 21ºC being the
maximum it will not be displayed as it is not a normalized value.

Note: The charts in above example are based on LogTag®s started at the same time. If unit (A)
had been started earlier, depending on the start time unit (B) may also have its readings
interpolated. To ensure the chart with the shortest log interval always has its real values shown,
please use the Aligning Charts function from the context menu.
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Automatically calculated statistics
The software will automatically calculate and display certain statistics of the recorded data. The
statistics for the complete recording are shown on the Summary tab, where you will also find
intermediate values for each sequence of data points between the inspection marks.

If any readings within the referenced time interval are beyond the limits of the sensor, the values
for Average Reading, Standard Deviation, and Mean Kinetic Temperature will not be displayed.

Average Reading
The Average Reading is the arithmetic mean of the sequence of data points. It is calculated by
adding all the data point values together and then dividing the total by the number of data points.
Mathematically this formula can be expressed as illustrated in the following picture:

Figure 81: Formula for average reading

Where:

av is the calculated arithmetic mean

n is the number of data points to include in the calculation

ti are the sequence of data points to include in the calculation

For example, if there were 5 data points to calculate the arithmetic mean of and they were, 12.3,
15.9, 16.2, 14.7, 14.9, then the arithmetic mean would be 14.8.

The number of decimal places displayed can be set to 1, 2 or 3 by
clicking Options from the Edit Menu, then navigating to the
Summary or Chart Statistic section, highlighting Average Reading
and clicking Customize... .

Confirming this dialogue with OK will set the number of decimal
places to the number selected in the drop down box.



Standard Deviation
The standard deviation is a useful measure for determining how spread out the readings are from
the arithmetic mean (Average Reading). Most controlled environments typically try to keep the
environmental conditions at a stable and consistent humidity and/or temperature. The standard
deviation can be used to help indicate how stable the environmental conditions were maintained.
One standard deviation (sometimes expressed as "one sigma") away from the mean, positive or
negative represents approximately 68 percent of all the readings. Two standard deviations, or two
sigmas, away from the mean represents approximately 95 percent of the readings. Three standard
deviations represent about 99 percent of the readings.

For example, if the arithmetic mean of the readings was 50.6°C and the standard deviation was
2.3°C, then approximately 68% of the readings were between 48.3°C and 52.9°C, 95% of all the
readings were between 46.0°C and 55.2°C and 99% of the readings were between 43.7°C and
57.5°C. Further more, if all the readings were recorded over a span of 1 day (24 hours) then the
temperature was between 48.3°C and 52.9°C for approximately 16 hours and 19 minutes during
the recorded period of time.

LogTag® Analyzer allows the calculation of sample or population based standard deviation.

Figure 82: Sample based standard deviation Figure 83: Population based standard deviation

Where:

s the calculated sample based standard deviation

sN the calculated population based standard deviation

n the number of readings to include in the calculation

av the calculated arithmetic mean

ti a reading to include in the calculation

The number of decimal places displayed can be set to 1, 2 or
3 by clicking Options from the Edit Menu, then navigating
to the Summary or Chart Statistic section, highlighting
Standard Deviation and clicking Customize... .

Here you can also set whether the standard deviation should
be sample based or population based.

Confirming this dialogue with OK will set the number of decimal places to the number selected in
the drop down box and the calculation method.

For a more detailed explanation of the various ways to calculate standard deviation please consult
the relevant literature related to statistical and probability calculations.
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Mean Kinetic Temperature
Some products and materials have accelerated rates of degradation at higher temperatures. For
example, perishable food items or pharmaceutical products can degrade exponentially as the
environmental temperature increases. Mean kinetic temperature is a calculation that
accommodates the non-linear thermal effect temperature can have on products. It is represented
as the equivalent temperature the product was thermally subjected to during the time temperature
readings were recorded.

Mathematically the formula for calculating the mean kinetic temperature can be expressed as:

Figure 84: Formula for mean kinetic temperature

Where:

mkt is the mean kinetic temperature, in degrees Celsius

ΔH is the activation energy.

R is the universal gas constant, which is 0.0083144 KJ/mol K

n is the number of data points to include in the calculation

ti represents the data points to include in the calculation, in degrees Celsius

For example, for the 5 data points 12.3, 15.9, 16.2, 14.7 and 14.9 degrees Celsius the mean kinetic
temperature would be 14.9 degrees Celsius, using the default ΔH activation energy value of 83.144
KJ/mol.

You can also enter a custom value for ΔH. Click Customize...
in the Summary Statistics or Chart Statistics option screen
and enter the desired value in Use the following value.

If you select Use logger stored value (if defined), the ΔH
parameter value stored in the logger will be used to
calculate MKT, if a custom value was entered during
configuration. If you display more than one logger, each will
use its own ΔH parameter to calculate MKT. If you open a
multichart, the ΔH value of the first opened file or logger will be used.

Charts and the Statistics page display the ΔH parameter if
it is different to the default value, and display Logger
deltaH if the parameter from the logger was used.



Degree Minutes
There are some products and materials that exist which can change their characteristics and/or
degrade if they experience temperatures which are not within ideal conditions for long enough. For
example, some products may experience freezer burn if they experience an extremely cold
condition or experience a colder than ideal temperature for a long enough period of time. Other
products for example, ice cream, change their characteristics if they experience temperatures
which allow it to melt. The LogTag® Analyzer will automatically display the results of two separate
Degree Minutes calculations. The result of the first Degree Minutes calculation displayed will be
based on the readings that were recorded below the ideal conditions and the result of the second
Degree Minutes calculation displayed will be based on the readings that were recorded above the
ideal conditions. The ideal conditions used in the calculation of the Degree Minutes formula are
based on the upper and lower alert values that where configured when the LogTag® was originally
prepared for use.

Mathematically the formula for calculating the degree minutes above alert can be expressed as
illustrated in the following picture:

Figure 85: Formula for degree minutes

Where:

deg min Total Degree Minutes spent above/below the alert threshold.

ti The temperature that was above/below the alert threshold.

a The alert temperature threshold.

s The duration of time, in minutes, the temperature was sustained.

For example, if there were 5 data points to calculate the degree minutes of and they were, 12.3,
15.9, 16.2, 14.7 and 14.9 degrees, each of these temperatures were recorded at 2 minute intervals
and the high alert temperature threshold was 12.6 degrees, then the degree minutes temperature
above the upper alert threshold would be 22.6 degree-minutes.

Displaying statistics
The statistics displayed on the Summary tab can be configured in the Options dialog. Refer to the
topic on Summary Statistics. By default, all statistics are displayed on the Summary tab.

Statistics can also be displayed on the chart, underneath the legend. Refer to the topic on Chart
Statistics for more information about configuring the chart statistics.

If there are readings beyond the limits of the sensor within the time interval being displayed, the
statistics for the relevant interval will be displayed as "**".
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Printing the results
Printing from LogTag® Analyzer is similar to printing from other Windows software.

Before you print for the first time, however, we suggest you take some time to set-up your
preferred page settings.

Page Setup
Click Page Setup; the following dialogue will be displayed:

You can set page margins, paper size, paper source and orientation.

Printing a single document
Click the "Print" icon ( ) on the toolbar or click Print... from the File menu to display the Print
window.

Figure 86: Custom printer dialogue

Choose a printer and if required adjust its properties.

Choose the range of readings to be printed:



l All - All readings will be printed

l Selected dates - Select the beginning and end date and time for which the readings will
be printed. This option is pre-selected, if you have zoomed the readings, with the
beginning and end date and time matching the zoom area.

l Range of inspection marks - If inspection or download marks are present in the data,
you can select a pair of marks between which the data will be printed.

Please note:

l When printing a report or chart the temperature and humidity axes will always
be zoomed to the current settings of the chart display, even if you select to print
a larger date range than currently displayed. You may therefore not see all
readings.

l Reports and Data lists will always be printed in Portrait, regardless of the
settings made in Page Setup (see page 127).

Printing multiple documents
You can print all currently open documents at once.

Click Print All... from the File menu; the following dialogue will be displayed:

Each document's currently active tab will be printed with the respective zoom settings.

Chapter 5: Results from LogTag® Loggers 128



129 LogTag® Analyzer Version 2.9 User Guide

Emailing a file directly from LogTag® Analyzer

You can send files of interest to another person, by email, directly from the software without the
need to exit to your email software or to deal with file attachments.

While you have the file of interest open and being displayed on the screen, just click once on the
"Send Mail" icon ( ) located on the and your email software will pop up with the file already
inserted as an attachment. Type the desired email address to send the file of interest to, add any
message that you wish to include, and then click "Send".

Clicking on Send in the File menu will achieve the same results as clicking the "Send Mail" icon as
previously described.

Note, the recipient of the file will also need to have a copy of the LogTag® Analyzer software to
open and view the file that you sent. LogTag® Analyzer software is free and can be downloaded
from https://logtagrecorders.com/software.

If you want to attach your data files in file formats other than the LogTag® Analyzer format,
specify the desired file formats in the Exports and Reports section in the Options Window (see
Exports and Reports on page 163). The data files will automatically be attached to your emails in
the desired formats.

To send a Multi Chart configuration, the configuration must first be saved to disk (see Saving a
Multi Chart file on page 87). The "Send Mail" command will automatically attach the multi chart
configuration file, the annotation file (if annotations have been added) and the relevant individual
data files to your email.

Note: You can automatically send emails and upload files to ftp sites using LogTag® Analyzer's
automated SMTP and FTP functionality. Please see Automatic emailing and uploading to FTP
sites for further details.

https://logtagrecorders.com/software


Calling up previous results
To open a stored file, click the "Open" icon ( ) from the toolbar or click Open... from the File
menu. This will display the "Open" file dialog:

Figure 87: File Open dialogue window

Browse to any location accessible by the Windows® Operating System, including network and ftp
locations. Select the desired file and click Open . Please refer to your operating system's help for
more information.

The files that have most recently been opened are listed at the bottom of the "File" menu. After
the software has been installed for the first time, there are two recently opened files listed in the
"File" menu, even though no files have been opened yet. These are sample files, which were
installed along with the software so that users can see an example of information that can be
retrieved from LogTag®s. These files are not required for the correct operation of the software and
therefore may be deleted at any time.

You can also open files directly from Windows® Explorer or your email software by double clicking
on the file or right clicking and selecting "open" from the context menu. When opening files from
email programs that store attachments in temporary folders such as MS Outlook, you may be
asked to store the file in a new location when performing further actions such as selecting multi-
charts or uploading to FTP sites.

If the software is unable to open the file, it will display an error similar to the following picture.
Click Check Now to check for an updated version of the software.
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Figure 88: File not compatible with current version of LogTag® Analyzer

Opening USB Logger PDF Files
Starting with LogTag® Analyzer version 2.8r3 you can open PDF files generated by USB loggers.

These PDF's contain an embedded *.ltd file, which LogTag® Analyzer will extract, save to disk and
then display.

To open a PDF file, click Open... from the File menu, then select All Files (*.*) as the type of file
to open. Browse to and click the PDF file you wish to open. The saved file will carry the original file
name of the PDF with the .ltd file extension added and will be saved in the same folder as the PDF
file, or in the default LogTag Data folder if the PDF location is read-only.

Note: You will not be able to open PDF files created by LogTag® Analyzer.

Opening *.ltdx Files
Starting with LogTag® Analyzer version 2.8r3 you can open *.ltdx files generated by LogTag®

Analyzer version 3.

The *.ltdx format is an extended file format used by LogTag® Analyzer version 3, which contains
the logger's logged data as well as other information such as annotations and zoom settings. The
logged data are extracted by LogTag® Analyzer , saved to disk and then displayed.

To open a *.ltdx file, click Open... from the File menu, then select All Files (*.*) as the type of file
to open. Browse to and click the *.ltdx file you wish to open. The saved file will carry the original
file name of the *.ltdx with the .ltd file extension added and will be saved in the same folder as the
*.ltdx file, or in the default LogTag Data folder if the *.ltdx location is read-only.

Note: Annotations, zoom settings, chart titles, chart subtitles and receiver notes are not
transferred to the *.ltd file.



Digital signatures
Support for digital signatures is primarily provided for compliance with the US FDA 21 CFR Part 11
regulation - Electronic records and electronic signatures. Various industries however, may find
inclusion of digital signatures beneficial towards their quality control and assurance systems.

Digital signatures allow users to include their digital signature within a LogTag® Analyzer file
along with a meaning/reason for the inclusion of the digital signature. To add digital signatures to
LogTag® Analyzer files, the copy of the LogTag® Analyzer software being used must be connected
to the LogTag® User Server software. For more information about how to get the software to
connect to the LogTag® User Server software see User Server or contact your local network
administrator.

While the file that the digital signature is to be added to is open and currently selected, add a
digital signature by clicking on the "Digital Signatures" icon ( ) located on the , which will display
the "File Properties" dialog with the "Digital Signatures" tab already activated, similar to the
following picture.

Figure 89: File with digital signature attached

Then click New to begin the process of adding a digital signature to the file. If New is disabled,
moving the mouse pointer over New and leaving it still for a short time will reveal the reason why
the button is disabled.

Once the "Add Digital Signature" dialog is visible, enter your LogTag® Analyzer user password and
select the meaning for the digital signature that is being added.
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Figure 90: Adding a digital signature

Click OK to permanently add the digital signature to the file or Cancel to not add the digital
signature. Multiple digital signatures from the same and/or different users to LogTag®

Analyzerfiles may be added to a single file.

How secure is my data
All LogTag® files are encrypted and contain checks to detect if the file has been tampered with
since it was originally created. If the software detects that a file has been tampered with, even by
only one character or has become corrupted and therefore the data within does not represent the
data originally retrieved from the LogTag®, the software will not open the file and display the
information within.

An additional validation and security feature of the LogTag® is that it will automatically insert
error detection codes periodically during recordings, which are used to detect corruption or
manipulation of data. Whenever these detection codes for a block of recordings fails its integrity
validation test, the relevant readings become marked as non validated readings. Non validated
readings are displayed differently to validated readings to indicate that they have failed their
integrity test.

Non validated recordings typically occur in the scenarios following scenarios:

1. One or more readings in the non validated block of readings is not the genuine recorded
value.

2. A communications or hardware failure has occurred during the transfer of the data from the
LogTag® to the computer. Try downloading the recordings from the LogTag® again; make
sure the contacts on the back of the LogTag® are clean, the contact pins in the Interface
Cradle slot are clean and return evenly to their normal position when the LogTag® is
removed.

Since the software does not modify any of the recorded data within a LogTag® file at any time, if
the software can open the file, regardless of how long ago it was created, the contents of the file
will still represent the original recorded information retrieved from the LogTag®.



Therefore, the files created by the LogTag® Analyzer software meet all criteria for data integrity
and data security as set forth in the US FDA 21 CFR Part 11 regulations. The firmware code that is
embedded in the processor chip of each LogTag® cannot be extracted or reverse-assembled.
Accordingly, data sets that are recorded on the memory within the LogTag® cannot be downloaded
or modified except by being transferred to a LogTag® file. There is no way to interfere with the
process of the transfer of information between the LogTag® and the software in such a way that
data integrity would be compromised.

Viewing file properties
The file properties window provides users with a summary of the key properties of the data
included in the file, such as model ID and serial number, alert range and range of readings, start
time end time and total number of readings as well as the battery status. If the LogTag® has a
limited number of trips left, this is also indicated here.

The file properties window is accessed by clicking on Properties in the File Menu or through the
toolbar command.

Figure 91: File properties Figure 92: File properties for indicator product
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Chapter 6
Customising the software

Many of the features offered by the software can be customized to suit your specific
requirements.

The customization is performed in the options dialogue, which can be opened by
clicking on the icon in the toolbar or by selecting Options from the Edit menu.

Figure 93: Edit Options Menu

In this chapter:

General Settings 137
Summary Statistics 138
Chart Statistics 140
Charts 141
Automation 144
File and Folder Settings 157
Exports and Reports 163
Date and Time Format 166
Time zones 168
Communication Ports 169
User Server 171
Software Updates 172
Configuration Reports 173
Importing and Exporting Option Settings 174

To change any of the options, select the corresponding category in the left pane of the
options window. You will the see what can be changed in the right pane. Most of the
options available will be applied as soon as you click on OK . For example, if the
language selection and/or the date format are changed, all windows that are open will
be updated without the need to restart the software. Please note, however, that these
settings will only be permanently stored once you exit the LogTag® Analyzer software.
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Some of the display settings, such as decimal point and date/time formats, are not controlled by
LogTag® Analyzer's user settings dialogues, but rather by the regional settings of the Windows™
operating system. These can usually be found in the Control Panel under "Regional and
Language Options". Please refer to your Operating System's documentation for further
assistance.



General Settings
The General Settings options allow you to change various preferences that will effect the overall
appearance of the information shown by LogTag® Analyzer.

Figure 94: General settings

Show temperatures in
This will set the unit used for temperature values displayed in the software's dialogues, lists,
charts and reports. The options include:

l Fahrenheit (°F)

l Celsius (°C)

l Kelvin (K)

Loggers with a display and PDF loggers have a separate setting for the temperature unit used on
the display or in the PDF. It is set in the corresponding Advanced Options dialogue during
configuration.
No other logger model stores the temperature unit inside its memory.

Use Font
The font currently used to display and print is shown in this field. Click Font... to open a selection
dialogue where you can adjust settings as desired.
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Default display time interval
This drop down box allows you to set the default time zoom level. You can set this to:

l All readings

l From first reading to first inspection/download mark

l From last inspection/download mark to last reading

The setting you select here will apply to all newly opened windows when a file is opened or a
logger is downloaded.

The section about Inspection and download mark zoom explains how this feature works.

Language
This instructs the software which language for the software to use for all the information it
displays and prints. Supported languages are:

l English US

l English (UK)

l Chinese (Simplified)

l Chinese (Traditional)

l Czech

l Danish

l Dutch

l French

l German

l Greek

l Italian

l Norwegian

l Polish

l Portuguese (Brazil)

l Portuguese

l Romanian

l Russian

l Spanish

l Swedish

l Turkish

Summary Statistics
This option allows you to specify which statistics are displayed in the Summary tab. The statistics
can be enabled or disabled by clicking the tick box for the relevant item in the list.



Figure 95: Statistics Options dialogue

Following Statistics settings can be further customised. You can find out more about the
parameters that can be customised in each of the chapters.

l Average Reading (see page 123)

l Standard Deviation (see page 124)

l Mean Kinetic Temperature (see page 125)

When you highlight any of these entries, the Customize... button becomes available.

The customised settings are shared with the Chart Statistics. If you change them here, they will be
automatically changed for the chart statistics, too.

Chapter 6: Customising the software 139



140 LogTag® Analyzer Version 2.9 User Guide

Chart Statistics
This window allows you to specify which statistics are displayed on the charts. Select all options
you wish to be shown, and clear all options you wish to hide.

Figure 96: Chart Statistics Options dialogue

Following Statistics settings can be further customised. You can find out more about the
parameters that can be customised in each of the chapters.

l Average Reading (see page 123)

l Standard Deviation (see page 124)

l Mean Kinetic Temperature (see page 125)

When you highlight any of these entries, the Customize... button becomes available.

The customised settings are shared with the Summary_Statistics. If you change them here, they
will be automatically changed for the summary statistics, too.



Charts
In the charts options dialogue various settings can be customized that influence how charts are
being displayed in the chart tab.

Figure 97: Chart options

The various Chart Options settings can be enabled or disabled by clicking the check box for the
relevant item in the list. If ticked, an item is enabled.

When you highlight an item, the color selector and other relevant controls below the list will
become active. Some experimentation with these settings will show very quickly how they work.
Select a color in the color panel, click OK and go to the Data screen to see the resulting change.

Function Purpose

Heading You can combine a number of different variables and your own text to
create a chart title. The controls work the same as described in the
section about the File Name.

Temperature Readings
Humidity Readings

You can select colour and style of the lines used to display the readings.
Note you cannot disable the display of readings.

Temperature Markers
Humidity Markers

You can select colour and style of the marker display. You can also
enable or disable displaying the markers.

Download Marks
Inspection Marks

You can select colour and style of the download and inspection marker
display. You can also enable or disable displaying these markers.

Table 15: Available Settings in the chart options
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Function Purpose

Above Alert Region
Within Alert Region
Below Alert Region

You can set the chart background so different background colours are
used for the regions "at or above high alert limit", "between high alert
limit and low alert limit" and "at or below low alert limit". This allows
out-of-range and in-range data to be spotted easily on the listed or
charted data.

This can be activated independently for each region by enabling the
corresponding check box and selecting a colour from the colour selection
drop down box.

By default these settings are enabled, with red for "above alert", blue for
"below alert range" and green for the non-alert range.

By selecting a line style for the "above high alert limit" and "below low
alert limit" regions you can improve the readability of the charts on
black and white printouts.

The report chart does not show these shaded backgrounds.

Note: for USB loggers with multiple alarms, the "above alert" and
"below alert range" colours cannot be changed. They can, however, be
turned off.

Multi Chart Shade Enabling this check box shows the multi chart tab with the background
selected in the colour selection drop down box. Disabling the check box
shows the colour selected for "Window" in the Windows Appearance
settings.

X-Axis grids
Y-Axis grids

Enabling either tick box displays vertical (x-axis) or horizontal (y-axis)
lines which help you identify readings relative to each other. By default
the y-axis grid is enabled, while the x-axis grid is disabled.

Non-Validated
Readings

You can choose to include or exclude non-validated data from the chart
display by checking or un-checking the "Non-validated readings" check
box in the list. If non-validated data is to be displayed, it can either
appear just like validated data, or you can define a different colour and
marker style to be used. Check the check box "Display non-validated
readings differently:" to display non-validated data in the selected
colour/style.

Please refer to section How secure is my data for a detailed explanation
of non-validated data.



Function Purpose

Show readings beyond
specifications

Sometimes the LogTag® can record readings beyond the specified
measurement range. In this case

l the Chart and report tabs will not show the out of range values
and the chart curve will appear with broken lines

l the Data tab will include "<" or ">" for each reading that is
beyond the specification range

l the Statistics display will include "**" for each statistic that
includes readings that are beyond the specification range.

If the option "Show readings beyond specification" is enabled, all
recorded reading values will be displayed, even if they are beyond the
operating range of the LogTag®.

For example, the TRIX-8 has a published minimum temperature of -
40°C. Temperatures down to -41.5°C may be displayed if the Show
readings beyond specification is enabled, however the accuracy of
recordings between -40°C and -41.5°C is unknown. -41.5°C will be
displayed even if the temperature falls to a much lower actual value.

LogTag® Recorders provides no guarantee of temperature reading
reliability or accuracy beyond the published range for any product;
enabling this option for general use is not recommended.

Show annotations Enable this check box to show annotations on the chart. Disable it to
hide the annotations.

Elapsed time The "Elapsed Time" option switches the x-Axis display between real
date&time and elapsed time since the beginning of the display period.
You can temporarily override this selection with the Toolbar commands.

Y-Axis alert shade Here you can define if the alert shading uses the temperature or the
humidity values when displaying the chart for HAXO-8 loggers.
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Function Purpose

Default Zoom You can define the minimum and maximum y-axis values initially
displayed when opening the chart.

l Range of readings: this scales the chart so the maximum and
minimum temperature displayed is just above/below the
highest/lowest temperature reading recorded by the LogTag®.
If you choose this option the maximum screen area is used to
display all recorded readings.

l Range of sensor: this scales the chart to show the full
temperature measurement range of the logger.

l Custom range: When you select this option, an additional
dialogue appears. Here you can enter two temperature values
and two humidity values, which are used as maximum and
minimum values for the chart's y-axis, regardless of the value
of the recorded readings.

These settings are stored when the software is closed.

Regardless of these settings, you can always zoom in or out using the
various zoom settings (see Zoom Control. When using the context menu
in the chart tab you can also temporarily override the manual settings
with new ones.

Automation
The Automation options determine what the software does automatically when it detects a
LogTag® in the Interface Cradle.



Figure 98: Automation Options dialogue

Enable automatic download of readings from LogTag®

Instructs the software to automatically retrieve recordings from a LogTag® when it is placed in an
Interface Cradle that is connected to the computer. While the software is automatically retrieving
recordings from a LogTag® an animated picture will appear on the screen to let the user know this
action is being performed.

With this function enabled, it is not necessary to go through the download wizard procedure. This
function is very useful when working with multiple LogTag®s.

This function can be temporarily disabled by holding down the "Ctrl" key on the keyboard while a
LogTag® is placed in the Interface Cradle.

Re-configure with same settings after automatic download
When this feature is enabled, a LogTag® will be automatically re-configured with the same settings
that were used for the previous trip, once the data have been downloaded. This option not
available if the Enable automatic download of readings from LogTag® option is not enabled.

If the data download fails for any reason (for example the network storage folder is
inaccessible at the time) the re-configuration will not proceed.
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Skip configuration password prompt (TRID/TRED only)
If enabled , a password does not have to be provided during re-cofiguration even if a logger was
last configured with a configuration password, as long as the data download has been successful
(as described in Quickly re-configuring a LogTag® on page 81).

This feature is only available for TRID30, TRED30 and TRED30-16R models, as the nature of these
recorders often requires them to be re-configured frequently in stationary applications while
ensuring the settings are unchanged.

Display readings after successful download
Instructs the software to display the recordings after downloading them from the LogTag®. The
default display format is determined by the "Display" setting in the "File Settings" option. This
option will affect readings downloaded through the automatic download feature and when
downloading through the Wizard approach.

Only show the latest set of readings after download
Instructs the software to only display the most recently downloaded readings on the screen. If
multiple windows are being displayed, they will be automatically closed and only the most recently
downloaded readings will be displayed.

Automatically save data files to default folder if source is read only
Select this check box if you want LogTag Analyzer to create a permanent copy of any *.ltd file you
open from a read-only source. This copy will be stored in the folder specified in File and Folder
Settings. This is useful if for example you open a file directly from the mass storage device of a
USRIC-8 or from an email you received. In this case you do not have to explicitly create a copy of
the file yourself to retain a local copy, and you will be able to make and save annotations.

Clear the check box if you do not wish to create these copies. In this case you will need to copy a
file manually from a read-only folder to a read/write folder if you wish to make annotations.

Tip: If you open a *.ltd file from a USB logger's mass storage device directly, you will not be able
to save the file after you have unplugged it. Therefore we recommend turning this option on,
particularly if you do not use the automatic download option.

Automatic emailing and uploading to FTP sites
In the same way that LogTag® Analyzer files are saved to a local hard drive, they can be
automatically uploaded to an FTP site and automatically be emailed every time data from a
LogTag® are downloaded.

FTP (File Transfer Protocol) is a standard which describes how files are transferred between
different computers and networks. SMTP (Simple Mail Transfer Protocol) is used for email and
describes how electronic mail is distributed across networks. Detailed explanations of how both FTP
and SMTP work are beyond the scope of this manual, however if you wish to learn more about FTP,
SMTP, email and networking please refer to one of the many good articles available on the
Internet, such as the ones on Wikipedia or the various FTP and SMTP client providers.



In the Automation dialogue you can select for both FTP and email whether you wish to make the
process automatic, on request, or both. If you activate manual uploading/emailing, but not
automatic uploading/emailing, you need to press a button on the toolbar to upload or send the file
in the currently active window. This button is in the form of a globe symbol, which also indicates
which setting is currently active.

If the globe is active, and a small "F" is depicted in the lower right corner, automatic FTP
uploading is activated.

If the globe is active, and a small "e" is depicted in the upper right corner, automatic emailing
is activated.

If the globe is active, and both the "F" and the "e" are depicted, both automatic FTP uploading
and emailing are activated.

If the globe is active, but no letter is displayed, neither automatic FTP uploading nor automatic
emailing are activated. Manual FTP or email functions may still both be active.

If the globe is grayed out, neither automatic nor manual FTP or email functions are available.

When neither box for emailing has a tick, no emailing will be possible. Similarly, when neither box
for FTP upload has a tick, no uploading via FTP will be possible, however in both cases the settings
data will still remain stored.

Clicking on the FTP or E-mail settings buttons brings up the dialogue windows for the Basic FTP
settings or the Basic SMTP and email settings. Usually this information will be provided by your
network administrator. If your company has specific IT policies you may not be allowed to
configure the settings yourself. In this case, or if your network administrator has already created a
company wide access for multiple users, you may be provided with a file containing the required
settings. Your network administrator will detail instructions how to import these settings into
LogTag® Analyzer.

Changing FTP or email settings while files are being uploaded will display following dialogue box
when clicking OK to close the Options window.

Click Yes to cancel the current upload, and No to continue uploading to the new location.

When uploading or emailing files a status window is displayed (See "Upload Status Window").
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The manual email function described here is different from the "send mail" button on the
toolbar. The Send mail button invokes your standard email program, attaches the data file,
requires you to fill in an email address and press the send button. The manual email function
via SMTP does not use your standard email program, but the configured SMTP settings and
requires no further action once the globe button on the toolbar is pressed.

Note: Automatic upload via FTP and automatic emailing only work if a file is created by
downloading data from a LogTag® in the interface. If the uniqueness settings in the File and
Folder Settings are set so that certain conditions do not result in creation of a new file, no file is
uploaded or emailed either.

Files with formats other than the native LogTag® Analyzer format will only be emailed or
uploaded automatically if specifically selected in the FTP or SMTP basic settings. This may be
different from the settings in the Exports and Reports option dialogue.

Note: If you upload a file via the manual or automatic FTP function, any file that already exists
on the server with the same name will be overwritten. It is up to you to make sure files are
created with unique file names.

Basic SMTP and email settings
Disclaimer

The distribution of unsolicited emails provides huge inconvenience to anyone with an email
account. LogTag® Analyzer's email function allows the automated emailing of files to a large
number of recipients simultaneously without user interaction. Some countries consider this as
spam and will prosecute offenders.

It is therefore of the utmost importance that you as the sender obtain permission from the
recipients to send these files. LogTag® Recorders provides this functionality as a feature assisting
in the distribution of information between various users within an organization and will not
assume responsibility for any misuse of its software.

Setting up automated emailing requires two main pieces of information:

l The name of the SMTP server which you wish to use to send the emails and

l A valid user name and password for the SMTP server.

Once you click on the SMTP Settings button a dialogue window will appear, allowing you to enter
the configuration data for the SMTP email function. A lot of these settings will be familiar to you
from your standard email program.



Figure 99: Basic SMTP settings for automatic emailing

If you have been supplied with access data by your network administrator we suggest you print the
following table, enter the data into the fields provided and keep it in a safe place.

Field What to enter

SMTP Server Enter the name of the SMTP server you were given by your network
administrator

SSL SSL stands for Secure Sockets Layer. You may be required to tick this box if
your SMTP server requires a secure connection. Typically this setting is not
required, and your network administrator will set this up if required.

Use name and
password

Some SMTP servers require an authentication method, especially if the SMTP
server you are using is not provided by your ISP, e.g. if you are using email
accounts from a hosted site. In this case you need to tick this box and provide
login data for this SMTP server. Quite often, though, you will not be required
to use Authentication.

Table 16: Available basic SMTP Settings
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Field What to enter

User Name Enter the user name you have been allocated by your network administrator
required for Authentication. Please note that for authentication this often
needs to include a full email address rather than just the SMTP login.

Password Enter the password you have been given by your network administrator
required for Authentication.

Name Enter the name as it should appear in the recipients email program. This can
be your name or someone else's name.

email address Enter the email address that the recipient can reply to by pressing the reply
button of his email program. This can be your email address, or someone
else's address.

Recipients Enter the email addresses of the intended recipients. Pressing the "add" button
will bring up a new entry window where you can enter a recipient's name and
email address.

You can also highlight a recipient's name and edit the data or remove it from
the list.

Subject Line Text entered in this line will be displayed in the subject line of the email

when displayed on the recipients' email programs. Clicking on the button
will allow you to specify some file related information which will be entered
into the subject line at the time of sending. You can enter your own text with
the file related information.

Advanced
settings

Press this button to display a new dialogue window where you can enter
advanced SMTP settings like port numbers, retries and log files. Refer to the
section about Advanced SMTP settings.

Attach file in
the following
formats

Select all files that you wish to attach when the email is sent. Each file ticked
here will be created, regardless of the settings made in Edit - Options -
Exports and Reports.



Field What to enter

Store pending
uploads between
sessions

This feature is selected by default.

If emailing files is interrupted due to a network error, a temporary copy is
stored locally, and LogTag® Analyzer will attempt delivery when it is next
started. If you no longer wish to send these files, click the Clear pending
uploads (outbox) button to delete the temporary copy. Your generated data
files will not be affected.

If the feature is disabled, files not sent when the software is closed will have
to be manually re-submitted.

As a minimum you only need to provide an SMTP server address and one recipient email address
for this function to work.

Every time you make changes to these settings you should perform a test by pressing the Send
Test email button. LogTag® Analyzer will

l check you have provided valid connection data,

l send a test email to the email addresses in the recipient list.

If any of these actions fail, LogTag® Analyzer will display one of the following error messages:

In this case the SMTP server requires authentication, and the data provided were not correct.
Please enter the correct authentication data.

This error message is displayed if LogTag® Analyzer could not connect to the specified SMTP site
because it could not find it. This could be due to internet connectivity issues, due to an incorrect
port name or due to a mis-spelt server name.
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This error message is displayed if one or more of the addresses in the recipient list have an
incorrect mail format (i.e. are not in the format a@b.c). LogTag® Analyzer can only check for the
correct format of the addresses, but not for correctness of the recipients email addresses. Please
note if you do not provide a correct return address, you may not know that intended recipients are
not receiving the messages.

We recommended you add your own email address to the list of recipients. This way you get
feedback if your email has been sent correctly in your email program. It is also good practice to
enter a valid and correct email return address for yourself. Some ISP's will not relay messages
without a sender's address.

Advanced SMTP settings
Clicking on the "Advanced Settings" button in the SMTP settings dialogue displays following
Window:

Figure 100: Advanced SMTP settings

This will allow experienced users to change additional settings normally associated with FTP
transfers.

Field What to enter

Port Number The default port for providing SMTP connections is 25. Some network
administrators change the port number on their SMTP servers to increase
security and stop hacking attacks. If your network administrator has advised a
different port for connection, please enter it here.

In this case you may also need to change the settings of you firewall.

If you wish to learn more about this topic please see any of the published
articles on networking and TCP/IP available on the Internet.

Table 17: Available advanced SMTP settings



Field What to enter

Retry If a connection cannot be established, LogTag® Analyzer will retry to email the
file again after the number of minutes entered here. This helps eliminate
email errors due to intermittent Internet connection errors.

Maximum
Retries

Enter the number of times LogTag® Analyzer should try to email the file if
previous attempts have not been successful.

Automatic
Disconnect if
idle

LogTag® Analyzer will keep the connection to the SMTP server active, even if
currently no files are being emailed. This avoids having to exchange password
and login information every time a file is uploaded therefore providing faster
uploads, especially if only a slow Internet connection is available. After a
certain amount of inactivity the connection is dropped to save resources. Enter
the time after which you wish LogTag® Analyzer to automatically disconnect
from the SMTP server.

Log uploads If a tick is placed in the box next to "Log uploads" the message exchange
between the SMTP server and LogTag® Analyzer is recorded into a file. These
files are automatically named "YYYY_M_D_LogTag Analyzer_SMTP.log", you
can specify a location where the files are created, or click to browse to a
location of your choice.

Log Connection
errors

Tick this box if you wish connection errors to be logged. This is recommended
if you frequently experience upload errors and you wish to discuss this issue
with your network administrator.

Click OK to store the settings or cancel to abort.

Basic FTP settings
You will require two main pieces of information to upload data to an FTP site:

l The name of the FTP site and a directory on the site in which the files will be stored once
uploaded and

l A valid user name and password allowing you access to this directory.

Once you have clicked the "FTP Settings" button a dialogue window will appear, allowing you to
enter the configuration data for the FTP site access.
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Figure 101: Basic FTP settings screen

If you have been supplied with access data by your network administrator we suggest you print
this page, enter the data into the fields provided and keep it in a safe place.

Field What to enter

FTP Server Enter the name of the FTP site you were given by your network administrator

User Name Enter the user name you have been allocated by your network administrator

Password Enter the password you have been given by your network administrator

Remote folder Enter the folder in which the data files should be uploaded. Please note that
not all FTP servers allow creation of files or folders in the root directory.
Please discuss any of your requirements with your network administrator.

Create Folder Tick this box if the remote folder is not yet present on the FTP site and you
wish to create it.

Upload file in
the following
formats

Select all files that you wish to have uploaded to the FTP site. Each file ticked
here will be created, regardless of the settings made in "EDIT - OPTIONS -
EXPORTS AND REPORTS".

Advanced
settings

Press this button to display a new dialogue window where you can enter
advanced FTP settings like port numbers, retries and log files. Refer to the
section about Advanced FTP settings.

Table 18: Recording your basic FTP settings



Field What to enter

Store pending
uploads between
sessions

This feature is selected by default.

If uploading files is interrupted due to a network error, or because the FTP site
is down, a temporary copy is stored locally, and LogTag® Analyzer will attempt
to re-upload the file when it is next started. If you no longer wish to upload
these files, click the Clear pending uploads (outbox) button to delete the
temporary copy. Your generated data files will not be affected.

If the feature is disabled, files not uploaded when the software is closed will
have to be manually re-submitted.

All of the above settings are required to make a successful connection to an FTP server.

Every time you make changes to these settings you should perform a test by pressing the "Test
connection" button. LogTag® Analyzer will

l check you have provided valid connection data,

l if necessary create the folder you have specified and

l put a small test file in the selected location.

If any of these actions fail, LogTag® Analyzer will display one of the following error messages:

In this case the remote folder could not be created. Please select a different folder name or change
to a permitted location.

This error message is displayed if LogTag® Analyzer could not connect to the specified FTP site
because it could not find it. This could be due to internet connectivity issues, due to an incorrect
port number or due to a mis-spelt name.
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This message appears when either user name or password are incorrect.

Advanced FTP settings
Clicking on the "Advanced Settings" button in the FTP settings dialogue displays following Window:

Figure 102: Advanced FTP settings screen

This will allow experienced users to change additional settings normally associated with FTP
transfers.

Field What to enter

Port Number The default port for providing FTP connections is 21. Some network
administrators change the port number on their FTP servers to increase
security and stop hacking attacks. If your network administrator has advised a
different port for connection, please enter it here.

In this case you may also need to change the settings of you firewall.

If you wish to learn more about this topic please see any of the published
articles on networking and TCP/IP available on the Internet.

Security Protocol Choose between none, SSL or TLS

Table 19: Available advanced FTP settings



Field What to enter

Firewall/Proxy
Settings

Use the settings from the registry or choose your own settings. Please discuss
these settings with your network or IT administrator.

Retry If a connection cannot be established, LogTag® Analyzer will retry the file
upload after the number of minutes entered here. This helps eliminate upload
errors due to intermittent Internet connection errors.

Maximum
Retries

Enter the number of times LogTag® Analyzer should try to upload the file if
previous attempts have not been successful.

Automatic
Disconnect if
idle

LogTag® Analyzer will keep the connection to the FTP server active, even if
currently no files are being uploaded. This avoids having to exchange
password and login information every time a file is uploaded therefore
providing faster uploads, especially if only a slow Internet connection is
available. After a certain amount of inactivity the connection is dropped to
save resources. Enter the time after which you wish LogTag® Analyzer to
automatically disconnect from the FTP server.

Log uploads If a tick is placed in the box next to "Log uploads" the message exchange
between the FTP server and LogTag® Analyzer is recorded into a file. These
files are automatically named "YYYY_M_D_LogTag Analyzer_FTP.log", you can
specify a location where the files are created, or click to browse to a
location of your choice..

Log Connection
errors

Tick this box if you wish connection errors to be logged. This is recommended
if you frequently experience upload errors and you wish to discuss this issue
with your network administrator.

Click OK to store the settings or cancel to abort. You can restore default settings by clicking on
"Restore defaults".

File and Folder Settings
The File and Folder Settings options help you manage the LogTag® data files.

Figure 103: File and folder settings Option dialogue
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Display X items in my most recently used list
This determines how many of the most recently accessed files are listed in the File menu for quick
access to be opened and viewed again. Once this number of files has been reached, the reference
to the oldest file opened will be removed and the most recently opened file will be added to
position 1. Only the file reference is removed from this list, the actual file is not deleted. Changing
this setting will take effect the next time LogTag® Analyzer is started.

Display
This determines how the information retrieved from a file and/or LogTag® will be first displayed.
All other ways of displaying information will still be available regardless of which is selected here.

l Chart; this will display the data in a time versus humidity and/or temperature chart.

l Data; this will display a list grid (spreadsheet style) of the time versus humidity and/or
temperature data.

l Report; this will display a condensed overview of the data including averages, ranges,
alert results, LogTag® identification data, and a small chart.

l Summary; this will display a summary of the data, including averages, ranges, alert
results, LogTag® identification data, and other information.

File Name
Whenever information is downloaded from a LogTag® it is always automatically saved to disk. This
field defines the composition of the file's name.

You can enter text and also include pre-defined placeholder elements in this definition field. When
a new file is created, the elements are then replaced with the corresponding information from the
logger data or your computer environment.

Use the button at the end of the edit control ( ) to display a list with available elements.
Selecting an element will insert placeholder text representing this element at the cursor location;
alternatively you can enter this text directly.



Figure 104: Available file name elements

You may use one or more of the available elements in any order. If you type additional text into
the definition field, you must not add it inside an element's placeholder text. If you manually
enter placeholder text, the letters must be in uppercase as shown in the following table (for
example, "%ID" not "%id") and include the % marker.

Element Placeholder Text File name shows...

LogTag ID %ID The unique LogTag® identification value.

Date LogTag Finished %FINISH-DATE The date of the last reading recorded
after being started. If the LogTag® was
not started then this information will be
blank.

Date File Created %DATE The date when the LogTag® information
was originally retrieved.

Table 20: Description of available file name elements and their placeholder text
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Element Placeholder Text File name shows...

Date LogLogTag Started %START-DATE The date the LogTag®g was started to
record information. If the LogTag® was
not actually started and only pre-start
information was recorded then this
information will be blank.

Date of first reading %FIRST-DATE The date of when the LogTag® began
recording information, even if it was
under pre-start conditions.

Date of last reading %LAST-DATE The date of the last reading recorded,
even if there are only pre-start
recordings.

Date/Time LogTag Finished %FINISH The date and time of the last reading
recorded after being started. If the
LogTag® was not started then this
information will be blank.

Date/Time LogTag Started %START The date and time the LogTag® was
started to record information. If the
LogTag® was not actually started and
only pre-start information was recorded
then this information will be blank.

Date/Time File Created %DATE-TIME The date and time when the LogTag®

information was originally retrieved.

Date/Time of first reading %FIRST The date and time of when the LogTag®

began recording information, even if it
was under pre-start conditions.

Date/Time of last reading %LAST The date and time of the last reading
recorded, even if there are only pre-start
recordings.

Model ID %PRODUCTID The product identifier (part number) for
the LogTag® used to record the data.

Month File Created %MONTH The month in which the file was created,
using a two digit number with a leading
zero where required.

Number of Times Started %START-COUNT The number of times the LogTag® has
been started since manufacture.

Serial Number %SERIALNUM The unique serial number of the
LogTag®.



Element Placeholder Text File name shows...

Time LogTag Finished %FINISH-TIME The time of the last reading recorded
after being started. If the LogTag® was
not started then this information will be
blank.

Time LogTag Started %START-TIME The time the LogTag® was started to
record information. If the LogTag® was
not actually started and only pre-start
information was recorded then this
information will be blank.

Time File Created %TIME The time when the LogTag® information
was originally retrieved.

Time of first reading %FIRST-TIME The time of when the LogTag® began
recording information, even if it was
under pre-start conditions.

Time of last reading %LAST-TIME The time of the last reading recorded,
even if there are only pre-start
recordings.

User ID %USERID The user defined identifier for the set of
information recorded by the LogTag®.

Week File Created %WEEK The week in which the file was created,
using a two digit number with a leading
zero where required.

Year File Created %YEAR The year in which the file was created,
using a four digit number.

You may use the \ character to specify that a file name definition includes a sub folder name. This
is useful if you want to group/sort files automatically together and it cannot be done using the
folder name controls (for example if you want sort the files by User Id).

Characters not supported by the operating system such as : * ? < > | are not permitted. If you do
include one of these elements they will be replaced with the _ character.

Any date or time element will use the formatting settings defined in the Date and Time options.

Folder Name
This determines the directory where the files are automatically stored. The location defined here
can specify a local drive path or a network drive path. UNC folder names are supported. You can:

l Browse the directory structure with the button and select the desired directory.

l Enter the path manually.
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You can enter text and also include pre-defined placeholder elements in this field. When
a new file is stored, the elements are then replaced in the path name with the
corresponding information from the logger data or your computer environment.

Use the button at the end of the edit control ( ) to display a list with available
elements. Selecting an element will insert placeholder text representing this element at
the cursor location; alternatively you can enter this text directly.

You can insert following variables, provided the final resulting name is a valid UNC folder
name:

Element Placeholder text Path name shows...

Computer name %COMPUTERNAME The name of the computer as entered in the
system description.

Month File Created %MONTH The month in which the file was created, using
a two digit number with a leading zero where
required.

User domain %USERDOMAIN The domain name of the network the user is
connected to.

User home drive %HOMEDRIVE The drive letter on which the User 's documents
directory is stored.

User home path %HOMEPATH The path (excluding the drive letter) of the
user's home directory.

User name %USERNAME The user' user name as required for logon.

Week File Created %WEEK The week in which the file was created, using a
two digit number with a leading zero where
required.

Year File Created %YEAR The year in which the file was created, using a
four digit number.

Table 21: Description of available elements and their placeholder text for the storage folder



A valid storage directory would be %HOMEDRIVE\%HOMEPATH\Documents\My LogTag
Documents. You do not need to enclose the string with quotes.

You need to make sure you have write access to the resulting directory. If LogTag® Analyzer is
unable to write to or create a directory, a warning message will appear when you next download a
logger and you will then need to select a different directory.

Note: Some Network Attached Storage Devices (NAS Drives) use versions of SAMBA (Server
Message Block) file servers which do not correctly report back whether a file exists or not.
Consequently, LogTag® will overwrite without warning an already existing file with the same
name, regardless of the settings made in the Automation options.

Uniqueness
With this setting you decide what the software should do when a LogTag® is downloaded, and the
file name settings see File Name on page 158) would result in duplicate file names in the selected
storage location. This is important if for example you have kept the default file name settings, and
download a logger more than once a day.

The options available include:

1. Always create a unique copy of files (recommended)

The software will automatically append " Copy n" to the end of the file name, where "n" will
be a unique sequential number.

2. Overwrite file if the file already exists

The existing file is replaced with a file that contains the information just downloaded. The
old file will no longer be accessible. This is only recommended if you do not use "continuous
operation" (see Continuous operation on page 73).

3. Prompt if an existing file already exists.

A message will appear asking you whether or not you want to replace the existing file.

- If you answer Yes the existing file is replaced as in option 2.

- If you answer No the software will append " Copy n" to the end of the file name as in
option 1.

This setting only takes effect if the file that is being saved is different to the file that is already
stored. If you download a logger that has already stopped, the resulting file would have the exact
same content as the file already stored. In this case no additional files are generated, regardless
of what settings you have made in this drop down box. You will see a change in date for the
"Last modified" property in Windows Explorer, as it is opened by LogTag® Analyzer for
comparison. The only time such a file would be re-generated is if someone had added a digital
signature to the original file, and downloaded the logger again. In that case the uniqueness
settings would determine if a file would be generated again, and what name it would be given.

Exports and Reports
In addition to the native *.ltd file you can automatically create files in other formats every time a
LogTag® is downloaded. You would use this for example if you wanted to perform further analysis
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of the downloaded data in MS Excel, or email a PDF file to someone who does not have LogTag®

Analyzer installed on their computer.

Figure 105: Export Options

To automatically create additional files, select one or more file types from the list.

The additional files will be automatically saved when downloading a LogTag® using the file name
and folder location defined in File and Folder Settings.

If during the download no new file is created (for example when downloading a unit that
is no longer logging and has previously been downloaded), no export data are generated
either.

These file formats cannot be imported back into LogTag® Analyzer. It is also not possible to detect
any manipulation to these files since they can be edited with third party software.

You can select which extra information will be included in the exported data by highlighting the
format name and clicking Customise . In the dialogue window displayed adjust the options to suit
and click OK to save your selection. Click Cancel if you wish to discard any changes you have
made.

To override and customize the contents of the particular file format, simply ensure the file format
is highlighted and click Following window will be displayed:



Figure 106: Customising Export Options

For CSV files you can additionally select a custom list separator. CSV files normally use a comma
as a separator between individual values of a row. By default, LogTag® Analyzer uses the list
separator from the "Regional and Language Options" in the Windows Operating System. For some
regions the resulting file is strictly speaking no longer a CSV file, however it maintains
compatibility with the import of CSV files into MS Excel. You can also use a self selected separator
instead.

The options for the PDF files are more extensive than for other files, please see PDF files

To select file formats for the email attachment created through the Send Mail command when
Sending a file by email direct from Analyzer, tick the desired file formats in the second list.

Note: The list of Send Mail file formats contains only file formats selected in the Export formats
list, plus the LogTag® format.

Please also be aware any formats selected here will neither be automatically uploaded to an FTP
site, nor emailed through the automatic emailing function. Files to be automatically sent or
uploaded are enabled in the Basic FTP settings and the Basic SMTP and email settings dialogues.
Customisation, however, is only performed in this section about Exports and Reports.

Chapter 6: Customising the software 165



166 LogTag® Analyzer Version 2.9 User Guide

Date and Time Format
Here you can set how dates and times are displayed in all tabs, reports and exports.

Figure 107: Date and time options

Short Date, Long Date and Default time use the settings from the Regional and Language settings
of the Windows operating system, accessible through the Windows Control Panel.

You can customize how the date or time information is displayed by selecting Custom Date or
Custom Time and combining the elements as listed in the tables on page 125. You can use other
characters such as '.', '/', '\', ',' or '-' (to name just a few) to separate elements, or you can add text.
If you wish to show the letters 'd', 'M', or 'y' in the date string or 'h', 'H', 'm', 's' or 't' in the time
string they must be enclosed in single quotation marks. The letters must be in the correct case (for
example, "MM" in the date string, not "mm" as you would use for time value).

Element Meaning

d Day of month as digits with no leading zero for single-digit days.

dd Day of month as digits with leading zero for single-digit days.

ddd Day of week as a three-letter abbreviation.

dddd Day of week as its full name.

M Month as digits with no leading zero for single-digit months.

MM Month as digits with leading zero for single-digit months.

MMM Month as a three-letter abbreviation.

MMMM Month as its full name.

Table 22: Date options



Element Meaning

y Year as last two digits, but with no leading zero for years less
than 10.

yy Year as last two digits, but with leading zero for years less than
10.

yyyy Year represented by full four digits.

Element Meaning

h Hours with no leading zero for single-digit hours; 12-hour clock.

hh Hours with leading zero for single-digit hours; 12-hour clock.

H Hours with no leading zero for single-digit hours; 24-hour clock.

HH Hours with leading zero for single-digit hours; 24-hour clock.

m Minutes with no leading zero for single-digit minutes.

mm Minutes with leading zero for single-digit minutes.

s Seconds with no leading zero for single-digit seconds.

ss Seconds with leading zero for single-digit seconds.

t One character time-marker string, such as A or P.

tt Multi character time-marker string, such as AM or PM.

Table 23: Time options

For example, if the date was 2 January 2012 and the date format was defined as yy-M',' dd the date
would be displayed as 12-1, 02.

A sample of the chosen date and time format is displayed in the sample box.

This setting does not affect how the date and time information is stored in a *.ltd file, only how
the information is shown.
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Time zones

Time zone What is displayed

Download Time Zone All reading times are displayed in the time zone of the computer used
for downloading or displaying the data. This is the default setting and is
also referred to as local time.

If you receive a file which was originally downloaded in a different
time zone, the times displayed still appear in the time zone of your
local computer.

This is the most commonly used option, as it displays the dates and
times on screen in your local time zone.

Configuration Time
Zone

All reading times are displayed in the time zone of the computer used
for configuring the LogTag®.

You would use this option if you wanted to view the data in the same
way the sender or the logger would see them.

UTC/GMT Time Zone All times are displayed in Universal Time Coordinates, or Greenwich
Mean Time representation.

This is the best option when comparing different loggers from different
senders in different time zones.

Logger Display Clock /
PDF Time Zone/
Configuration Time
Zone

All times are displayed relative to the clock that is showing on the
display or in the PDF file. If the unit has no display or is not a USB PDF
logger, the logger's Configuration time zone is used.

You would typically select this option, if you want the logger's display
clock or the PDF file generated by the USB loggerto show the same time
values as the Report generated by LogTag® Analyzer.

Logger Display clock/
Download Date

All times are displayed relative to the clock that is showing on the
display and use the date of the download computer. This is the setting
always applied to Vaxtag® (TRID30-7FW ) units

Table 24: Time zones for data display

Selecting either of these options does not affect recorded data inside the LogTag®.



Communication Ports
LogTag® Analyzer supports communication with multiple ports simultaneously, so it is possible to
connect and use more than one interface cradle at the same time. Each time you use LogTag®

Analyzer to configure, download or hibernate a logger it needs to check each enabled port to see if
an interface with a logger is attached to that port. In this dialogue you can define, which
communication ports should be checked for connected interface cradles. The more ports you leave
enabled, the longer it will take LogTag® Analyzer to establish which ports have interfaces
connected, and which don't.

You should therefore only enable ports you plan on connecting an interface to. Ports not used for
communication with LogTag® products should be excluded, which speeds up communication.

When you first install LogTag® Analyzer, all COM ports are disabled by default, as the most
common method of communicating is via USB interfaces.

Figure 108: All COM ports disabled, USB enabled

This is especially useful if you have Bluetooth devices connected to your computer, which generate
a large number of virtual COM ports. It can take LogTag® Analyzer a long time during download or
configuration to detect if these virtual ports have an interface connected, so disabling the ports
significantly improves communication time. Any new COM port established after you disable all
serial ports will also be automatically disabled.

If you wish to use an RS232 serial interface, you can clear the check box Disable all serial ports.
There are two methods which you can now use to define the COM ports that will be used for
communication:
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l automatically

Figure 109: Communication ports USB, COM1 and COM2 enabled

When you select automatically, all COM ports will be listed that can support a connected
interface. This includes virtual COM ports that you might use with an RS232 to USB
adapter. You can then choose which of these ports you want to enable for communication
by selecting the check box next to the COM port.

Any COM ports created after you confirm this setting will automatically be added to the
list of available ports and will automatically be enabled for communication.

l manually

Figure 110: Communication port COM4 detected and enabled after scan

When you select manually, all COM ports are removed from the list. When you click
Scan now , LogTag® Analyzer checks each COM port for the presence of an interface
cradle, and only lists those ports which have an interface connected at the time.

Any COM ports created after you confirm this setting will not be added to the list of
available ports. If you plug your interface into a different COM port (or your virtual COM
port gets a different number assigned) you will need call up this setting again to select Scan now
and re-detect the interface.

Any interfaces found will automatically be selected for communication.

Note: USB ports cannot be disabled; if you do not wish the software to communicate with USB
ports you must unplug any interface currently connected.



User Server
The User Server options define if and how LogTag® Analyzer should connect to the LogTag® User
Server software. If you do not have LogTag® User Server software installed on your computer
and/or available on your local area network, you will not need to changes these settings.
Connection to the LogTag® User Server software is typically only used in a multiple user
environment or if your organization requires compliance with the US FDA 21 CFR Part 11
regulations for use of digital signatures that are controlled by a central administrator.

Figure 111: User Server options

The settings required in these fields will be provided by your network administrator. Once a valid
connection to the LogTag® User Server software has been established, you will be required to
provide a valid user name and password (see How users log on on page 198 to continue using
LogTag® Analyzer.

Note: If the LogTag® User Server software runs on a different computer you need to be
connected to that computer via a LAN or WAN to use LogTag® Analyzer software or make any
changes to these settings.

To enter or change these settings LogTag® Analyzer must be started from a user account with local
administrator privileges. If you normally start it from a standard user account, please close
LogTag® Analyzer, right click its shortcut and click Run as administrator from the context menu.
Make the changes after you have provided Administrator credentials, then close LogTag® Analyzer
and start as usual.
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Figure 112: Running LogTag® Analyzer as administrator

Software Updates
The LogTag® Analyzer software can periodically check if a newer version is available for download
from the LogTag® Recorders website.

To enable this feature select Enable automatic checking for newer version and set the number of
days between checks by entering a number in the "Check every XX days" field. This can be set from
1 (every day) to 365 (every year). By default, this option is turned on with a period of 30 days. We
recommend leaving it turned on, so you will automatically be notified when an update is available.

To disable the feature, clear the check box.

If you enable the automatic check, you will be asked if you want to download and install the new
version when it is available Updating LogTag Analyzer on page 19).



Figure 113: Software update options

Configuration Reports
It can sometimes be useful to keep a record of the configuration data of a LogTag® Recorder.
LogTag® allows a number of selected configuration data to be stored in a text file. These settings
are made in the Configuration Reports window.

Figure 114: Configuration logging options

When the Log configuration data option is ticked, the selected parameters are written into a text
file, which is named "LogTag Analyzer_config_log_WW-YYYY", where WW is the current week
number and YYYY is the current year. Each week a new file will be generated.
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Clicking on the button will allow you to select a folder of your choice where the log files will be
stored. For each logger configured a new line is started in the text file, individual entries in each
line are separated by the character specified in the "Field separator" box. You can change the order
of the entries in each line by selecting a Field and clicking on the up or down buttons.
Clicking the tick box enables all parameters to be included in the log file.

Following parameters can be selected:

For Loggers with multiple alarms, or loggers where the upper and lower alarms can have different
accumulative or consecutive values, the Upper and Lower Alert fields contain a summary of the
alarm settings.

Importing and Exporting Option Settings
LogTag® Analyzer's option settings can be and then into other installations of LogTag® Analyzer.
This is useful if you want to distribute settings to multiple users on the same computer or copy
settings from one computer to another. You can also use this if you are upgrading your computer,
and want to transfer the settings to the new computer.

You can access these functions via the Import and Export buttons in the Edit - Options dialogue.



Figure 115: Import and Export Buttons in the bottom left corner of the window

Exporting the Options Settings
To export the settings, click Export from the Edit - Options menu.

You will see a dialogue, where you can select which option settings will be exported.

Figure 116: Selecting the options settings to be exported

Select all applicable sections you wish to export, or Select All to export all settings. Only settings
with the check box selected will be exported.

You need to enable at least on option, or you will receive following error:
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Click Export and browse to a directory; enter the file name of the export file. The *.asxml file
extension will be added automatically.

Figure 117: Selecting the export file name and location

Once you click Save the export file will be written to the folder specified.

Importing the Option Settings
You can use one of the following methods to import option settings into LogTag® Analyzer.



l With LogTag® Analyzer open, select Edit - Import Options.

Figure 118: Import options dialogue

Browse to a previously stored *.asxml file and click on Open.

l Double click on a *.asxml file in Windows Explorer, on the Desktop or in an email
attachment.

l Drag and drop a *.asxml file onto the LogTag® Analyzer icon on the desktop.

l Open the file via the File - Open dialogue in LogTag® Analyzer.

Only settings present in the *.asxml file will be imported. If a setting already exists in LogTag®

Analyzer, and a different setting is imported, the new setting from the imported file will overwrite
the existing setting.

Once the import is complete, you will see this dialogue.

Figure 119: Import successful
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If there are any problems with the import file, an error message will be displayed showing the
import failed.

Figure 120: Import failure

Individual parameters are also checked on import. When a parameter is outside allowed values, an
error message will be displayed, and the import will not proceed:

Figure 121: Import failure with misspelled parameter

If an error is found, the file import of the *.asxml will not proceed. Your IT administrator can help
with issues arising from an import failure.

If the imported file contains settings for user server, a confirmation dialogue will appear,
requesting you to acknowledge the new settings.

Figure 122: Confirm User Server settings



If you click cancel, or do not enable the I agree check box, the user server settings are not
imported, however the remainder of the import will proceed.

If LogTag® Analyzer already requires you to log-on to an existing User Server connection...

l ...you cannot import new User Server option settings

l ...you cannot import any settings for which access has been blocked by the User Server
administrator

l ...you cannot import or export any settings without being logged in, and the menu items
will not be accessible.

Chapter 6: Customising the software 179



Chapter 7
Menus and Toolbars

At the top of the screen below the title bar is LogTag® Analyzer's menu system and
toolbar. The toolbar provides quick access to some of the more commonly used
functions within the menu system. The menu system contains lists of all the
operations and commands that are available to you while using the software.

Figure 123: Menu and toolbar

In this chapter:

Menu commands 181
Toolbar commands 189
Upload Status Window 191
Print preview toolbar 191
Standard Window commands 193



181 LogTag® Analyzer Version 2.9 User Guide

Menu commands
The menu system has been separated into groups of related commands. Each of these menu
groups is explained in more depth in the subsequent sections. The software will only display the
menu groups and commands within each menu group that are appropriate depending on what you
are currently doing with the software.

You may also see that some of the menu commands have a reference after the command name,
for example F2 or Ctrl+O. These represent key strokes on the keyboard that instruct the software
to perform the appropriate command, without the need to select the menu or toolbar command.
When only one key reference is mentioned, for example F2, then pressing that single key on the
keyboard will cause the appropriate command to be performed. If there is more than one key
reference mentioned, for example Ctrl+O, then to cause the command to be performed you must
press and hold down the first key mentioned while pressing the other key once. When letters are
used in the key reference, for example Ctrl+O, it does not matter whether or not the caps lock is
on or off.

File Menu
The File menu contains commands that relate to a LogTag® file. When clicking on File, a menu
similar to following will appear. You can also access the menu by pressing ALT-F.

Figure 124: File menu

The following table outlines the commands that appear in the "File" menu and a brief explanation
for each command. Some commands do not appear if no file is open.



Command Explanation

Open... ( ) This will display the Open file dialog, which will allow you to open:

l LogTag® *.ltd and *.sltd files previously saved, or

l previously saved Multi Chart configuration files.

It will start at the folder defined in Edit - Options - File and Folder Settings.

If a Multi Chart file is selected, the LogTag® Analyzer software will
automatically switch to Multi Chart mode and all the selected files will be
added to the Multi Chart display.

Close This command will close all windows that are displaying information about
the open file that is currently selected. If no files are currently open this
command will not be visible.

Multi Chart This will change the way recordings are displayed such that they are all
combined on a single chart window (see Combining charts onto a single chart
on page 117).

Single Chart This will change the way recordings are displayed such that each which will
contain all the information retrieved from a single LogTag®.

Save This will save any changes you have made to the LogTag® file (or Multi Chart
configuration) to your disk drive.

Save As... This will display the Save As file dialog, which will allow you to save a copy of
the file currently being displayed in the same or different folder with the
same or different file name.

Upload This will send an email with the currently active file attached to a list of
recipients or upload the file to a pre-determined FTP site. See Automatic
emailing and uploading to FTP sites.

Print... This will open a window allowing you to print a copy of the LogTag® file to an
output device, which will typically be a printer. This command is further
explained in the section Printing the results.

Print All... This will open a window allowing you to print all currently open files. See
Printing the results for further information.

Print Preview This will change the display mode of the software to show you a copy of how
a printout of the currently selected file and window would look like. In "Print
Preview" mode you will not be able to zoom in or out of a chart. Click Close to
exit the "Print Preview" mode and return to normal display mode.

Page Setup... This will open a window allowing you to view and adjust one or more of your
page settings, like printer margins and page orientation. See the Information
for Page Setup on page 127

Table 25: File menu - available commands
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Command Explanation

Send... This will help you send, by email, the currently open and selected LogTag®

file to another user without the need to exit to your email software or to deal
with file attachments. This command is explained in further detail in the
section Sending a file by email direct from Analyzer.

Properties... This will open a window that will display the information about the file that
is being displayed and currently selected. This same window and information
will be displayed if you view the properties of the file from Microsoft
Windows Explorer.

Digital
Signature... ( )

This will open a window to display a list of digital signatures that have been
included with the file. It also allows you to add and print this list of digital
signatures. This command is explained in further detail in the section "Digital
signatures".

User logon... ( ) The User Logon is used when LogTag® Analyzer is connected to the User
Server software. Users must provide their logon to use the software.

This command is only available if the Analyzer software is connected to the
User Server software. If a user is already logged on, this menu entry changes
to User Logoff.

The section User Server explains in more detail how to get the Analyzer
software to connect to the User Server software.

Logoff user
(username) ( )

This allows the currently logged on user to log off. The username portion of
this command will represent the name of the user currently logged on.

Change
Password...

This allows the currently logged on user to modify their password that they
use to logon to the Analyzer software. This command will only be available if
the Analyzer software is connected to the User Server software and the User
Server administrator has granted the appropriate user permissions.

1, 2, 3, etc This portion of the menu represents a list of the most recent files you have
viewed. To re-open one of these files, simply click on the entry (name of the
file) to open. The number of files included in this list can be adjusted through
Edit - Options - General Settings.

Exit This command will exit and close down the LogTag® Analyzer software. Any
files that you currently have open will also be closed automatically for you.
Any user currently logged on will be automatically logged off.

Edit Menu
The Edit menu contains commands that change how the data are presented on screen. Here you
can also define default option settings and import and export these settings. When clicking Edit, a
menu similar to following will appear. You can also access the menu by pressing ALT-E.



Figure 125: LogTag® Analyzer Edit menu

The following table outlines the commands and the explanation of each command that may appear
in the Edit menu:

Command Explanation

Copy Places a copy of the contents of the currently displayed window onto
the clipboard, which can then be pasted into any Windows®

application. If you are copying a chart, the chart at its current zoom
range is copied to the clipboard. If you are copying from one of the
tabular style windows (Data or Summary), then the entire contents
of the window is copied to the clipboard, regardless of what part of
the data you have scrolled to view.

Zoom Out This will undo the last zoom operation performed allowing you to see
more of the data on the chart. If the chart is displaying all the
readings recorded by the LogTag®, this command will not be
available.

Real Time Clicking this menu item will make the time axis represent date and
time the data were recorded. This is useful when you want to
inspected at what date and time a certain event occurred.

Elapsed Time Clicking this menu item will make the time axis represents the
elapsed time since the recording began. This is useful when you
want to inspected how long into a trip a certain event occurred.

Zoom to Marks When this command is enabled, the chart is automatically zoomed to
show readings recorded between inspection marks. The section
"Starting and using the LogTag®" explains in further detail how
inspection marks are recorded.

Table 26: Edit menu - available commands
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Command Explanation

Previous group of Marks This command will show the readings recorded between the first
inspection mark shown and the previous inspection mark recorded.
This command will only be available if the "Zoom to Marks"
command is enabled and the first reading recorded is not currently
visible.

Next group of Marks This command will show the readings recorded between the last
inspection mark shown and the next inspection mark recorded. This
command will only be available if the "Zoom to Marks" command is
enabled and the last reading recorded is not currently visible.

Options... This will open a window allowing you to customize the software.
This command is further explained in the chapter "Customizing the
software".



LogTag® Menu

The LogTag® menu contains commands that relate to interaction with LogTag® logger products.

Figure 126: LogTag Menu

The following table explains each of the available commands:

Command Explanation

Configure... This will display a wizard to help you through the necessary steps to configure
LogTag®s for their next use. This command is explained in further detail in
the chapter Entering Configuration Parameters on page 41.

Download... This will display a wizard to help you through the necessary steps to retrieve a
copy of the recorded readings stored inside the LogTag®(s). This command is
explained in further detail in the chapter Results from LogTag® Loggers on
page 84.

Hibernate... This will display a wizard to help you through the necessary steps to set
LogTag®s to "Hibernation" mode. This command is explained further in the
chapter Hibernation - Prolonging battery life on page 82.

Quick Re-
configure...

With this command you can re-configure a loggerwith the same settings as for
the previous trip. This command is explained in further detail in the section
Quickly re-configuring a LogTag® on page 81

Profiles With this command you can configure a logger with a configuration profile
previously created. This command is explained in further detail in the section
about Configuration Profiles on page 76.

Wizard... This will display a wizard to help you through the necessary steps to retrieve a
copy of the recorded readings stored inside the LogTag®(s) and then prepare
the LogTag®s for their next use. This command is explained in further detail
in First Steps on page 23.

Table 27: LogTag menu - available commands
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Window Menu
The Window menu contains commands that relate to the management of each open Window that
displays the contents of a LogTag® file.

Figure 127: Window menu

Commands available in the Window menu:

Command Explanation

New Window Opens a new window that contains a copy of the information of the currently
selected window. This command is useful when you need to closely inspect
and analyze different sections of the same data set.

Close Closes the currently selected window within the LogTag® Analyzer software.

Close All Closes all the windows within the LogTag® Analyzer software.

Cascade Arrange all the windows within the LogTag® Analyzer software in an
overlapping style.

Title
Horizontally

Arrange all the windows within the LogTag® Analyzer software as horizontal
non-overlapping tiles.

Title Vertically Arrange all the windows within the LogTag® Analyzer software as vertical
non-overlapping tiles.

Arrange Icons Arrange all the minimized windows within the LogTag® Analyzer software at
the bottom of the main window.

1, 2, 3, etc The tick mark beside these entries indicates the window that is currently
selected. If you want to change the currently selected window to one of the
windows listed, just click/select the appropriate entry on this list.

Table 28: Window menu - available commands



Help Menu
The "Help" menu contains commands that relate to providing you with help and assistance with
using the LogTag® Analyzer software.

Figure 128: Help menu

The following table outlines the commands and the explanation of each command that may appear
in the "Help" menu when using the LogTag® Analyzer software:

Command Explanation

Help Topics Opens a window that contains the online help.

User Guide Opens the online user guide for viewing. Requires Adobe Acrobat and/or Adobe
Acrobat Reader software, version 6 or later, to be installed on the computer.

LogTag® VCF
Dataloggers
Home Page...

This will open your default Internet browser and display the LogTag®

Recorders website https://logtagrecorders.com. You need to be connected to
the internet at the time you wish to see this website.

Request help... This will gather non personal information from your system to include in the
email to be sent to software support at LogTag® Recorders, so that the support
team will be informed of the relevant information about your system in order
to provide you with quality and useful assistance. This command is explained
in further detail in the section about Getting more help.

Check Internet
for update...

This is a simple way of checking to see if there is a newer version of this
software available for download. This command is explained in further detail
in the section about Updating LogTag Analyzer.

About LogTag®

Analyzer...
Display the version information about the LogTag® Analyzer software that you
are using.

Table 29: Help menu - available commands
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Toolbar commands
Each icon on the toolbar represents a unique command.

Figure 129: LogTag® Analyzer toolbar

Command Explanation

Access LogTag® This will bring up the LogTag® Wizard, which will take you through the steps
to retrieve readings from connected LogTag®(s) and prepare them for their
next use.

Open This will display the file open window to allow you to locate and open LogTag®

files that contain previously retrieved LogTag® readings.

Save Save a copy of the LogTag® data to a file on your disk drive.

Print Opens the window that will allow you to print a copy of the LogTag® data to a
printer. See Printing the results on page 127

File properties Displays file properties about the currently selected open file. See Viewing file
properties on page 134.

File digital
signatures

Displays information about any digital signatures included in the currently
selected open file, which is also allows where new digital signatures can be
added to the file and where you can print a copy of the digital signatures.

Send mail Creates a new blank email for sending a copy of the currently selected open
file as an attachment to a recipient of your choice.

Upload Uploads the file in the currently active window to an FTP server, or sends it
by email. Please see Automatic emailing and uploading to FTP sites on
page 146

Copy Places a copy of the currently displayed information to the Windows clipboard
so that you can paste it into another Windows software package.

Real Time When this button is active, the time axis represents date and time the data
were recorded. This is useful when you want to inspected at what date and
time a certain event occurred.

Elapsed Time When this button is active, the time axis represents the elapsed time since
the recording began. This is useful when you want to inspected how long into
a trip a certain event occurred.

Table 30: Toolbar icons and their function



Command Explanation

Zoom out Zooms out one level of the chart in the currently active window. If you are
displaying a chart and this function is not available, then all available data are
already being displayed and you cannot zoom out any further.

Zoom to
inspection
marks

This zooms the chart so readings are shown between the oldest reading
recorded and the first inspection mark that exists in the data. If this function
is not available then there are no inspection marks in the data currently being
displayed.

The next two commands will not be available until this command is activated.

Previous
inspection mark
group

This zooms the chart so readings are shown which were recorded between the
first inspection mark currently being displayed and the previous inspection
mark.

This function is disabled when either the oldest reading is already being
displayed, or the "Zoom to inspection marks" function has not been activated.

Next inspection
mark group

This zooms the chart so readings are shown which were recorded between the
last inspection mark currently being displayed and the next inspection mark.

This function is disabled when either the newest reading is already being
displayed, or the "Zoom to inspection marks" function has not been activated.

Average Combines all open file windows into a single Multi Chart window and
activates the average tab. , or if already in multichart, activates or disables the
average tabs. It is recommended to deactivate this feature when processing
large data sets, as Minimum, Maximum and Average Charts can require
considerable memory and processor resources when activated.

Multi Chart Switches into Multi Chart mode, which displays all currently open charts
together in one window. If additional LogTag®(s) are downloaded or more files
opened, their data will be added to the Multi Chart window.

Single Chart Switches into Si ngle Chart mode. Each chart that is currently open will be
displayed in its own window.

Options This will open a window allowing you to customize the software. This
command is further explained in the chapter Customising the software on
page 135.

Logon/Logoff
user

This will log a user on to the software if no user is currently logged on or log
off the currently logged on user. This command will only be available if the
software is connected to the LogTag® User Server software.

Help Click on this icon, then click on an area on the screen, and the help topic for
this area will be displayed.
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Upload Status Window
When uploading or emailing files a status window is displayed at the bottom of the LogTag®

Analyzer window.

This window shows status messages related to the FTP and emailing functions. The window can be
hidden by right clicking anywhere in it and de-selecting the Upload/Send Status box. It can be re-
displayed by right clicking anywhere on the menu or toolbar and selecting the Upload/Send Status
box.

Print preview toolbar
The print preview feature -available through the File menu- will display a view of the data as it
would appear printed out. When the software is displaying a file in print preview mode, an
additional toolbar will appear, similar to the following picture:

Figure 130: Print preview

Command Explanation

Print... This will open a window allowing you to print a copy of the LogTag® file to an output
device, which will typically be a printer.

Next
Page

This will display the next page included in the print out. This button will be disabled
if there are no more pages available to be displayed.

Prev Page This will display the previous page included in the print out. This button will be
disabled if there are no previous pages available to be displayed.

Table 31: Commands available in the print preview toolbar



Command Explanation

One Page Selecting this button will change the display so that only one page is displayed at a
time. Once this button is selected it will change to "Two Page".

Two Page Selecting this button will change the display so that two consecutive pages are
displayed side by side at the same time. This button will be disabled if there is only
one page in the print out, like a chart. Once this button is selected it will change to
"One Page".

Zoom In This will zoom in the display of the print out making it appear larger on the screen.
It will not effect what information is included in the print out.

Zoom Out This will zoom out the display of the print out making it appear smaller on the
screen. It will not effect what information is included in the print out.

Close This will close the print preview mode of display and revert the display of the data
back to normal mode, which will allow users to switch between chart display and data
listing display, for example.

Note: When using Print Preview you can only print one document at a time.
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Standard Window commands
In the top right corner of each window, one or all of the buttons in the
following image will be displayed and will (from left to right) minimize the
window, maximize the window or close the window.

The following picture illustrates an example of the menu that will appear if a user selects the icon
in the top left corner of the LogTag® Analyzer software, usually by clicking the left mouse button
on it, or by clicking the right mouse button on the title bar. The commands illustrated in the
following picture allow you to change the location and/or size of the window containing the
LogTag® Analyzer software. Users can also move the window containing the LogTag® Analyzer
software by "dragging" the title bar, which is typically performed by pressing and holding the left
mouse button down over the title bar of the software and moving the mouse to the new location
for the window.

Figure 131: Application window commands

The following picture illustrates an example of the menu that will appear if a user selects the icon
in the top left corner of a data file window, usually by clicking the left mouse button on it, or by
clicking the right mouse button on the title bar of the data window. These menu commands will
only effect the window containing the data retrieved from a LogTag® Analyzer rather than the
Window that contains the entire LogTag® Analyzer software.

Figure 132: File window commands



Chapter 8
Getting more information

In this chapter:

Getting more help 195
Finding your software version 196



195 LogTag® Analyzer Version 2.9 User Guide

Getting more help

If you run into a problem with your LogTag® logger, you can click Request help... from the Help
Menu to contact the support team at LogTag® Recorders for assistance.

When you select this command, LogTag® Analyzer will collect non-personal information from your
system, such as

l operating system version,

l LogTag® Analyzer version information,

l storage folders,

l installed languages,

l temporary folders

and put it into a file called Diagnostics.txt.

The software will also create a special download file of any USB logger and any logger or indicator
in an interface attached to the PC. These file(s) will have a *.ltm file extension (Logger Total
Memory), which can only be viewed with special diagnostic software by LogTag® Recorders, but not
with LogTag® Analyzer software.

All information collected will be combined into a Zip file and stored in a folder called Diagnostics
inside your My LogTag Documents folder.

While the software is collecting this information, the following message is displayed:

It is important you do not remove any loggers during this process.

LogTag® Analyzer will then start your default email program and attach this information.

In the email please also include as much detailed information as possible about the problem, such
as what you were doing at the time, or what application the product is used in. If needed, create a
screen shot of the problem (ALT-PRTSC) and paste it into the email (CTRL-V).



If you use an online email program such as Gmail or Outlook.com, or you only have a 64-bit email
program installed, please send an email to software@logtagrecorders.com, use the word
"Diagnostics" as the subject line and attach the Zip file from the My LogTag
Documents\Diagnostics folder to this email.

Note: When you click Request help... from the Help Menu again, any existing files in the
Diagnostics folder will automatically be deleted.

Finding your software version
Each time LogTag® Analyzer is updated, its version number increases. To find out which version
you are using, click About LogTag Analyzer… from the Help Menu to display this message:

Figure 133: About LogTag® Analyzer

This window displays the full version number of the software being used. You may need the
version number to compare versions on different computers or to ask for help.

You can also find major and minor version of LogTag® Analyzer in the title bar:
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Connecting to LogTag® User Server

To use Digital Signatures, LogTag® Analyzer must be connected to the LogTag® User Server
software. When connected, all users are required to log on to LogTag® Analyzer before they can use
the software. To find out how to connect LogTag® Analyzer to User Server please see User Server

How users log on
For users to successfully log on to the software, they must enter their username and password,
which the User Server administrator would have assigned.

Usernames are typically not case sensitive, however passwords are, which means that "Bob Smith"
is the same username as "BOB SMITH" and "bob smith", however, entering a password of "bob"
rather than "Bob", for example, is considered to be different.

Figure 134: Logon request when connected to User Server

Every log on attempt, whether successful or not, will be recorded automatically in the audit logs.
As a security measure, the network administrator may configure LogTag® User Server so that a
user account becomes blocked after a certain number of consecutive failed log on attempts. Please
contact your network administrator if you have problems with the log-on process.

How users change their password
The network administrator may permit users to change their password used to log on to the
software. Users will need to supply their current logon password before being permitted to change
it, then the new password and a confirmation.

The network administrator may enforce certain password rules. For example, they may require a
minimum number of characters (digits, letters or symbols) and/or a minimum number of digits to
be included in the password. Please contact your network administrator if you have problems with
the password change process.



Figure 135: Changing a User Server password

Passwords should be chosen so they are difficult for someone else to guess. Following are a few
points to remember when changing a password:

1. Do not use something that is personal to the user. Birth dates, license plate numbers,
names of family members, types of vehicles owned, favorite foods and address of residence
are all examples of passwords that should NOT be used.

2. Do not write your password down.

3. Change your password on a regular basis.

If users forget their password, the network administrator will be able to change it. However,
network administrators will not be able to see and therefore inform users what their current
password is.

Troubleshooting
For tips on troubleshooting please visit the FAQ on the LogTag® Recorders website at
https://logtagrecorders.com/support/faq. This site is regularly updated and contains the latest
information on how to deal with issues that might occur.

Code Pages
A computer determines which character to display based on a table of values, which is specific to a
language. This table is often referred to as the code page.

A small number of characters are independent of a computer's input language. These are '1-9', 'a-
z', 'A-Z' and some special characters.

Figure 136: ASCII Table of printable characters
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An additional 128 characters are available, which are specific to each code page. The following
examples show for example the differences between the available characters for the Latin and Thai
code pages.

Figure 137: Code page 1252, Western languages

Figure 138: Code page 847, Thai language

In LogTag® Analyzer password and user ID fields are text entry fields. The code page is used to
determine the characters LogTag® Analyzer displays on screen and stores inside a logger. Which
code page is selected depends on which input language you have selected for your computer. When
the LogTag® is downloaded in a different country, the user ID is displayed with the characters from
the code page who's reference is stored in the logger. This is possible because all Windows code
pages get installed as part of the operating system installation for all operating systems supported
by LogTag® Analyzer, although only one is used at a time to display characters.

Passwords are always displayed with the asterisk character, but you will need to type them into a
confirmation dialogue (especially if the password on download feature is enabled). You can use the
Windows character map to enter characters that are not available in your language. To access the
Windows character map, enter charmap.exe in the "Search" or "Run" box of the Start menu,
depending on your operating system, and press Enter.



Figure 139: Accessing charmap.exe on Windows 7

Some code pages make more than these extra 128 characters available, but this requires more
storage in the logger's memory, which reduces the number of characters available for password and
user ID. These languages are Chinese (Traditional), Chinese (Simplified), Korean and Japanese. For
every character not in the ASCII character table on page 199 the number of characters that can be
stored is reduced by one. This means a password can be as short as 3 characters, and a description
as short as 19 characters (or 18 characters for a TRID30 or TRED30). The sample shows the
extended character overview and character subset for Japanese.

You can find more information about the history and technical background of code pages via a
number of online references.

Note: Although you can use the Windows character map to confirm a password on download, you
cannot enter characters as a new password or description that are not available in your chosen
input language with this method. If you want to use different characters you must switch the
input language of your computer. Please refer to the instructions relating to your specific
operating system how to do this.

Figure 140: Code page 932, Japanese language
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Figure 141: Code page 932, Japanese language, subset 91
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